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While Deltek has attempted to verify that the information in this document is accurate and 
complete, some typographical or technical errors may exist. The recipient of this document is 
solely responsible for all decisions relating to or use of the information provided herein. 

The information contained in this publication is effective as of the publication date below and is 
subject to change without notice. 

This publication contains proprietary information that is protected by copyright. All rights are 
reserved. No part of this document may be reproduced or transmitted in any form or by any 
means, electronic or mechanical, or translated into another language, without the prior written 
consent of Deltek, Inc. 

This edition published June 2013. 

© 2013 Deltek, Inc. 

Deltek’s software is also protected by copyright law and constitutes valuable confidential and 
proprietary information of Deltek, Inc. and its licensors. The Deltek software, and all related 
documentation, is provided for use only in accordance with the terms of the license agreement. 
Unauthorized reproduction or distribution of the program or any portion thereof could result in 
severe civil or criminal penalties. 

All trademarks are the property of their respective owners.  



 

 

Document Management Installation Guide iii 

 

Contents 
If You Need Assistance ................................................................................................................... 1 

Customer Services ...................................................................................................................... 1 

Customer Care Connect Site ...................................................................................................... 1 

Downloading Deltek Products using Deltek Software Manager ...................................................... 3 

Accessing DSM Directly .............................................................................................................. 3 

Accessing DSM from within Deltek Customer Care .................................................................... 4 

DSM Documentation and Troubleshooting ................................................................................. 4 
Important Information for Users of Previous Versions of Deltek Vision Document Management ... 5 

Windows SharePoint Services (WSS) 2.0 Installations .............................................................. 5 

Differences between Vision 5.1 and Vision 7.x Document Management ................................... 5 

Upgrade Windows SharePoint Services 3.0 to SharePoint Foundation 2010 ............................ 8 

Upgrade Vision Document Management .................................................................................... 8 
Before You Begin:.......................................................................................................................... 10 

Vision Document Management Requirements ......................................................................... 10 

Understanding Domain Configuration Changes ....................................................................... 11 

Where to Go from Here ................................................................................................................. 13 

Single Tier New Document Management Installations ............................................................. 13 

Multi-Tier New Document Management Installations ............................................................... 13 
Multi-Tier New Document Management Installations (SharePoint “Server” installations) ........ 14 

Single Tier New Installation and Configuration for x86 (32-bit) Servers – SharePoint is NOT 
Installed ......................................................................................................................................... 15 

Prerequisites ............................................................................................................................. 15 

Single Tier Installation and Configuration Steps ....................................................................... 15 

Install and Configure Vision 7.1 Document Management and Windows SharePoint Services 
(WSS) 3.0 .................................................................................................................................. 18 

Configure Vision Document Management ................................................................................ 40 

Single Tier New Installation and Configuration for x64 (64-bit) Servers – SharePoint is NOT 
Installed ......................................................................................................................................... 42 

Prerequisites ............................................................................................................................. 43 
Single Tier Installation and Configuration Steps ....................................................................... 43 

Install and Configure Vision 7.1 Document Management and SharePoint Foundation (SPF) 
2010........................................................................................................................................... 46 

Configure Vision Document Management ................................................................................ 70 

Single Tier Installation and Configuration for x86 (32-bit) Servers – SharePoint Already Installed
 ....................................................................................................................................................... 72 

Prerequisites ............................................................................................................................. 72 

Single Tier Installation and Configuration Steps ....................................................................... 72 



 

 

Document Management Installation Guide iv 

 

Install and Configure Vision 7.1 Document Management ......................................................... 75 

Configure Vision Document Management ................................................................................ 84 

Single Tier New Installation and Configuration for x64 (64-bit) Servers – SharePoint Already 
Installed ......................................................................................................................................... 86 

Prerequisites ............................................................................................................................. 86 

Single Tier Installation and Configuration Steps ....................................................................... 86 

Install and Configure Vision 7.1 Document Management ......................................................... 89 

Configure Vision Document Management ................................................................................ 98 

Multi Tier New Installation and Configuration for x86 (32-bit) Servers – SharePoint is NOT 
Installed ....................................................................................................................................... 100 

Prerequisites ........................................................................................................................... 100 

Multi Tier Installation and Configuration Steps ....................................................................... 100 

Install and Configure Vision 7.1 Document Management and WSS 3.0 ................................ 103 

Configure Vision Document Management .............................................................................. 125 

Multi Tier New Installation and Configuration for x64 (64-bit) Servers – SharePoint is NOT 
Installed ....................................................................................................................................... 134 

Prerequisites ........................................................................................................................... 135 

Multi Tier Installation and Configuration Steps ....................................................................... 135 

Install and Configure Vision 7.1 Document Management and SharePoint Foundation (SPF) 
2010......................................................................................................................................... 138 

Configure Vision Document Management .............................................................................. 164 
Multi Tier New Installation and Configuration for x86 (32-bit) Servers – SharePoint Already 
Installed ....................................................................................................................................... 173 

Prerequisites ........................................................................................................................... 173 

Multi Tier Installation and Configuration Steps ....................................................................... 173 

Install and Configure Vision 7.1 Document Management ....................................................... 176 

Configure Vision Document Management .............................................................................. 185 
Multi Tier New Installation and Configuration for x64 (64-bit) Servers – SharePoint Already 
Installed ....................................................................................................................................... 195 

Prerequisites ........................................................................................................................... 195 

Multi Tier Installation and Configuration Steps ....................................................................... 195 

Install and Configure Vision 7.1 Document Management ....................................................... 198 
Configure Vision Document Management .............................................................................. 209 

Multi Tier—New Installation of Document Management 7.1 with MOSS 2007 ........................... 218 

Prerequisites ........................................................................................................................... 218 

Multi Tier Installation and Configuration Steps ....................................................................... 218 

Install and Configure Vision 7.1 Document Management and the MOSS 2007 Site Collection
 ................................................................................................................................................. 221 
Configure Vision Document Management .............................................................................. 230 



 

 

Document Management Installation Guide v 

 

Multi-Tier New Installation of Document Management 7.1 with SharePoint Server 2010 .......... 240 

Prerequisites ........................................................................................................................... 240 

Multi Tier Installation and Configuration Steps ....................................................................... 240 

Install and Configure Vision 7.1 Document Management and the SharePoint Server 2010 Site 
Collection ................................................................................................................................. 243 

Configure Vision Document Management .............................................................................. 253 

Appendix A: Active Directory Domain Functional Level .............................................................. 263 

Active Directory Domain Functional Levels............................................................................. 263 

Identify the Domain Functional Level ...................................................................................... 263 

How to Raise the Domain Functional Level ............................................................................ 264 
Appendix B: Configure SharePoint for a Custom URL ................................................................ 266 

Configure SPN and Alternate Access Mappings for Custom URL for SharePoint Web Server
 ................................................................................................................................................. 266 

Add SPNs for a Custom DNS Name ....................................................................................... 266 

Create or Modify Alternate Access Mappings WSS 3.0 / MOSS 2007 ................................... 267 
Create or Modify Alternate Access Mappings SPF  / SharePoint Server 2010 ...................... 269 

Configure Constrained Delegation or Protocol Transition When Using a Custom DNS Record
 ................................................................................................................................................. 272 

Appendix C: Manual Installation of Vision Document Management ........................................... 275 

Appendix D:  Troubleshooting ..................................................................................................... 277 

SPN Troubleshooting .............................................................................................................. 277 
Kerberos Troubleshooting ....................................................................................................... 277 

Internet Access, Authentication Prompts and Windows Credential Manager......................... 278 

Appendix E:  Use a Site Collection SharePoint Account instead of Farm Administrator Account
 ..................................................................................................................................................... 280 

 

 



If You Need Assistance 

 

Document Management Installation Guide 1 

 

If You Need Assistance 
If you need assistance installing, implementing, or using Vision, Deltek makes a wealth of 
information and expertise readily available to you. 

Customer Services 
For over 20 years, Deltek has maintained close relationships with client firms, helping with their 
problems, listening to their needs, and getting to know their individual business environments. A 
full range of customer services has grown out of this close contact, including the following: 

 Extensive self-support options through the Customer Care Connect Web portal. 

 Phone and email support from Customer Care analysts 

 Technical services 

 Consulting services 

 Custom programming 

 Classroom, on-site, and Web-based training 
  

 
Find out more about these and other services from the Customer Care Connect site. 

  

Customer Care Connect Site 
The Deltek Customer Care Connect site is a support Web portal for Deltek customers who 
purchase an Ongoing Support Plan (OSP).  

The following are some of the many options you have at the Customer Care Connect site: 

 Download the latest versions of your Deltek products 

 Search Deltek’s knowledge base 

 Ask questions, exchange ideas, and share knowledge with other Deltek customers 
through the Deltek Connect Customer Forums 

 Display or download product information, such as release notes, user guides, technical 
information, and white papers 

 Submit a support case and check on its progress 

 Transfer requested files to a Customer Care analyst 

 Use Quick Chat to submit a question to a Customer Care analyst online 

 Subscribe to Deltek communications about your Deltek products and services 

 Receive alerts of new Deltek releases and hot fixes 
  

 If you need assistance using the Customer Care Connect site, the online help available on the site 
provides answers for most questions. 
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Access Customer Care Connect 

To access the Customer Care Connect site, complete the following steps:  

1. Go to https://deltek.custhelp.com.  

2. Enter your Customer Care Connect Username and Password. 

3. Click Log In. 
  

 

If you do not have a username and password for the Customer Care Connect site, contact your firm’s 
Vision Administrator. 

If you forget your username or password, you can click the Account Assistance button on the login 
screen for help. 

  

 

 

https://deltek.custhelp.com/
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Downloading Deltek Products using Deltek 
Software Manager 
You can use Deltek Software Manager (DSM) to download complete Deltek products, hot fixes, 
and sub-releases. You can access DSM directly or through the Deltek Customer Care site. 

When you access DSM directly, you will be prompted to log on before you can access the 
application. If you access DSM from within the Deltek Customer Care site, you do not have to log 
on since you are already logged into the Customer Care site. 

Accessing DSM Directly 
To access Deltek Software Manager directly, complete the following steps: 

1. Launch Deltek Software Manager by taking one of the following actions: 

 Click here.  

 On your desktop, click Start » Programs » Deltek » Vision » Deltek Software 
Manager. 

2. In the Deltek Software Manager logon dialog box, enter your Deltek Customer Care User 
ID and Password, and click Logon. 

3. To select the folder where you want to download Deltek products, click Settings above 
the right pane of Deltek Software Manager. 

  

 When you log on for the first time, Deltek Software Manager asks you to select a default 
folder where Deltek products are to be downloaded.  

  

4. Use the Settings dialog box to specify the folder where you want to download Deltek 
products, and click OK.  

  

 You can change this folder anytime in the Settings dialog box.  
  

5. In the left pane of Deltek Software Manager, expand the Deltek product that you want to 
download, if it is not already expanded.  

  

 If you clicked the link in step 1 to access DSM, the application automatically selects Vision 
for you. 

  

6. Select the product type that you want to download. Your options are Complete, HotFix, 
and Sub-Release. 

7. In the table, select the check box that corresponds to the Deltek product that you want to 
download. The right pane displays a message stating that the product has been added to 
the download queue. 

  

 To view the items in the download queue, click View Download Queue at the bottom of the 
left pane.  

  

https://dsm.deltek.com/DeltekSoftwareManager/DeltekSoftwareManager.application?ProductVersionID=6B7B0346-9416-4077-A3F3-28760B8AB948
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8. Click Download at the bottom of the left pane. Deltek Software Manager downloads the 
product to the folder that you selected.  

Accessing DSM from within Deltek Customer Care 
To access Deltek Software Manager from within Deltek Customer Care, complete the 
following steps: 

1. In your Web browser, go to https://deltek.custhelp.com.  

2. Enter your Customer Care Connect Username and Password, and click Log In. 

3. When the Customer Care site displays, click the Product Downloads tab. 

You are automatically logged in Deltek Software Manager. 

4. To select the folder where you want to download Deltek products, click Settings above 
the right pane of Deltek Software Manager. 

  

 When you log on for the first time, Deltek Software Manager asks you to select a default 
folder where Deltek products are to be downloaded.  

  

5. Use the Settings dialog box to specify the folder where you want to download Deltek 
products, and click OK.  

  

 You can change this folder anytime in the Settings dialog box.  
  

6. In the left pane of Deltek Software Manager, expand the Deltek product that you want to 
download, if it is not already expanded.  

7. Select the product type that you want to download. Your options are Complete, HotFix, 
and Sub-Release. 

8. In the table, select the check box that corresponds to the Deltek product that you want to 
download. The right pane displays a message stating that the product has been added to 
the download queue. 

  

 To view the items in the download queue, click View Download Queue at the bottom of the 
left pane.  

  

9. Click Download at the bottom of the left pane. Deltek Software Manager downloads the 
product to the folder that you selected.  

DSM Documentation and Troubleshooting 
To view the online help for Deltek Software Manager, click here. 

To view a tutorial on how to use Deltek Software Manager, click here.  

To view more information on troubleshooting Deltek Software Manager, click here. 

https://deltek.custhelp.com/
https://dsm.deltek.com/DeltekSoftwareManager/Help/
https://dsm.deltek.com/DeltekSoftwareManager/Tutorial/PubData/Engine/Default.htm?https%3A%2F%2Fdsm.deltek.com%2FDeltekSoftwareManager%2FTutorial%2FPubData%2F
https://deltek.custhelp.com/app/answers/detail/a_id/52469
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Important Information for Users of Previous 
Versions of Deltek Vision Document Management 
If you are upgrading from an earlier version of Vision, particularly from a 5.x version, note the 
following important information.  If this is a new installation of Vision Document Management skip 
ahead to “Before you Begin” for the software and infrastructure requirements of Vision Document 
Management. 

Windows SharePoint Services (WSS) 2.0 Installations 
Deltek Vision 5.x and earlier versions supported Windows SharePoint Services 2.0.  Please note 
that this version of SharePoint is no longer supported with Vision 6.x and higher. If you have not 
yet upgraded your Windows SharePoint Services installation from WSS 2.0 to WSS 3.0 or 
SharePoint 2010, you must upgrade WSS as your first step.  

You must upgrade WSS 2.0 before you install Deltek Vision 7.1. 
  

 
In order to upgrade to WSS 3.0, see the Deltek Vision 5.1 Document Management Upgrade Guide 
for the necessary upgrade steps.  

In order to upgrade to SharePoint 2010, refer to the following Microsoft Technet article: 
http://technet.microsoft.com/en-us/library/ee947140.aspx  

  

Differences between Vision 5.1 and Vision 7.x Document 
Management 
If you are upgrading from Vision 5.1 and have the Document Management module, please note 
the key differences between Vision 5.1 and Vision 7.x Document Management, as follows: 

 Windows Server 2003 is no longer supported as an Operating System for Vision or Vision 
Document Management. 

 As indicated above, WSS 2.0 is no longer supported for Vision Document Management. 

 Unlike Vision 5.1 with Windows SharePoint Services (WSS) 3.0, you cannot install WSS 
3.0 or SharePoint 2010 to the same Web site as Vision 7.1.   

 With the Vision 5.1 Document Management installation, you had to configure the ASP 
.NET Impersonation Identity. This installation step is no longer necessary, because the 
Identity of the IIS Application Pool performs this function in Vision 7.1. The installation of 
Vision 7.1 creates the DeltekVisionAppPool with the local DeltekVision account as the 
Identity.  
 
The SharePoint service (Farm Administrator) account must be the Application Pool 
Identity for Vision 7.1 and a domain account, as shown in the following example dialog 
boxes. 

 

  

http://technet.microsoft.com/en-us/library/ee947140.aspx
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 For this account to be the Application Pool Identity it must be a member of the IIS_IUSRS 
group in addition to being a member of the local administrators group on the local server. 

  

 The SharePoint Service account credentials must be specified in Weblink System 
Settings, as shown in the following example of the Weblink System Settings tab. Note as 
well that Weblink now includes a Test button that will allow you to validate the credentials 
entered are valid. 

 
 The SharePoint Service account/Vision Application Pool Identity must be granted Logon 

as a service rights on the Vision 7.1 Web/Application Server for multi-tier Document 
Management installations, as shown in the following example of the Local Security 
Settings setup screens. 



Important Information for Users of Previous Versions of Deltek Vision Document Management 

 

Document Management Installation Guide 7 

 

 
 

 The configuration of Service Principal Names and Delegation has changed with Vision 
7.1. Specifically, a Service Principal Name (SPN) must be configured for the domain 
account chosen to be the Application Pool Identity / SharePoint Service account when 
deploying a multi-tier deployment of Vision Document Management.  This account is also 
the account that will be configured for Delegation. 

 In multi-tier installations of Vision Document Management, you must configure domain 
based delegation. This configuration has changed from Vision 5.1. It is now configured 
for this user account running the Vision 7.1 Application Pool being granted delegation 
rights to the WSS server. This configuration is shown in the following example of the 
Delegation tab of the Application Pool Identity Properties dialog box: 
 

 
 There are three possible authentication configurations with IIS 7.0/7.5, only two of which 

require you to create an SPN for the Application Pool Identity. Refer to sections in each 
deployment titled “Configure Authentication for the Vision Website” and “Configure 
Service Principal Name (SPN) for Vision Application Pool Identity”.  For single tier 
installations these steps are optional. 
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Upgrade Windows SharePoint Services 3.0 to SharePoint 
Foundation 2010 
Existing installations of Windows SharePoint Services 3.0 will not be upgraded to SharePoint 
Foundation 2010 via the Document Management installation; however, existing Document 
Management customers can upgrade their installation of SharePoint by following the 
documentation available from Microsoft, which is included below: 

 Hardware and Software Requirements (SharePoint Foundation 2010): 

http://technet.microsoft.com/en-us/library/cc288751.aspx 

 Upgrade and Migration for SharePoint Foundation 2010: 

http://technet.microsoft.com/en-us/sharepoint/ee517215.aspx 
  

 
If you plan to upgrade to SharePoint 2010, Deltek strongly recommends that you perform the 
upgrade of Windows SharePoint Services to SharePoint Foundation before installing Vision 7.1 
Document Management and that any previous installations of Document Management be 
uninstalled (this will not uninstall SharePoint). Upgrading to SharePoint foundation after installing 
Vision 7.1 Document Management will break the Document Management functionality as the 
installation makes modifications differently based on which version of SharePoint is installed. 

  

 

Upgrade Vision Document Management 

Vision 5.1 to Vision 7.1 Document Management Upgrade  
  

 Please review the notes in the previous section titled “Differences between Vision 5.1 and Vision 7.x 
Document Management” as there are configuration changes required due to changes in technology. 

  

To upgrade from Vision 5.1 Document Management to Vision 7.1 Document Management, 
complete the following steps: 

1. Uninstall Deltek Vision 5.1 Document Management from Add/Remove Programs on your 
Deltek Vision Web server and also on any dedicated SharePoint servers. 

2. Unregister the existing Deltek.Vision.WSS30.Server.dll from the GAC (Global Assembly 
Cache, c:\windows\assembly) via an administrative command prompt (change drive letter 
and path as appropriate for your installation): 
C:\\Program Files\Deltek\Vision\Support\Utilities\gacutil.exe /u C:\\Program 
Files\Deltek\Vision\Support\DM\30\ Deltek.Vision.wss30.dll 

3. Delete the old Deltek.Vision.WSS30.dll from \inetpub\bin or inetpub\virtual 
directories\wss\<port>\bin. 

4. Install Vision 7.1 Document Management following the New installation instructions for 
your tier configuration. 

5. Run the installation on both your Vision and SharePoint servers if they are on different 
physical machines. 

http://technet.microsoft.com/en-us/library/cc288751.aspx
http://technet.microsoft.com/en-us/sharepoint/ee517215.aspx
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Vision 6.x to Vision 7.1 Document Management Upgrade  

To upgrade from Vision 6.x Document Management to Vision 7.1 Document Management, 
whether using Windows SharePoint Services or SharePoint Foundation, complete the 
following steps: 

1. Run the Deltek Vision 7.1 installation to upgrade your Vision servers to Deltek Vision 7.1. 

2. Run the Deltek Vision 7.1 Document Management installation to upgrade your Document 
Management server(s) to Deltek Vision 7.1 Document Management. 

3. Update the Deltek Vision Document Management .NET assembly 
(Deltek.Vision.WSS30.Server.dll) in your SharePoint site \bin directory with the updated 
assembly located in <drive>:\Program Files\Deltek\Vision\Support\DM\3.0 folder. 
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Before You Begin: 
  

 
!!IMPORTANT!! 

Vision Document Management is a complicated software component with many 
configuration steps after the Vision Document Management setup has completed, 
both with the Vision and SharePoint software as well as the various Domain level 
changes that may be required to support your installation.  Please pay particular 
attention to the following software and Domain requirements as well as the step 
by step installation and configuration instructions for your chosen deployment. 

  

Vision Document Management Requirements 
The Vision Document Management installation for Vision 7.1 has the following requirements: 

 The Vision Web/Application and Microsoft SharePoint Web server(s) must be running 
Windows Server 2008 (x86 or x64) or Windows Server 2008 R2 x64.   
 
NOTE: Windows Server 2003 is no longer supported with Vision 7.1. 
 

 The Document Management installation will automatically download and install 
SharePoint for you if not already installed. 

 As of Vision 7.0, SharePoint Foundation 2010 will be installed if the server is x64; 
otherwise WSS 3.0 will be installed. 

 If installing Vision Document Management into an existing SharePoint installation, Vision 
Document Management must have its own top-level site.  Vision Document Management 
does not support integrating with an existing SharePoint site collection. 

 Vision Document Management supports Single Tier deployments (installing SharePoint 
to the same server as Vision) and also Multi-Tier deployments (installing SharePoint to its 
own physical server separate from Vision).  Multi-Tier deployments require domain level 
configuration changes which are documented in the next section “Understanding Domain 
Configuration Changes”. 

 Single-Tier installations are not supported with SharePoint “server:” installations (e.g. 
Microsoft Office SharePoint Server 2007 (MOSS) and SharePoint Server 2010). 

 For Single Server installations, Vision and SharePoint cannot share the same website 
(e.g. they cannot both be installed to the Default Website). 

 An Active Directory domain is required to use Vision Document Management and the 
Vision and SharePoint servers must be members of a domain. 

 The domain functional level must support constrained delegation for multi-tier 
installations of Vision Document Management. Refer to Appendix A for how to identify 
your domain functional level (if applicable).  

 Internet Information Services (IIS) must be configured for Integrated Windows 
Authentication on both the Vision Web/Application server(s) and the Microsoft SharePoint 
Web server(s). A standard deployment of Vision supports either Anonymous Access 
(Vision Security) or Integrated Windows Authentication (Domain security), so this may be 
a change if you already have Vision deployed. The use of Integrated Security in IIS does 
not prohibit the use of Vision Security login accounts (for example, you don’t have to 
configure all users in Vision for Integrated Security). 
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 There are additional Microsoft licensing requirements necessary to support the use of 
Integrated Windows Authentication with IIS. Specifically, a CAL (Client Access License) is 
required for each user who will access the IIS server (Vision).  Refer to your software 
license vendor for any questions regarding this requirement. 

  

Understanding Domain Configuration Changes 
 The following information applies to multi-tier installations of Vision Document 

Management only.  If Vision and SharePoint will be installed to the same physical server 
you can skip this section. 

  

 

Delegation and Kerberos Authentication 
Delegation is required for a multi-tier deployment of Vision Document Management.  A multi-tier 
installation is where Vision and SharePoint exist on separate physical servers. 

Delegation is the process of passing the credentials of the logged-in user from one server to 
another. In the case of Vision Document Management, the user’s credentials are passed from the 
Vision Web/Application server to the SharePoint server. In Vision 7.1, delegation is configured by 
modifying the domain user account of the Vision Application Pool Identity to perform delegation. 

Kerberos Authentication is a secure key-based authentication protocol necessary for delegation 
to be performed. The Vision Web server requests a key from the Key Distribution Center (KDC—
a service which runs on domain controllers). The KDC authenticates the user and provides the 
key to the Vision Web Server for use in delegating the users’ credentials to the SharePoint 
server. 

Constrained Delegation, Unconstrained Delegation, and Protocol Transition 
 Unconstrained Delegation —Delegation is allowed from one computer in the domain to 

any other User/Computer or Service on the domain with no restrictions. This is the only 
model available in domain models that support Windows 2000 domain controllers. Vision 
7.1 does not support Unconstrained Delegation. 

 Constrained Delegation — Delegation that can be performed by a user or computer in 
the domain is limited to a specific User/Computer or Service. This method of delegation is 
much more granular and secure and is only available in Server 2003 native domains. 

 Protocol Transition — Use this option to transition the authentication protocol from the 
trusted server during the delegation. For Vision Document Management in an Internet 
deployment, we must transition the protocol from NTLM (as Kerberos is not available 
through the firewall) on the Vision Web server to Kerberos when communicating to the 
SharePoint server. This is necessary for Internet deployments because the client must 
negotiate the Kerberos ticket. This requires that Port 88 be open inbound through the 
firewall to the domain controller (not an advisable security configuration). The ticket is 
requested by the Vision Web server on the client's behalf and once granted, it is used to 
authenticate the user with Kerberos to the SharePoint server. This option is only available 
if the domain function level is Server 2003 native or higher. 

The following screen shot is of the Vision Application Pool Identity/SharePoint Service 
Account in a Server 2003 native functional (or higher) domain that allows us to show all of the 
available Delegation and protocol transition configurations. 
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Service Principal Name (SPN) 
In addition to the information provided in this document about the SPN needed for the Vision 
Application Pool Identity, below are some additional instances where SPNs may need to be 
configured for your Document Management deployment. 

If you are using, or will be using, a Fully Qualified Domain Name (FQDN) as your SharePoint 
URL (for example, http://sharepoint.company.com, where "sharepoint" is a custom DNS record 
added to avoid using the actual machine name of the server) and your deployment model 
requires the configuration of Constrained Delegation, you will need to register the custom FQDN 
using the Service Principal Name utility (setspn.exe) so that it can be configured for Constrained 
Delegation or Protocol Transition. 

Additionally, when deploying Microsoft Office SharePoint Server (MOSS) 2007, SharePoint 
Foundation 2010 and SharePoint Server 2010, the application pool identity for the SharePoint 
Web application defaults to a domain account. If your SharePoint Application Pool Identity is a 
domain account (as opposed to Network Service, which is the default for Windows SharePoint 
Services 3.0), you may need to create SPNs for this account as identified in the following 
Microsoft Support article (http://support.microsoft.com/?id=871179). 

  

Constrained Delegation 

Protocol Transition 

Unconstrained Delegation (not supported) 

No Delegation 

http://sharepoint.company.com/
http://support.microsoft.com/?id=871179
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Where to Go from Here 
Because of the many different deployment options available for Vision Document Management, 
please identify your deployment model (dependent on your chosen tier deployment and 
Operating System platform) from the list below and go to that section for complete step by step 
installation and configuration instructions. 

Single Tier New Document Management Installations  
SharePoint is NOT currently installed: 

In this configuration, Vision and SharePoint will be installed to the same physical server and 
SharePoint is not yet installed.  SharePoint will be installed by the Vision Document Management 
installation. 

• x86 – go to page 15 

o This installation supports Windows SharePoint Services 3.0 

• x64 – got to page 42 

o This installation supports Windows SharePoint Foundation 2010 

SharePoint is already installed:  

In this configuration, Vision and SharePoint will be installed to the same physical server and you 
already have an existing SharePoint installation that you wish to use with Vision Document 
Management. 

• x86 – go to page 72 

o This installation supports Windows SharePoint Services 3.0 

• x64 – got to page 86 

o This installation supports Windows SharePoint Services 3.0 or Windows 
SharePoint Foundation 2010 

  

 
!!IMPORTANT!! 

For Single Tier installations, Vision and SharePoint cannot be installed to the 
same web site.  If SharePoint is already installed and you wish to install Vision 
you will need to create a new website in IIS to host Vision. 

  

Multi-Tier New Document Management Installations 
SharePoint is NOT currently installed: 

In this configuration, Vision and SharePoint will be installed to different physical servers but 
SharePoint will be installed by the Vision Document Management installation. 

• x86 – go to page 100 

o This installation supports Windows SharePoint Services 3.0 

• x64 – go to page 134 

o This installation supports Windows SharePoint Foundation 2010 
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SharePoint is already installed: 

In this configuration, Vision and SharePoint will be installed to different physical servers and you 
already have an existing SharePoint installation that you wish to use with Vision Document 
Management. 

• x86 – go to page 173 

o This installation supports Windows SharePoint Services 3.0 

• x64 – got to page 195 

o This installation supports Windows SharePoint Services 3.0 or Windows 
SharePoint Foundation 2010 

Multi-Tier New Document Management Installations (SharePoint 
“Server” installations) 
In these configurations, SharePoint “Server” is already installed and Vision and/or Vision 
Document Management will be installed after the fact. 

• x86 – go to page 218 

o This installation supports Microsoft Office SharePoint Server (MOSS) 2007 

• x64 – go to page 240 

o This installation supports Microsoft Office SharePoint Server (MOSS) 2007 or 
Windows SharePoint Server 2010 

 
  

 
!! IMPORTANT INFORMATION FOR EXISTING SHAREPOINT 
INSTALLATIONS!! 

If you already have SharePoint installed and plan to use that existing installation 
of SharePoint for your Vision Document Management deployment, note that 
Vision Document Management does not support integrating with an existing 
SharePoint site collection and requires a dedicated top-level site on your 
SharePoint server. 
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Single Tier New Installation and Configuration for 
x86 (32-bit) Servers – SharePoint is NOT Installed  
  

 
!!IMPORTANT!! 

Please note the following for this configuration: 

1. In this configuration, Vision and SharePoint will be installed to the same 
physical server and SharePoint is NOT yet installed.   

2. The Vision Document Management installation will install Windows 
SharePoint Services 3.0.  SharePoint Foundation 2010 is not supported 
for this configuration. 

3. The Operating System for the server is x86 (32-bit).  
  

Prerequisites 
 Install/upgrade your Vision installation to Vision 7.1 (if applicable).  

 Change the Application Pool Identity for the DeltekVisionAppPool to be a domain user 
account (the Vision 7.1 installation sets this to be the local DeltekVision account).  

 The domain service account used above will also be the SharePoint Service account.  

 Add this domain user to the local Administrators and IIS_IUSRS group on the Vision 
server. 

Single Tier Installation and Configuration Steps 

Step Where to Perform Description 

1.  Vision Web/Application 
Server 

Configure Vision Application Pool Identity to Be a Domain 
Account 

2.  Vision Web/Application 
Server 

Install Vision 7.1 Document Management and WSS 3.0 

3.  Vision Web/Application 
Server 

Optional: Configure Authentication for the Vision Website 

4.  Vision Web/Application 
Server 

Optional: Configure Service Principal Name (SPN) for 
Vision Application Pool Identity 

5.  SharePoint Web 
/Application Server 

Run the SharePoint Products and Technologies 
Configuration Wizard 

6.  SharePoint Web 
/Application Server 

Use SharePoint Central Administration to Complete the 
SharePoint Configuration 

7.  SharePoint Web 
/Application Server 

Optional: Configure SharePoint for a Custom URL 
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8.  SharePoint Web 
/Application Server 

Verify IIS Configuration and Configure Deltek Vision 
Document Management .NET Assembly 

9.  Vision Web/Application 
Server 

Configure Document Management Service Account in 
Weblink 

10.  Vision Web/Application 
Server 

Configure Vision Document Management 

11.  Domain Configure Constrained Delegation – Not Required 

12.  Domain Optional: Configure Protocol Transition – Not Required 

Configure Vision Application Pool Identity to be a Domain Account  
You must change the Vision Application Pool Identity to be a domain account. The default is for 
Vision to use a local DeltekVision user created during the Vision installation. This change is 
necessary because of the local account’s inability to work with Active Directory.  

  

 For this account to be the Application Pool Identity it must be a member of the IIS_IUSRS group in 
addition to being a member of the local administrators group on the local server. 

  

To change the Vision Application Pool Identity, complete the following steps: 

1. Create a domain user account. This account must also be your SPF Service account. No 
domain Admin rights are needed for this account. 

2. Log on to the domain on the Vision Web/application server using an Administrator 
account. 

3. Open Internet Information Services: Start » All Programs » Administrative Tools » 
Internet Information Services (IIS) Manager. 

4. Expand the Server name and then click Application Pools. 

5. Select the DeltekVisionAppPool and select Advanced Settings from the Action pane 
on the right hand side.  The following displays: 
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6. Place your cursor in the Identity field and then click the ellipses button to set the identity.  

The Application Pool Identify dialog box displays:  

  
7. Select the Custom account option and click Set.  The Set Credentials dialog box 

displays. 



Single Tier New Installation and Configuration for x86 (32-bit) Servers – SharePoint is NOT Installed 

 

Document Management Installation Guide 18 

 

 
8. In the User name field, enter the Application Pool Identity in the form 

<Domain>\<Username>.  

9. In the Password and Confirm password fields, enter that user’s password.  

10. Click OK three times to set the identity. 

Install and Configure Vision 7.1 Document Management and 
Windows SharePoint Services (WSS) 3.0  
When you install Vision 7.1 Document Management WSS is automatically installed if your 
Operating System platform is x86 (32-bit). If you are upgrading from a previous version of Vision 
and/or already have WSS installed the changes made to your WSS installation are outlined 
below.  The steps to configure WSS are outlined in this section. 

The Document Management installation does the following: 

 Installs Web Service Extensions (WSE) 2.0 Sp3. 

 Installs WSS 3.0, if it is not already installed. 

 Copies Document Management files to the SharePoint ISAPI folder (c:\program 
files\common files\microsoft shared\web service extensions\12\isapi). 

 Copies Document Management files to the Vision Support folder (\program 
files\deltek\vision\support\DM\30). 

 Modifies the SharePoint Web.config file in the ISAPI directory to work with Vision 
Document Management. 

 Installs Deltek.Vision.WSS30.Server dll into the Global Assembly Cache (GAC). 

Install Vision Document Management and WSS 3.0 

To install Vision Document Management and WSS 3.0, complete the following steps: 

1. Download the DeltekVision71DM.exe file and run the setup on your Vision Web server.  

2. When a dialog box displays to indicate the IIS licensing requirements for the use of 
Windows Integrated Authentication (required to use Vision Document Management), click 
OK. 

3. On the first Document Management Installation Wizard page, click Next. 

4. On the License Agreement page, select I accept the terms of the license agreement 
and click Next. 

5. When this message displays, click Yes because this is a single-tier installation of Vision 
Document Management and this server will host both Vision and WSS 3.0. 
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6. On the Ready to Install the Program page, click Install to start the installation. The 

installation automatically downloads the version of Windows SharePoint Services 3.0, 
extracts the WSS 3.0 setup files, and installs Windows SharePoint Services.   

7. When the “Files extracted successfully” message displays, click the OK button to 
continue the installation. 

8. When the InstallShield Wizard Complete page displays, click Finish. 

Optional: Configure Authentication for the Vision Website 
  

 This is an “Optional” step for single tier installations and only required if the default 
configuration does not work for your setup. 

  

IIS Kernel Mode Authentication 

The default configuration of IIS when using Windows Integrated Authentication (required for 
Vision Document Management) is to use Kernel Mode Authentication.  Under this configuration, 
the application pool runs under the Machine account whether or not an identity has been 
established.  Because delegation is not required for single tier deployments of Vision Document 
Management, the additional configuration steps below are optional.  However, if you do change 
the default of enabling Kernel Mode Authentication you will be required to create an SPN which is 
outlined in next section. 

Identify if Kernel Mode Authentication Is Enabled 

Follow the steps below to identify if Kernel Mode Authentication is enabled. (In a default 
configuration of IIS, it will be enabled.) 

To identify the authentication status, complete the following steps: 

1. Log on to the domain on the Vision Web/application server using an Administrator 
account. 

2. Open Internet Information Services: Start » All Programs » Administrative Tools » 
Internet Information Services (IIS) Manager. 

3. Expand the server name, expand Sites, and expand Default Web Site or whichever site 
Vision is installed to. 

4. Select the Vision virtual directory and then double click Authentication in the 
Features view. 

5. Select Windows Authentication and verify that the status is Enabled 
(Anonymous Access should be Disabled).  If it is not, select Enable from the 
Actions menu. 

6. With Windows Authentication still selected, click Advanced settings on the 
Action menu. The Advanced Settings dialog box displays: 
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Kernel Mode Authentication Implementation 

As mentioned above, under this default configuration, Vision Document Management will 
not be able to delegate credentials to a WSS 3.0 server separate from the Vision 
Web/application server. Two possible configurations allow Document Management to 
function properly: 

 Disable Kernel Mode Authentication. In order to Disable Kernel Mode Authentication, 
simply uncheck the Enable Kernel Mode Authentication option under the Advanced 
Settings of the Windows Authentication feature for the Vision virtual directory. 

 Modify the ApplicationHost.config file to force the use of the Application Pool 
Identity.  In order to continue to use Kernel Mode Authentication but force the Application 
Pool to run under its Identity rather than the Machine account, it is necessary to modify 
the ApplicationHost.config file, the steps of which are outlined below: 

1. Click Start » All Programs » Accessories. 

2. Right-click Notepad, click Run as, and select the Administrator account.  
  

 This is necessary in order to save the changes we need to make to the 
ApplicationHost.config file, which is protected under UAC (User Account Control) on 
Windows Server 2008. 

  

3. Click Open on the File menu and locate the ApplicationHost.config file from 
c:\windows\system32\inetsrv\config.  

4. Click Find on the Edit menu in Notepad and search for the following:  

<location path=”Default Web Site/Vision”> 

5. Locate the windowsAuthentication tag and add useAppPoolCredentials=”true” as 
shown in the following:  
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6. Once the edits are complete, save your changes and restart IIS to make the changes 

effective.  

Both of these configuration options require that a Service Principal Name be established 
for the Application Pool Identity. The following section provides more information on 
creating the SPN. 

Optional: Configure Service Principal Name (SPN) for Vision Application 
Pool Identity 
  

 This is an “Optional” step for single tier installations and only required if the default 
configuration does not work for your setup. 

  

 

Under the default configuration with Kernel Mode Authentication enabled, it is not necessary to 
create a Service Principal Name for the Application Pool Identity for Windows Authentication and 
Vision Document Management will work just fine on single tier installations as delegation is not 
required.   

However, if you opted to modify the default of enabling Kernel Mode Authentication for the Vision 
web site as described in the preceding section, it will be necessary to create a Service Principal 
Name (SPN) for the domain user running the Vision Application Pool Identity. 
  

 Domain rights are required to complete this step. 
  

After you establish one of the above Kernel Mode configuration changes, use the steps 
below to create a Service Principal Name for the Application Pool Identity of the 
DeltekVisionAppPool. 

  

 The setspn utility is installed by default on Windows Server 2008. It is not necessary to download 
and install it separately. 

  

To create a service principal name, complete the following steps: 

1. Open a command prompt and enter: 

setspn –A http/<Vision Web/App Server name> <domain app pool identity> 

For example: setspn –A http/camqainetk3nwb5 inettest2k3n\dmservacct3tier 
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2. Repeat for the FQDN of the server. 
 
For example: setspn –A http/camqainetk3nwb5.inettest2k3n.com 
inettest2k3n\dmservacct3tier 

  

 
See the following related Microsoft Knowledge Base article for more information: 

http://support.microsoft.com/?id=871179  
  

Run the SharePoint Products and Technologies Configuration Wizard 

To run the SharePoint Products and Technologies Configuration wizard, complete the 
following steps: 

1. Click Start » Administrative Tools » SharePoint Products and Technologies Wizard. 
The Welcome page displays. 

 
2. Click Next. The following dialog box displays. 

 

http://support.microsoft.com/?id=871179
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3. Click Yes. The Connect to a server farm page displays. 
 

 
4. Select the No, I want to create a new server farm option and click Next. The Specify 

Configuration Database Settings page displays.  
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5. Enter the name of the database server to host the SharePoint configuration database and 
accept the default database name: SharePoint_Config. 

  

 Your SharePoint database access account will need to have the dbcreator and 
securityadmin SQL Server Roles.  This is accomplished by adding the domain account as 
a SQL Server login and adding the roles as shown below: 
 

  
 
 

  

6. In Username, enter the domain and name of the Vision Application Pool Identity (as 
configured earlier) as the username for the SharePoint database access account, and 
enter the user’s password in Password. 

7. Click Next. The Configure SharePoint Central Administration Web Application page 
displays. 
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8. Specify the port to be used for the SharePoint Central Administration Web site and select 

Negotiate (Kerberos) for the authentication provider.   

9. Click Next.  The following dialog box displays. 

 
10. Click Yes to continue using Kerberos with Windows Authentication. The Completing the 

SharePoint Products and Technologies Configuration Wizard page displays. 
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11. Click Next to begin the configuration. This process may take some time to complete. The 
Configuration Successful page displays when configuration is complete. 

 
12. Click Finish to finish the configuration process. The SharePoint Central Administration 

page displays. 
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Use SharePoint Central Administration to Complete the SharePoint 
Configuration 

To complete the SharePoint Configuration, complete the following steps: 

1. When you click Finish in the preceding procedure, SharePoint Central Administration is 
launched. 

 
2. Click Operations. The Operations page displays.  
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3. Click Services on Server under Topology and Services to configure the SharePoint 

Services search.  

 
4. Locate the Windows SharePoint Services Search option and click Start. 
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5. Configure the search service to include the Service account and Content Access account 

(use the same account information as your Vision Application Pool Identity). 

6. Configure Search Database as shown above and click Start. After a minute or so, the 
service’s status changes to Started.  
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7. Click Application Management to configure the SharePoint Web Application. 

 
8. Select the Create or extend Web application option. The Create or Extend Web 

Application page displays. 
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9. Click Create a new Web application. The Create a New Web Application page displays. 
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10. Select the Create a new IIS web site option. Enter a description for the Web site and 
specify a port different that that being used for the Vision web site in Port.   
 
SharePoint defaults to ‘SharePoint – 80’ and ‘80’ as the site name and port, if you change 
the port to be 81 (as shown), the web site name changes automatically to ‘SharePoint – 
81’ 

  

 
Warning! 

Vision and SharePoint cannot be installed to the same website.  Doing so will break the 
Vision application! . 

Alternatively, you can create a new Web site ahead of time using a different IP address or 
port and select the option to Use an existing IIS web site. 

  

 
Note the entry in Path, which by default is the root of your WSS Web site in a directory 
named after the port chosen under c:\inetpub\wwwroot\wss\virtualdirectories.  This is the 
folder location where you will copy the Vision SharePoint assembly to later in this section. 

11. Select Negotiate (Kerberos) under Authentication provider. 

12. For the Allow Anonymous and Use Secure Sockets Layer (SSL) options, accept the 
default of No. If you want to use SSL with SharePoint, you can configure SSL later, but 
you must not configure SSL to be required as the web service calls from the Vision 
Web/Application server cannot use SSL. 
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13. Select the Create new application pool option and provide a name (Deltek 

recommends using the same name as the Web site).  NOTE: Since the SharePoint 
Application Pool will run as Network Service, no SPN is required. 

14. Select Predefined and Network Service for the security account to be used for the 
application pool. 

15. Select the Restart IIS Manually option for Reset Internet Information Services. 
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16. Verify the name of the server in Database Server. (It should be the same as that used 
for the SharePoint configuration database server.) Accept the default in Database Name 
for the content database.  

17. Select Windows authentication (recommended) under Database authentication. 
(This will use the SharePoint service account and Vision Application Pool Identity 
configured previously). 

18. Select the search server in Select Windows SharePoint Services search server and 
click OK.  This is necessary for the document search in Vision to function correctly. The 
following dialog box displays. 

 
19. Click OK to use Kerberos for Windows Authentication. After a few minutes, the 

Application Created page displays. It indicates the status of the process to create a new 
Web application. 

 
20. Do not click the Create Site Collection link at this time. It is still necessary to add 

DeltekVision as a managed path with explicit inclusion before you create the site 
collection. 

21. Click Application Management and select the Define Managed Paths option.  
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22. Enter DeltekVision in Path and select Explicit inclusion in Type. 

23. Click OK.  

 
24. Click Application Management and select the Create Site Collection option under 

SharePoint Site Management. 
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The Create Site Collection page displays. 

 
25. Enter Deltek Vision in Title and enter a description, if appropriate. 

26. From the URL drop-down list, select /deltekvision. This will be the top level root site for 
Vision Document Management. 
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27. Under Select a template, accept the default of Team Site for the template to be used 

and enter a username in each of the User name fields for the primary and secondary site 
collection administrators.  One of these needs to be the Vision Application Pool identity. 

28. Select No Quota in Select a quota template and click OK. The Top-Level Site 
Successfully Created page displays. 
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29. Click the link for the top level site (in our example it is 
http://camqainetk3nwb1:81/deltekvision) to display the site. 

 
30. The SharePoint configuration is complete. Close SharePoint Central Administration. 

Optional: Configure SharePoint for a Custom URL  
If you will be configuring your SharePoint server to use a custom DNS record for the URL (e.g. 
http://sharepoint.company.com instead of http://servername.company.com http://servername), 
then you must create additional SPNs and also create Alternate Access Mappings in SharePoint.  
It is recommended that this step be completed before Vision Document Management is 
configured in order to eliminate re-work.  

See “Appendix B: ” for more information. 

Verify IIS Configuration and Configure Deltek Vision Document 
Management .NET Assembly 

To verify IIS configuration, complete the following steps: 

1. Use the steps that follow to open Internet Information Services to view these Web sites: 

 Default Web Site — This is your Vision Web Site 

 SharePoint – 81 — This is your WSS 3.0 Web Site  

 SharePoint Central Administration Web Site 

http://camqainetk3nwb1:81/deltekvision
http://sharepoint.company.com/
http://servername/


Single Tier New Installation and Configuration for x86 (32-bit) Servers – SharePoint is NOT Installed 

 

Document Management Installation Guide 39 

 

 
2. Copy the Vision Document Management .NET assembly to SharePoint site directory. 

Copy Deltek.Vision.WSS30.Server.dll from <Vision Installation Directory>\Support\DM\30 
to c:\inetput\wwwroot\wss\Virtual Directories\<site>\bin 

  

 By default, the <site> directory references the port chosen. In our example, the port is 81.  
  

Configure Document Management Service Account in Weblink 
You must configure the Document Management service account (username/password) on the 
System Settings tab of the Deltek Vision Weblink utility.  

To configure the service account in Weblink, complete the following steps: 

1. On the Vision Web server, launch Weblink from Start » Programs » Deltek Vision 

2. Enter the Weblink password when prompted. 

3. Click the System Settings tab.  

4. In the Document Management group box, enter your SharePoint username and 
password.  This account is your SharePoint Service account/Deltek Vision Application 
Pool Identity.  

5. Click the Test button and SharePoint Credentials to validate that the information entered 
is correct. 
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Configure Vision Document Management 
To configure Vision Document Management, complete the following steps: 

1. Log in to Vision using an account that has access to the Configuration menus. 

2. Click Configuration » General » System Settings and select the Document 
Management tab. 

 
3. Select the Enable Document Management check box. 

4. Enter the name of the server hosting Document Management. This should be the server 
name only, FQDN’s or custom DNS values are not needed here. Enter this value without 
the protocol prefix (for example, remove the http://). In the illustration above, the value is 
camdevk82twar 

5. Enter the port in Virtual Server Port. In our example the port is 81. 

6. Click the Lookup icon to select the current site. 
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7. The Select Web Site dialog box displays the available sites. Select a site and click OK. 

8. Save your changes. 

Configure Constrained Delegation 
Constrained Delegation is not required for Single Server installations. 

Optional: Configure Protocol Transition 
Protocol Transition is not required for Single Server installations. 
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Single Tier New Installation and Configuration for 
x64 (64-bit) Servers – SharePoint is NOT Installed 
  

 
!!IMPORTANT!! 

Please note the following for this configuration: 

1. In this configuration, Vision and SharePoint will be installed to the same 
physical server and SharePoint is NOT yet installed.   

2. The Vision Document Management installation will install SharePoint 
Foundation 2010.  Windows SharePoint Services is not supported for this 
configuration. 

3. The Operating System for the server is x64 (64-bit).  
  

 

Before you proceed: 

 Review the Hardware and Software Requirements for SharePoint Foundation 2010. See 
http://technet.microsoft.com/en-us/library/cc288751.aspx for more information. 

 Make sure your SharePoint servers are current with all available Windows Updates. 
Deltek strongly recommends that you do this, to ensure that the SharePoint prerequisite 
installer completes successfully. 

Specific database server requirements for SharePoint Foundation 2010 are as follows: 

Environment Minimum Requirement 

Database server in 
a farm 

One of the following: 

 The 64-bit edition of Microsoft SQL Server 2008 R2. 

 The 64-bit edition of Microsoft SQL Server 2008 with Service Pack 
1 (SP1) and Cumulative Update 2.  
 
NOTE: Deltek recommends SQL 2008 Sp3 with Vision 7.1 

 The 64-bit edition of Microsoft SQL Server 2005 with Service Pack 
3 (SP3).  
 
NOTE: Even though SQL 2005 is supported for SharePoint 
Foundation 2010, Deltek does not support SQL Server 2005 with 
Vision 7.1 if you will be using the same database server for Vision 
and SPF 2010. 

 

For more information about choosing a version of SQL Server, see SQL Server 
2008 R2 and SharePoint 2010 Products: Better Together (white paper) (SharePoint 
Server 2010). 

 
  

http://technet.microsoft.com/en-us/library/cc288751.aspx
http://technet.microsoft.com/en-us/library/cc990273.aspx
http://technet.microsoft.com/en-us/library/cc990273.aspx
http://technet.microsoft.com/en-us/library/cc990273.aspx
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 The Document Management installation does not check the edition, platform or 
version of your SharePoint database server but the SharePoint 2010 Products 
Configuration Wizard will and will fail to configure SharePoint until the database 
prerequisites have been met.   

For example, you may see an error similar to the following: 

 
  

Prerequisites 
 Install/upgrade your Vision installation to Vision 7.1 (if applicable).  

 Change the Application Pool Identity for the DeltekVisionAppPool to be a domain user 
account (the Vision 7.1 installation sets this to be the local DeltekVision account).  

 The domain service account used above will also be the SharePoint Service account.  

 Add this domain user to the local Administrators and IIS_IUSRS group on the Vision 
server. 

Single Tier Installation and Configuration Steps 

Step Where to Perform Description 

1.  Vision Web/Application 
Server 

Configure Vision Application Pool Identity to Be a Domain 
Account 

2.  Vision Web/Application 
Server 

Install Vision 7.1 Document Management and SharePoint 
Foundation 2010 

3.  Vision Web/Application 
Server 

Optional: Configure Authentication for the Vision Website 

4.  Vision Web/Application 
Server 

Optional: Configure Service Principal Name (SPN) for 
Vision Application Pool Identity 

5.  SharePoint Web 
/Application Server 

Run the SharePoint 2010 Products Configuration Wizard 

6.  SharePoint Web 
/Application Server 

Use SharePoint Central Administration to Complete the 
SharePoint Configuration 
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7.  SharePoint Web 
/Application Server 

Optional: Configure SharePoint for a Custom URL 

8.  SharePoint Web 
/Application Server 

Verify IIS Configuration and Configure Deltek Vision 
Document Management .NET Assembly 

9.  Vision Web/Application 
Server 

Configure Document Management Service Account in 
Weblink 

10.  Vision Web/Application 
Server 

Configure Vision Document Management 

11.  Domain Configure Constrained Delegation – Not Required 

12.  Domain Optional: Configure Protocol Transition – Not Required 

Configure Vision Application Pool Identity to Be a Domain Account  
You must change the Vision Application Pool Identity to be a domain account. The default is for 
Vision to use a local DeltekVision user created during the Vision installation. This change is 
necessary because of the local account’s inability to work with Active Directory.  

  

 For this account to be the Application Pool Identity it must be a member of the IIS_IUSRS group in 
addition to being a member of the local administrators group on the local server.. 

  

To change the Vision Application Pool Identity, complete the following steps: 

1. Create a domain user account. This account must also be your SPF Service account. No 
domain Admin rights are needed for this account. 

2. Log on to the domain on the Vision Web/application server using an Administrator 
account. 

3. Open Internet Information Services: Start » All Programs » Administrative Tools » 
Internet Information Services (IIS) Manager. 

4. Expand the Server name and then click Application Pools. 

5. Select the DeltekVisionAppPool and select Advanced Settings from the Action pane 
on the right hand side.  The following displays: 
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6. Place your cursor in the Identity field and then click the ellipses button to set the identity.  

The Application Pool Identify dialog box displays:  

  
7. Select the Custom account option and click Set.  The Set Credentials dialog box 

displays. 
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8. In the User name field, enter the Application Pool Identity in the form 

<Domain>\<Username>.  

9. In the Password and Confirm password fields, enter that user’s password.  

10. Click OK three times to set the identity. 

Install and Configure Vision 7.1 Document Management and 
SharePoint Foundation (SPF) 2010 
When you install Vision 7.1 Document Management SPF is automatically installed if your 
Operating System platform is x64 (64-bit). If you are upgrading from a previous version of Vision 
and/or already have SPF installed the changes made to your SPF installation are outlined below.  
The steps to configure SPF are outlined in this section. 

The Document Management installation does the following: 

 Installs Web Service Extensions (WSE) 2.0 Sp3. 

 Installs SPF 2010, if it is not already installed. 

 Copies Document Management files to the SharePoint ISAPI folder (c:\program 
files\common files\microsoft shared\web service extensions\14\isapi). 

 Copies Document Management files to the Vision Support folder (\program 
files\deltek\vision\support\DM\30). 

 Modifies the SharePoint Web.config file in the ISAPI directory to work with Vision 
Document Management. 

 Installs Deltek.Vision.WSS30.Server dll into the Global Assembly Cache (GAC). 

Install Vision Document Management and SharePoint Foundation 

To install Vision Document Management and SPF 2010, complete the following steps: 

1. As indicated at the beginning of this section, it is highly recommended that you install all 
available Windows Updates prior to proceeding with the installation. 

2. Download the DeltekVision71DM.exe file and run the setup on your Vision Web server.  

3. The installation will check to ensure that the IIS Role service, Windows Authentication, is 
installed. If the Role Service is not installed, you are prompted to install it and the setup 
exits: 



Single Tier New Installation and Configuration for x64 (64-bit) Servers – SharePoint is NOT Installed 

 

Document Management Installation Guide 47 

 

 
4. After installing the Windows Authentication IIS Role Service, re-run the Document 

Management installation. The installation checks to ensure that Hotfix KB979917 is 
installed (not applicable if you have Windows Server 2008 R2 Sp1 installed), which is a 
SPF 2010 Prerequisite not installed by the Prerequisite Installer. If it is not installed you 
are prompted to install it, the setup exits, and a browser window opens to display the 
download site.  Make sure to choose the correct x64 version; Vista is Server 2008 and 
Win7 is Server 2008 R2. 

 
5. After installing the hotfix for KB979917 (if applicable), re-run the Document Management 

installation.  

6. When a dialog box displays to indicate the IIS licensing requirements for the use of 
Windows Integrated Authentication (required to use Vision Document Management), click 
OK. 

7. On the first Document Management Installation Wizard page, click Next. 

8. On the License Agreement page, select I accept the terms of the license agreement 
and click Next. 

9. When this message displays, click Yes because this is a single-tier installation of Vision 
Document Management and this server will host both Vision and SPF 2010. 

 
10. On the Ready to Install the Program page, click Install to start the installation. The 

installation automatically downloads SharePoint Foundation 2010, extracts the setup files 
and installs SharePoint. 

11. When the “Files extracted successfully” message displays, click the OK button to 
continue the installation. 

12. The installation will launch the SharePoint Foundation Prerequisite Installer to install all 
prerequisite components.  
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If there are errors installing any of these components you will see a dialog indicating that 
the Prerequisite Installer failed and a link to open the log file and the installation will end. 
The following is an example: 
 

 
The following is an excerpt from the Prerequisite Installer log file related to this error 
which indicates a problem installing the Microsoft Chart Controls for Microsoft .Net 
Framework 3.5: 

 
To locate the Prerequisite Installer log file, check: 

c:\users\<username>\appdata\local\temp\<numbered subdirectory>. 

If there are errors installing any software prerequisites, download and install them 
manually and then re-run the Document Management installation. Links to all software 
prerequisites can be found at: http://technet.microsoft.com/en-us/library/cc288751.aspx.    

If a reboot is necessary, a dialog box displays to indicate this and the installation ends. 
The following is an example: 
 

 
13. After resolving all issues with the prerequisite installations and/or rebooting as required, 

start the Document Management installation again to complete the installation. You may 
need to run the installation several times to complete. 

14. The installation then launches the SharePoint Foundation installation routine. If there are 
errors installing SharePoint, a dialog box displays with a link to open the log file. 

15. After resolving any issues, start the Document Management installation again to 
complete the installation. 

16. When the InstallShield Wizard Complete page displays, click Finish. 

http://technet.microsoft.com/en-us/library/cc288751.aspx
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Optional: Configure Authentication for the Vision Website 
  

 

This is an “Optional” step for single tier installations and only required if the default 
configuration does not work for your setup. 

  

IIS Kernel Mode Authentication 

The default configuration of IIS when using Windows Integrated Authentication (required for 
Vision Document Management) is to use Kernel Mode Authentication.  Under this configuration, 
the application pool runs under the Machine account whether or not an identity has been 
established.  Because delegation is not required for single tier deployments of Vision Document 
Management, the additional configuration steps below are optional.  However, if you do change 
the default of enabling Kernel Mode Authentication you will be required to create an SPN which is 
outlined in next section. 

Identify if Kernel Mode Authentication Is Enabled 

Follow the steps below to identify if Kernel Mode Authentication is enabled. (In a default 
configuration of IIS, it will be enabled.) 

To identify the authentication status, complete the following steps: 

1. Log on to the domain on the Vision Web/application server using an Administrator 
account. 

2. Open Internet Information Services: Start » All Programs » Administrative Tools » 
Internet Information Services (IIS) Manager. 

3. Expand the server name, expand Sites, and expand Default Web Site or whichever site 
Vision is installed to. 

4. Select the Vision virtual directory and then double click Authentication in the 
Features view. 

5. Select Windows Authentication and verify that the status is Enabled 
(Anonymous Access should be Disabled).  If it is not, select Enable from the 
Actions menu. 

6. With Windows Authentication still selected, click Advanced settings on the 
Action menu. The Advanced Settings dialog box displays: 
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Kernel Mode Authentication Implementation 

As mentioned above, under this default configuration, Vision Document Management will 
not be able to delegate credentials to a WSS 3.0 server separate from the Vision 
Web/application server. Two possible configurations allow Document Management to 
function properly: 

 Disable Kernel Mode Authentication. In order to Disable Kernel Mode Authentication, 
simply uncheck the Enable Kernel Mode Authentication option under the Advanced 
Settings of the Windows Authentication feature for the Vision virtual directory. 

 Modify the ApplicationHost.config file to force the use of the Application Pool 
Identity.  In order to continue to use Kernel Mode Authentication but force the Application 
Pool to run under its Identity rather than the Machine account, it is necessary to modify 
the ApplicationHost.config file, the steps of which are outlined below: 

1. Click Start » All Programs » Accessories. 

2. Right-click Notepad, click Run as, and select the Administrator account.  
  

 This is necessary in order to save the changes we need to make to the 
ApplicationHost.config file, which is protected under UAC (User Account Control) on 
Windows Server 2008. 

  

3. Click Open on the File menu and locate the ApplicationHost.config file from 
c:\windows\system32\inetsrv\config.  

4. Click Find on the Edit menu in Notepad and search for the following:  

<location path=”Default Web Site/Vision”> 

5. Locate the windowsAuthentication tag and add useAppPoolCredentials=”true” as 
shown in the following:  

 
6. Once the edits are complete, save your changes and restart IIS to make the changes 

effective.  

Both of these configuration options require that a Service Principal Name be established 
for the Application Pool Identity. The following section provides more information on 
creating the SPN. 
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Optional: Configure Service Principal Name (SPN) for Vision Application 
Pool Identity 
  

 

This is an “Optional” step for single tier installations and only required if the default 
configuration does not work for your setup. 

  

Under the default configuration with Kernel Mode Authentication enabled, it is not necessary to 
create a Service Principal Name for the Application Pool Identity for Windows Authentication and 
Vision Document Management will work just fine on single tier installations as delegation is not 
required.   

However, if you opted to modify the default of enabling Kernel Mode Authentication for the Vision 
web site as described in the preceding section, it will be necessary to create a Service Principal 
Name (SPN) for the domain user running the Vision Application Pool Identity. 
  

 Domain rights are required to complete this step. 
  

After you establish one of the above Kernel Mode configuration changes, use the steps 
below to create a Service Principal Name for the Application Pool Identity of the 
DeltekVisionAppPool. 

  

 The setspn utility is installed by default on Windows Server 2008. It is not necessary to download 
and install it separately. 

  

To create a service principal name, complete the following steps: 

1. Open a command prompt and enter: 

setspn –A http/<Vision Web/App Server name> <domain app pool identity> 

For example: setspn –A http/camqainetk3nwb5 inettest2k3n\dmservacct3tier 

2. Repeat for the FQDN of the server. 
 
For example: setspn –A http/camqainetk3nwb5.inettest2k3n.com 
inettest2k3n\dmservacct3tier 

  

 
See the following related Microsoft Knowledge Base article for more information: 

http://support.microsoft.com/?id=871179  
  

Run the SharePoint 2010 Products Configuration Wizard 

To run the SharePoint 2010 Products Configuration Wizard, complete the following steps: 

1. Click Start » All Programs » Microsoft SharePoint 2010 Products » SharePoint 2010 
Products Configuration Wizard. The Welcome page displays. 

http://support.microsoft.com/?id=871179
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2. Click Next. The following dialog box displays. 

 
3. Click Yes. The Connect to a server farm page displays. 
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4. Select the Create a new server farm option and click Next. The Specify Configuration 

Database Settings page displays.  

 
5. Enter the name of the database server to host the SharePoint configuration database and 

accept the default database name: SharePoint_Config. 
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 Your SharePoint database access account will need to have the dbcreator and 
securityadmin SQL Server Roles.  This is accomplished by adding the domain account as 
a SQL Server login and adding the roles as shown below: 
 

  
  

6. In Username, enter the domain and name of the Vision Application Pool Identity (as 
configured earlier) as the username for the SharePoint database access account, and 
enter the user’s password in Password. 

7. Click Next. The Specify Farm Security Settings page displays: 
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8. Enter a Passphrase for your Farm. 

9. Click Next. The Configure SharePoint Central Administration Web Application page 
displays. 

 
10. Select the Specify port number check box and enter the port to be used for the 

SharePoint Central Administration Web site and select the Negotiate (Kerberos) option 
for the Authentication provider to use. 

11. Click Next. The following dialog box displays.  

 
12. Click Yes to continue using Kerberos with Windows Authentication. The Completing the 

SharePoint Products and Technologies Configuration Wizard page displays. 
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13. Click Next to begin the configuration. This process may take some time to complete. The 
Configuration Successful page displays when configuration is complete. 

 
14. Click Finish to finish the configuration process. The SharePoint Central Administration 

page displays. 
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Use SharePoint Central Administration to Complete the SharePoint 
Configuration 

To finish the SharePoint Configuration, complete the following steps: 

1. When you click Finish in the preceding procedure, SharePoint Central Administration is 
launched. 

 
2. Decide whether to sign up for the SharePoint Customer Experience Program and click 

OK. The Configure your SharePoint Farm Wizard page displays.  
  

 
!!IMPORTANT!! 

Do not use the SharePoint Farm Wizard. Doing so will cause Vision to stop functioning!   
Instead, choose the Cancel button “No, I will configure everything myself” 

  

 
3. Click Cancel to configure everything yourself. The main Central Administration page 

displays. 
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4. Under System Settings, select Manage Services on Server. The Services on Server 

page displays: 

 
5. Locate SharePoint Foundation Search and click Start. 
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6. Configure the search service to include the Service account and Content Access account 

(use the same account information as your Vision Application Pool Identity). 

7. Configure Search Database as shown above and click Start. After a minute or so, the 
service’s status changes to Started.  
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8. Click Application Management and then Manage Web Applications. The Web 

Applications page displays. 

 
9. Click the New button. The Create New Web Application page displays. 
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10. Select Classic Mode Authentication as the Authentication type. 

11. Select the Create a new IIS web site option. Enter a description for the Web site and 
specify a port different that that being used for the Vision web site in Port.   
 
SharePoint defaults to ‘SharePoint – 80’ and ‘80’ as the site name and port, if you change 
the port to be 81 (as shown), the web site name changes automatically to ‘SharePoint – 
81’ 

  

 
Warning! 

With SPF 2010, Vision and SharePoint cannot be installed to the same Web site. 
Choosing to install SPF to the same website as Vision will cause Vision to no longer 
function. 

Alternatively, you can create a new Web site (different from the website Vision is installed 
to) ahead of time using a different IP address or port and select the option to Use an 
existing IIS web site. 

  

Note the entry in Path, which by default is the root of your WSS Web site in a directory 
named after the port chosen under c:\inetpub\wwwroot\wss\virtualdirectories. 
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12. Select Negotiate (Kerberos) under Authentication provider. 

13. For the Allow Anonymous and Use Secure Sockets Layer (SSL) options, accept the 
default of No. If you want to use SSL with SharePoint, you can configure SSL later, but 
you must not configure SSL to be required as the web service calls from the Vision 
Web/Application server cannot use SSL.. 

 
14. Select the Create new application pool option and provide a name (Deltek 

recommends using the same name as the Web site for consistence, for example, 
SharePoint - 81).  
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15. Using Network Service is not an option for SPF. Use the same account used for the 
Deltek Vision Application Pool.  NOTE: Since the SharePoint Application Pool will run as 
a domain account, an SPN is required; however, since this application pool will run as the 
same account as the Deltek Vision Application Pool, and you have already created an 
SPN for that account, no additional SPN’s are necessary. 

16. Verify the name of the server in Database Server. (It should be the same as that used 
for the SharePoint configuration database server.) Accept the default in Database Name 
and it is recommended to modify the name of the Content database to something more 
recognizable (e.g. WSS_Content_SharePoint81).  

17. Select Windows authentication (recommended) under Database authentication. 
(This will use the SharePoint service account and Vision Application Pool Identity 
configured previously.) 

 
18. Select the search server in Select Windows SharePoint Foundation search server 

and click OK. The following dialog box displays. 

 
19. Click OK to use Kerberos for Windows Authentication. After a few minutes, the 

Application Created page displays. It indicates the status of the process to create a new 
Web application. 
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20. Do not click the link to Create Site Collection link at this time. It is still necessary to add 

DeltekVision as a managed path with explicit inclusion before you create the site 
collection.   

21. Click OK, the Web Applications page displays. 

 
22. Select the SharePoint – 81 web application and click Managed Paths. The Define 

Managed Paths page displays.  
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23. Enter DeltekVision in Path and select Explicit inclusion in Type and click Add Path. 

24. Click OK.  DeltekVision is now added as a Managed Path. 

 
25. Click Application Management and select the Create Site Collection option under Site 

Collections. 
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The Create Site Collection page displays. 

 
26. Enter Deltek Vision in Title and enter a description, if appropriate. 

27. From the URL drop-down list, select /deltekvision. This will be the top level root for 
Vision Document Management. 



Single Tier New Installation and Configuration for x64 (64-bit) Servers – SharePoint is NOT Installed 

 

Document Management Installation Guide 67 

 

 
28. Under Select a template, accept the default of Team Site for the template to be used 

and enter a username in each of the User name fields for the primary and secondary site 
collection administrators.  One of these needs to be the Vision Application Pool identity. 

29. Select No Quota in Select a quota template and click OK. The Top-Level Site 
Successfully Created page displays. 

 
30. Click the link for the top level site (in our example it is 

http://camqainetk38wb9:81/deltekvision) to display the site. 

http://camqainetk38wb9:81/deltekvision
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31. The SharePoint configuration is complete. Close SharePoint Central Administration. 

Optional: Configure SharePoint for a Custom URL  
If you will be configuring your SharePoint server to use a custom DNS record for the URL (e.g. 
http://sharepoint.company.com instead of http://servername.company.com http://servername), 
then you must create additional SPNs and also create Alternate Access Mappings in SharePoint.  
It is recommended that this step be completed before Vision Document Management is 
configured in order to eliminate re-work.  

See “Appendix B: Configure SharePoint for a Custom URL” for more information. 

Verify IIS Configuration and Configure Deltek Vision Document 
Management .NET Assembly 

To verify IIS configuration, complete the following steps: 

1. Use the directions that follow to open Internet Information Services to view these Web 
sites: 

 Default Web Site — This is your Vision Web Site 

 SharePoint – 81 — This is your SPF 2010 Web Site 

 SharePoint Central Administration Web Site 

http://sharepoint.company.com/
http://servername/
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2. Copy the Vision Document Management .NET assembly to SharePoint site directory. 

 
Copy Deltek.Vision.WSS30.Server.dll from <Vision Installation Directory>\Support\DM\30 
to: 

c:\inetput\wwwroot\wss\Virtual Directories\<site>\bin 
  

 By default, the <site> directory references the port chosen. In our example, the port is 81. 
  

Configure Document Management Service Account in Weblink 
You must configure the Document Management service account (username/password) on the 
System Settings tab of the Deltek Vision Weblink utility.  

To configure the service account in Weblink, complete the following steps: 

1. On the Vision Web server, launch Weblink from Start » Programs » Deltek Vision 

2. Enter the Weblink password when prompted. 

3. Click the System Settings tab.  

4. In the Document Management group box, enter your SharePoint username and 
password.  This account is your SharePoint Service account/Deltek Vision Application 
Pool Identity.  

5. Click the Test button and SharePoint Credentials to validate that the information entered 
is correct. 
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Configure Vision Document Management 
To configure Vision Document Management, complete the following steps: 

1. Log in to Vision using an account that has access to the Configuration menus. 

2. Click Configuration » General » System Settings and select the Document 
Management tab. 

 
3. Select the Enable Document Management check box. 

4. Enter the name of the server hosting Document Management. This should be the server 
name only, FQDN’s or custom DNS values are not needed here.. Enter this value without 
the protocol prefix (for example, remove the http://). In the illustration above, the value is 
camopsk82twar. 

5. Enter the port in Virtual Server Port. In our example the port is 81. 

6. Click the Lookup icon to select the current site. 
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7. The Select Web Site dialog box displays the available sites. Select a site and click OK. 

8. Save your changes. 

Configure Constrained Delegation 
Constrained Delegation is not required for Single Server installations. 

Optional: Configure Protocol Transition 
Protocol Transition is not required for Single Server installations. 
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Single Tier Installation and Configuration for x86 
(32-bit) Servers – SharePoint Already Installed 
  

 
!!IMPORTANT!! 

Please note the following for this configuration: 

 In this configuration, Vision and SharePoint will be installed to the same 
physical server. 

 SharePoint is already installed on the server so the Vision Document 
Management installation will NOT install SharePoint. 

 The installation of SharePoint is WSS 3.0. 

 Vision is installed to a different website than that being used for 
SharePoint as they are not compatible when installed to the same 
website. 

 The Operating System for the server is x86 (32-bit).  
  

Prerequisites 
 Install/upgrade your Vision installation to Vision 7.1 (if applicable).  

 Identify the domain user account being used for the SharePoint Farm Administrator 
account. 

 Change the Application Pool Identity for the DeltekVisionAppPool to be the SharePoint 
Farm Administrator account above (the Vision 7.1 installation sets this to be the local 
DeltekVision account).  

 Add this domain user to the local Administrators and IIS_IUSRS group on the Vision 
server if not already done by the SharePoint installation. 

Single Tier Installation and Configuration Steps 

Step Where to Perform Description 

1.  Vision Web/Application 
Server 

Configure Vision Application Pool Identity to Be a Domain 
Account 

2.  Vision Web/Application 
Server 

Install Vision 7.1 Document Management  

3.  Vision Web/Application 
Server 

Optional: Configure Authentication for the Vision Website 

4.  Vision Web/Application 
Server 

Optional: Configure Service Principal Name (SPN) for 
Vision Application Pool Identity 

5.  SharePoint Web 
/Application Server 

Use SharePoint Central Administration to Complete the 
SharePoint Configuration 
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6.  SharePoint Web 
/Application Server 

Verify IIS Configuration and Configure Deltek Vision 
Document Management .NET Assembly 

7.  Vision Web/Application 
Server 

Configure Document Management Service Account in 
Weblink 

8.  Vision Web/Application 
Server 

Configure Vision Document Management 

9.  Domain Configure Constrained Delegation – Not Required 

10.  Domain Optional: Configure Protocol Transition – Not Required 

Configure Vision Application Pool Identity to be a Domain Account  
You must change the Vision Application Pool Identity to be a domain account. The default is for 
Vision to use a local DeltekVision user created during the Vision installation. This change is 
necessary because of the local account’s inability to work with Active Directory.  

  

 For this account to be the Application Pool Identity it must be a member of the IIS_IUSRS group in 
addition to being a member of the local administrators group on the local server.. 

  

To change the Vision Application Pool Identity, complete the following steps: 

1. Create a domain user account. This account must also be your SPF Service account. No 
domain Admin rights are needed for this account. 

2. Log on to the domain on the Vision Web/application server using an Administrator 
account. 

3. Open Internet Information Services: Start » All Programs » Administrative Tools » 
Internet Information Services (IIS) Manager. 

4. Expand the Server name and then click Application Pools. 

5. Select the DeltekVisionAppPool and select Advanced Settings from the Action pane 
on the right hand side. 
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6. Place your cursor in the Identity field and then click the ellipses button to set the identity.  

The Application Pool Identify dialog box displays:  

  
7. Select the Custom account option and click Set.  The Set Credentials dialog box 

displays. 
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8. In the User name field, enter the Application Pool Identity in the form 

<Domain>\<Username>.  

9. In the Password and Confirm password fields, enter that user’s password.  

10. Click OK three times to set the identity. 

Install and Configure Vision 7.1 Document Management  
When you install Vision 7.1 Document Management the changes made to your existing WSS 
installation are outlined below.  The steps to configure WSS are outlined in this section. 

  

 If you would prefer not to run the Vision Document Management installation on an 
existing installation of SharePoint, refer to “Appendix C: Manual Installation of Document 
Management” for manual setup instructions. 

  

The Document Management installation does the following: 

 Installs Web Service Extensions (WSE) 2.0 Sp3. 

 Installs WSS 3.0, if it is not already installed. 

 Copies Document Management files to the SharePoint ISAPI folder (c:\program 
files\common files\microsoft shared\web service extensions\12\isapi). 

 Copies Document Management files to the Vision Support folder (\program 
files\deltek\vision\support\DM\30). 

 Modifies the SharePoint Web.config file in the ISAPI directory to work with Vision 
Document Management. 

 Installs Deltek.Vision.WSS30.Server dll into the Global Assembly Cache (GAC). 

Install Vision Document Management 

To install Vision Document Management, complete the following steps: 

1. Download the DeltekVision71DM.exe file and run the setup on your Vision Web server.  

2. When a dialog box displays to indicate the IIS licensing requirements for the use of 
Windows Integrated Authentication (required to use Vision Document Management), click 
OK. 

3. On the first Document Management Installation Wizard page, click Next. 

4. On the License Agreement page, select I accept the terms of the license agreement 
and click Next. 
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5. When this message displays, click Yes because this is a single-tier installation of Vision 
Document Management and this server will host both Vision and WSS 3.0. 

 
6. On the Ready to Install the Program page, click Install to start the installation.  

7. When the InstallShield Wizard Complete page displays, click Finish. 

Optional: Configure Authentication for the Vision Website 
  

 

This is an “Optional” step for single tier installations and only required if the default 
configuration does not work for your setup. 

  

IIS Kernel Mode Authentication 

The default configuration of IIS when using Windows Integrated Authentication (required for 
Vision Document Management) is to use Kernel Mode Authentication.  Under this configuration, 
the application pool runs under the Machine account whether or not an identity has been 
established.  Because delegation is not required for single tier deployments of Vision Document 
Management, the additional configuration steps below are optional.  However, if you do change 
the default of enabling Kernel Mode Authentication you will be required to create an SPN which is 
outlined in next section. 

Identify if Kernel Mode Authentication Is Enabled 

Follow the steps below to identify if Kernel Mode Authentication is enabled. (In a default 
configuration of IIS it will be enabled.) 

To identify the authentication status, complete the following steps: 

1. Log on to the domain on the Vision Web/application server using an Administrator 
account. 

2. Open Internet Information Services: Start » All Programs » Administrative Tools » 
Internet Information Services (IIS) Manager. 

3. Expand the server name, expand Sites, and expand Default Web Site or whichever site 
Vision is installed to. 

4. Select the Vision virtual directory and then double click Authentication in the 
Features view. 

5. Select Windows Authentication and verify that the status is Enabled 
(Anonymous Access should be Disabled).  If it is not, select Enable from the 
Actions menu. 

6. With Windows Authentication still selected, click Advanced settings on the 
Action menu. The Advanced Settings dialog box displays: 
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Kernel Mode Authentication Implementation 

As mentioned above, under this default configuration, Vision Document Management will 
not be able to delegate credentials to a WSS 3.0 server separate from the Vision 
Web/application server. Two possible configurations allow Document Management to 
function properly: 

 Disable Kernel Mode Authentication. In order to Disable Kernel Mode Authentication, 
simply uncheck the Enable Kernel Mode Authentication option under the Advanced 
Settings of the Windows Authentication feature for the Vision virtual directory. 

 Modify the ApplicationHost.config file to force the use of the Application Pool 
Identity.  In order to continue to use Kernel Mode Authentication but force the Application 
Pool to run under its Identity rather than the Machine account, it is necessary to modify 
the ApplicationHost.config file, the steps of which are outlined below: 

1. Click Start » All Programs » Accessories. 

2. Right-click Notepad, click Run as, and select the Administrator account.  
  

 This is necessary in order to save the changes we need to make to the 
ApplicationHost.config file, which is protected under UAC (User Account Control) on 
Windows Server 2008. 

  

3. Click Open on the File menu and locate the ApplicationHost.config file from 
c:\windows\system32\inetsrv\config.  

4. Click Find on the Edit menu in Notepad and search for the following:  

<location path=”Default Web Site/Vision”> 
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5. Locate the windowsAuthentication tag and add useAppPoolCredentials=”true” as 
shown in the following:  

 
6. Once the edits are complete, save your changes and restart IIS to make the changes 

effective.  

Both of these configuration options require that a Service Principal Name be established 
for the Application Pool Identity. The following section provides more information on 
creating the SPN. 

Optional: Configure Service Principal Name (SPN) for Vision Application 
Pool Identity 
  

 

This is an “Optional” step for single tier installations and only required if the default 
configuration does not work for your setup. 

  

Under the default configuration with Kernel Mode Authentication enabled, it is not necessary to 
create a Service Principal Name for the Application Pool Identity for Windows Authentication and 
Vision Document Management will work just fine on single tier installations as delegation is not 
required.   

However, if you opted to modify the default of enabling Kernel Mode Authentication for the Vision 
web site as described in the preceding section, it will be necessary to create a Service Principal 
Name (SPN) for the domain user running the Vision Application Pool Identity. 
  

 

Domain rights are required to complete this step. 
  

After you establish one of the above Kernel Mode configuration changes, use the steps 
below to create a Service Principal Name for the Application Pool Identity of the 
DeltekVisionAppPool. 

  

 The setspn utility is installed by default on Windows Server 2008. It is not necessary to download 
and install it separately. 
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To create a service principal name, complete the following steps: 

1. Open a command prompt and enter: 

setspn –A http/<Vision Web/App Server name> <domain app pool identity> 

For example: setspn –A http/camqainetk3nwb5 inettest2k3n\dmservacct3tier 

2. Repeat for the FQDN of the server. 
 
For example: setspn –A http/camqainetk3nwb5.inettest2k3n.com 
inettest2k3n\dmservacct3tier 

  

 
See the following related Microsoft Knowledge Base article for more information: 

http://support.microsoft.com/?id=871179  
  

Use SharePoint Central Administration to Complete the SharePoint 
Configuration 
  

 
!! IMPORTANT INFORMATION FOR EXISTING SHAREPOINT 
INSTALLATIONS!! 

If you already have SharePoint installed and plan to use that existing installation 
of SharePoint for your Vision Document Management deployment, note that 
Vision Document Management does not support integrating with an existing 
SharePoint site collection and requires a dedicated top-level site on your 
SharePoint server. 

  

 
To create the Document Management SharePoint site collection, complete the following 
steps: 

1. Launch the SharePoint Central Administration application 

2. Click Application Management and select the Define Managed Paths option.  

http://support.microsoft.com/?id=871179
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3. Enter DeltekVision in Path and select Explicit inclusion in Type. 

4. Click OK.  

 
5. Click Application Management and select the Create Site Collection option under 

SharePoint Site Management. 
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The Create Site Collection page displays. 

 
6. Enter Deltek Vision in Title and enter a description, if appropriate. 

7. From the URL drop-down list, select /deltekvision. This will be the top level root site for 
Vision Document Management. 
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8. Under Select a template, accept the default of Team Site for the template to be used 

and enter a username in each of the User name fields for the primary and secondary site 
collection administrators.  One of these needs to be the Vision Application Pool identity. 

9. Select No Quota in Select a quota template and click OK. The Top-Level Site 
Successfully Created page displays. 

 
10. Click the link for the top level site (in our example it is 

http://camqainetk3nwb1:81/deltekvision) to display the site. 

http://camqainetk3nwb1:81/deltekvision
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11. The SharePoint configuration is complete. Close SharePoint Central Administration. 

Verify IIS Configuration and Configure Deltek Vision Document 
Management .NET Assembly 
Copy the Vision Document Management .NET assembly to SharePoint site directory. 

Identify your IIS configuration to specifically identify which website and port SharePoint is 
using as well as which website and port Vision is using.   

If SharePoint was extended to the Default Web Site then copy 
Deltek.Vision.WSS30.Server.dll from <Vision Installation Directory>\Support\DM\30 to 
c:\inetput\wwwroot\bin 

If SharePoint was extended to its own named web site (e.g. SharePoint – 80) then copy 
Deltek.Vision.WSS30.Server.dll from <Vision Installation Directory>\Support\DM\30 to 
c:\inetput\wwwroot\wss\Virtual Directories\<site>\bin 

  

 By default, the <site> directory references the port chosen. (e.g. 80, 81, etc.).  
  

Configure Document Management Service Account in Weblink 
You must configure the Document Management service account (username/password) on the 
System Settings tab of the Deltek Vision Weblink utility.  
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To configure the service account in Weblink, complete the following steps: 

1. On the Vision Web server, launch Weblink from Start » Programs » Deltek Vision 

2. Enter the Weblink password when prompted. 

3. Click the System Settings tab.  

4. In the Document Management group box, enter your SharePoint username and 
password.  This account is your SharePoint Service account/Deltek Vision Application 
Pool Identity.  

5. Click the Test button and SharePoint Credentials to validate that the information entered 
is correct. 

 

Configure Vision Document Management 
To configure Vision Document Management, complete the following steps: 

1. Log in to Vision using an account that has access to the Configuration menus. 

2. Click Configuration » General » System Settings and select the Document 
Management tab. 
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3. Select the Enable Document Management check box. 

4. Enter the name of the server hosting Document Management. This should be the server 
name only, FQDN’s or custom DNS values are not needed here. Enter this value without 
the protocol prefix (for example, remove the http://). In the illustration above, the value is 
camdevk82twar 

5. Enter the port in Virtual Server Port. In our example the port is 81. 

6. Click the Lookup icon to select the current site. 

 
7. The Select Web Site dialog box displays the available sites. Select a site and click OK. 

8. Save your changes. 

Configure Constrained Delegation 
Constrained Delegation is not required for Single Server installations. 

Optional: Configure Protocol Transition 
Protocol Transition is not required for Single Server installations.  
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Single Tier New Installation and Configuration for 
x64 (64-bit) Servers – SharePoint Already Installed 
  

 
!!IMPORTANT!! 

Please note the following for this configuration: 

 In this configuration, Vision and SharePoint will be installed to the same physical 
server. 

 SharePoint is already installed so the Vision Document Management installation 
will not download or install SharePoint. 

 The installation of SharePoint can be either WSS 3.0 x64 or SharePoint 
Foundation 2010. 

 Vision is installed to a different website than that being used for SharePoint as 
they are not compatible when installed to the same website. 

 The Operating System for the server is x64 (64-bit).  
  

Prerequisites 
 Install/upgrade your Vision installation to Vision 7.1 (if applicable).  

 Identify the domain user account being used for the SharePoint Farm Administrator 
account. 

 Change the Application Pool Identity for the DeltekVisionAppPool to be the SharePoint 
Farm Administrator account above (the Vision 7.1 installation sets this to be the local 
DeltekVision account).  

 Add this domain user to the local Administrators and IIS_IUSRS group on the Vision 
server. 

Single Tier Installation and Configuration Steps 

Step Where to Perform Description 

1.  Vision Web/Application 
Server 

Configure Vision Application Pool Identity to Be a Domain 
Account 

2.  Vision Web/Application 
Server 

Install Vision 7.1 Document Management  

3.  Vision Web/Application 
Server 

Optional: Configure Authentication for the Vision Website 

4.  Vision Web/Application 
Server 

Optional: Configure Service Principal Name (SPN) for 
Vision Application Pool Identity 

5.  SharePoint Web 
/Application Server 

Use SharePoint Central Administration to Complete the 
SharePoint Configuration 
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6.  SharePoint Web 
/Application Server 

Verify IIS Configuration and Configure Deltek Vision 
Document Management .NET Assembly 

7.  Vision Web/Application 
Server 

Configure Document Management Service Account in 
Weblink 

8.  Vision Web/Application 
Server 

Configure Vision Document Management 

9.  Domain Configure Constrained Delegation – Not Required 

10.  Domain Optional: Configure Protocol Transition – Not Required 

Configure Vision Application Pool Identity to Be a Domain Account  
You must change the Vision Application Pool Identity to be a domain account. The default is for 
Vision to use a local DeltekVision user created during the Vision installation. This change is 
necessary because of the local account’s inability to work with Active Directory.  

  

 For this account to be the Application Pool Identity it must be a member of the IIS_IUSRS group in 
addition to being a member of the local administrators group on the local server.. 

  

To change the Vision Application Pool Identity, complete the following steps: 

1. Create a domain user account. This account must also be your SPF Service account. No 
domain Admin rights are needed for this account. 

2. Log on to the domain on the Vision Web/application server using an Administrator 
account. 

3. Open Internet Information Services: Start » All Programs » Administrative Tools » 
Internet Information Services (IIS) Manager. 

4. Expand the Server name and then click Application Pools. 

5. Select the DeltekVisionAppPool and select Advanced Settings from the Action pane 
on the right hand side.  The following displays: 
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6. Place your cursor in the Identity field and then click the ellipses button to set the identity.  

The Application Pool Identify dialog box displays:  

  
7. Select the Custom account option and click Set.  The Set Credentials dialog box 

displays. 
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8. In the User name field, enter the Application Pool Identity in the form 

<Domain>\<Username>.  

9. In the Password and Confirm password fields, enter that user’s password.  

10. Click OK three times to set the identity. 

Install and Configure Vision 7.1 Document Management  
When you install Vision 7.1 Document Management the changes made to your SPF installation 
are outlined below.  The steps to configure SharePoint are outlined in this section. 

  

 If you would prefer not to run the Vision Document Management installation on an 
existing installation of SharePoint, refer to “Appendix C: Manual Installation of Document 
Management” for manual setup instructions. 

  

The Document Management installation does the following: 

 Installs Web Service Extensions (WSE) 2.0 Sp3. 

 Installs SPF 2010, if it is not already installed. 

 Copies Document Management files to the SharePoint ISAPI folder (c:\program 
files\common files\microsoft shared\web service extensions\14\isapi). 

 Copies Document Management files to the Vision Support folder (\program 
files\deltek\vision\support\DM\30). 

 Modifies the SharePoint Web.config file in the ISAPI directory to work with Vision 
Document Management. 

 Installs Deltek.Vision.WSS30.Server dll into the Global Assembly Cache (GAC). 

Install Vision Document Management 

To install Vision Document Management, complete the following steps: 

1. Download the DeltekVision71DM.exe file and run the setup on your Vision Web server.  

2. When a dialog box displays to indicate the IIS licensing requirements for the use of 
Windows Integrated Authentication (required to use Vision Document Management), click 
OK. 

3. On the first Document Management Installation Wizard page, click Next. 

4. On the License Agreement page, select I accept the terms of the license agreement 
and click Next. 



Single Tier New Installation and Configuration for x64 (64-bit) Servers – SharePoint Already Installed 

 

Document Management Installation Guide 90 

 

5. When this message displays, click Yes because this is a single-tier installation of Vision 
Document Management and this server will host both Vision and SPF 2010. 

 
6. On the Ready to Install the Program page, click Install to start the installation.  

7. Click Install to start the installation.    

8. When the InstallShield Wizard Complete page displays, click Finish. 

Optional: Configure Authentication for the Vision Website 
  

 

This is an “Optional” step for single tier installations and only required if the default 
configuration does not work for your setup. 

  

IIS Kernel Mode Authentication 

The default configuration of IIS when using Windows Integrated Authentication (required for 
Vision Document Management) is to use Kernel Mode Authentication.  Under this configuration, 
the application pool runs under the Machine account whether or not an identity has been 
established.  Because delegation is not required for single tier deployments of Vision Document 
Management, the additional configuration steps below are optional.  However, if you do change 
the default of enabling Kernel Mode Authentication you will be required to create an SPN which is 
outlined in next section. 

Identify if Kernel Mode Authentication Is Enabled 

Follow the steps below to identify if Kernel Mode Authentication is enabled. (In a default 
configuration of IIS it will be enabled.) 

To identify the authentication status, complete the following steps: 

1. Log on to the domain on the Vision Web/application server using an Administrator 
account. 

2. Open Internet Information Services: Start » All Programs » Administrative Tools » 
Internet Information Services (IIS) Manager. 

3. Expand the server name, expand Sites, and expand Default Web Site or whichever site 
Vision is installed to. 

4. Select the Vision virtual directory and then double click Authentication in the 
Features view. 

5. Select Windows Authentication and verify that the status is Enabled 
(Anonymous Access should be Disabled).  If it is not, select Enable from the 
Actions menu. 

6. With Windows Authentication still selected, click Advanced settings on the 
Action menu. The Advanced Settings dialog box displays: 
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Kernel Mode Authentication Implementation 

As mentioned above, under this default configuration, Vision Document Management will 
not be able to delegate credentials to a WSS 3.0 server separate from the Vision 
Web/application server. Two possible configurations allow Document Management to 
function properly: 

 Disable Kernel Mode Authentication. In order to Disable Kernel Mode Authentication, 
simply uncheck the Enable Kernel Mode Authentication option under the Advanced 
Settings of the Windows Authentication feature for the Vision virtual directory. 

 Modify the ApplicationHost.config file to force the use of the Application Pool 
Identity.  In order to continue to use Kernel Mode Authentication but force the Application 
Pool to run under its Identity rather than the Machine account, it is necessary to modify 
the ApplicationHost.config file, the steps of which are outlined below: 

1. Click Start » All Programs » Accessories. 

2. Right-click Notepad, click Run as, and select the Administrator account.  
  

 This is necessary in order to save the changes we need to make to the 
ApplicationHost.config file, which is protected under UAC (User Account Control) on 
Windows Server 2008. 

  

3. Click Open on the File menu and locate the ApplicationHost.config file from 
c:\windows\system32\inetsrv\config.  

4. Click Find on the Edit menu in Notepad and search for the following:  

<location path=”Default Web Site/Vision”> 
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5. Locate the windowsAuthentication tag and add useAppPoolCredentials=”true” as 
shown in the following:  

 
6. Once the edits are complete, save your changes and restart IIS to make the changes 

effective.  

Both of these configuration options require that a Service Principal Name be established 
for the Application Pool Identity. The following section provides more information on 
creating the SPN. 

Optional: Configure Service Principal Name (SPN) for Vision Application 
Pool Identity 
  

 

This is an “Optional” step for single tier installations and only required if the default 
configuration does not work for your setup. 

  

Under the default configuration with Kernel Mode Authentication enabled, it is not necessary to 
create a Service Principal Name for the Application Pool Identity for Windows Authentication and 
Vision Document Management will work just fine on single tier installations as delegation is not 
required.   

However, if you opted to modify the default of enabling Kernel Mode Authentication for the Vision 
web site as described in the preceding section, it will be necessary to create a Service Principal 
Name (SPN) for the domain user running the Vision Application Pool Identity. 
  

 

Domain rights are required to complete this step. 
  

After you establish one of the above Kernel Mode configuration changes, use the steps 
below to create a Service Principal Name for the Application Pool Identity of the 
DeltekVisionAppPool. 

  

 The setspn utility is installed by default on Windows Server 2008. It is not necessary to download 
and install it separately. 

  

To create a service principal name, complete the following steps: 

1. Open a command prompt and enter: 

setspn –A http/<Vision Web/App Server name> <domain app pool identity> 
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For example: setspn –A http/camqainetk3nwb5 inettest2k3n\dmservacct3tier 

2. Repeat for the FQDN of the server. 
 
For example: setspn –A http/camqainetk3nwb5.inettest2k3n.com 
inettest2k3n\dmservacct3tier 

  

 
See the following related Microsoft Knowledge Base article for more information: 

http://support.microsoft.com/?id=871179  

Use SharePoint Central Administration to Complete the SharePoint 
Configuration 
  

 
!! IMPORTANT INFORMATION FOR EXISTING SHAREPOINT 
INSTALLATIONS!! 

If you already have SharePoint installed and plan to use that existing installation 
of SharePoint for your Vision Document Management deployment, note that 
Vision Document Management does not support integrating with an existing 
SharePoint site collection and requires a dedicated top-level site on your 
SharePoint server. 

  

 
Create Document Management SharePoint Site Collection 

The following instructions are for SharePoint Foundation 2010.  If  you have Windows SharePoint 
Services 3.0 x64 installed as your version of SharePoint, refer to page 110 for specific 
instructions for that platform. 

1. Launch the SharePoint 2010 Central Administration application 

2. Click Manage Web Applications under Application Management. 

3. Select your SharePoint web application and click Managed Paths. The Define Managed 
Paths page displays.  

http://support.microsoft.com/?id=871179


Single Tier New Installation and Configuration for x64 (64-bit) Servers – SharePoint Already Installed 

 

Document Management Installation Guide 94 

 

 
4. Enter DeltekVision in Path and select Explicit inclusion in Type and click Add Path. 

5. Click OK.  DeltekVision is now added as a Managed Path. 

 
6. Click Application Management and select the Create Site Collection option under Site 

Collections. 
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The Create Site Collection page displays. 

 
7. Enter Deltek Vision in Title and enter a description, if appropriate. 

8. From the URL drop-down list, select /deltekvision. This will be the top level root for 
Vision Document Management. 
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9. Under Select a template, accept the default of Team Site for the template to be used 

and enter a username in each of the User name fields for the primary and secondary site 
collection administrators.  One of these needs to be the Vision Application Pool identity. 

10. Select No Quota in Select a quota template and click OK. The Top-Level Site 
Successfully Created page displays. 

 
11. Click the link for the top level site (in our example it is 

http://camqainetk38wb9:81/deltekvision) to display the site. 

http://camqainetk38wb9:81/deltekvision
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12. The SharePoint configuration is complete. Close SharePoint Central Administration. 

Verify IIS Configuration and Configure Deltek Vision Document 
Management .NET Assembly 
Copy the Vision Document Management .NET assembly to SharePoint site directory. 

Identify your IIS configuration to specifically identify which website and port SharePoint is 
using as well as which website and port Vision is using.   

If SharePoint was extended to the Default Web Site then copy 
Deltek.Vision.WSS30.Server.dll from <Vision Installation Directory>\Support\DM\30 to 
c:\inetput\wwwroot\bin 

If SharePoint was extended to its own named web site (e.g. SharePoint – 80) then copy 
Deltek.Vision.WSS30.Server.dll from <Vision Installation Directory>\Support\DM\30 to 
c:\inetput\wwwroot\wss\Virtual Directories\<site>\bin 

  

 By default, the <site> directory references the port chosen. (e.g. 80, 81, etc.).  

Configure Document Management Service Account in Weblink 
You must configure the Document Management service account (username/password) on the 
System Settings tab of the Deltek Vision Weblink utility.  

To configure the service account in Weblink, complete the following steps: 

1. On the Vision Web server, launch Weblink from Start » Programs » Deltek Vision 

2. Enter the Weblink password when prompted. 

3. Click the System Settings tab.  
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4. In the Document Management group box, enter your SharePoint username and 
password.  This account is your SharePoint Service account/Deltek Vision Application 
Pool Identity.  

5. Click the Test button and SharePoint Credentials to validate that the information entered 
is correct. 

 

Configure Vision Document Management 
To configure Vision Document Management, complete the following steps: 

1. Log in to Vision using an account that has access to the Configuration menus. 

2. Click Configuration » General » System Settings and select the Document 
Management tab. 

 
3. Select the Enable Document Management check box. 

4. Enter the name of the server hosting Document Management. This should be the server 
name only, FQDN’s or custom DNS values are not needed here.. Enter this value without 
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the protocol prefix (for example, remove the http://). In the illustration above, the value is 
camopsk82twar. 

5. Enter the port in Virtual Server Port. In our example the port is 81. 

6. Click the Lookup icon to select the current site. 

 
7. The Select Web Site dialog box displays the available sites. Select a site and click OK. 

8. Save your changes. 

Configure Constrained Delegation 
Constrained Delegation is not required for Single Server installations. 

Optional: Configure Protocol Transition 
Protocol Transition is not required for Single Server installations. 
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Multi Tier New Installation and Configuration for 
x86 (32-bit) Servers – SharePoint is NOT Installed  
  

 
!!IMPORTANT!! 

Please note the following for this configuration: 

 In this configuration, Vision and SharePoint will be installed to separate physical 
server and SharePoint is NOT yet installed.   

 The Vision Document Management installation will install Windows SharePoint 
Services 3.0.  SharePoint Foundation 2010 is not supported for this 
configuration. 

 The Operating System for the server is x86 (32-bit).  

Prerequisites 
 Install/upgrade your Vision installation to Vision 7.1 (if applicable).  

 Change the Application Pool Identity for the DeltekVisionAppPool to be a domain user 
account (the Vision 7.1 installation sets this to be the local DeltekVision account).  

 The domain service account used above will also be the SharePoint Service account.  

 Add this domain user to the local Administrators and IIS_IUSRS group on the Vision 
server. 

Multi Tier Installation and Configuration Steps 

Step Where to Perform Description 

1.  Vision Web/Application 
Server 

Configure Vision Application Pool Identity to Be a 
Domain Account 

2.  Vision Web/Application 
Server 

Grant Local Security Policy Rights to Vision Application 
Pool Identity 

3.  Vision Web/Application 
Server 

Install Vision 7.1 Document Management on the Vision 
Web Server 

4.  Vision Web/Application 
Server 

Configure Authentication for the Vision Website 

5.  Vision Web/Application 
Server 

Configure Service Principal Name (SPN) for Vision 
Application Pool Identity 

6.  

 

SharePoint Web 
/Application Server 

Install Vision Document Management on the WSS 
Server 

7.  SharePoint Web 
/Application Server 

Run the SharePoint Products and Technologies 
Configuration Wizard 
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8.  SharePoint Web 
/Application Server 

Use SharePoint Central Administration to Complete the 
SharePoint Configuration 

9.  SharePoint Web 
/Application Server 

Optional: Configure SharePoint for a Custom URL 

10.  SharePoint Web 
/Application Server 

Verify IIS Configuration and Configure Deltek Vision 
Document Management .NET Assembly 

11.  Vision Web/Application 
Server 

Configure Document Management Service Account in 
Weblink 

12.  Vision Web/Application 
Server 

Configure Vision Document Management 

13.  Domain Configure Constrained Delegation 

14.  Domain Optional: Configure Protocol Transition  

Configure Vision Application Pool Identity to Be a Domain Account 
You must change the Vision Application Pool Identity to be a domain account. The default is for 
Vision to use a local DeltekVision user created during the Vision installation. This change is 
necessary because of the local account’s inability to work with Active Directory.  

  

 For this account to be the Application Pool Identity it must be a member of the IIS_IUSRS group in 
addition to being a member of the local administrators group on the local server.. 

  

To change the Vision Application Pool Identity, complete the following steps: 

1. Create a domain user account. This account must also be your SPF Service account. No 
domain Admin rights are needed for this account. 

2. Log on to the domain on the Vision Web/application server using an Administrator 
account. 

3. Open Internet Information Services: Start » All Programs » Administrative Tools » 
Internet Information Services (IIS) Manager. 

4. Expand the Server name and then click Application Pools. 

5. Select the DeltekVisionAppPool and select Advanced Settings from the Action pane 
on the right hand side.  The following displays: 
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6. Place your cursor in the Identity field and then click the ellipses button to set the identity.  

The Application Pool Identify dialog box displays:  

  
7. Select the Custom account option and click Set.  The Set Credentials dialog box 

displays. 
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8. In the User name field, enter the Application Pool Identity in the form 

<Domain>\<Username>.  

9. In the Password and Confirm password fields, enter that user’s password.  

10. Click OK three times to set the identity. 

Grant Local Security Policy Rights to Vision Application Pool Identity 
The Vision Application Pool Identity/SharePoint Service Account must be granted Logon as a 
service rights on the Vision 7.1 Web/Application Server for multi-tier Document Management 
installations, as shown in the following example of the Local Security Settings setup screens. 

 

Install and Configure Vision 7.1 Document Management and 
WSS 3.0 
When you install Vision 7.1 Document Management WSS is automatically installed if your 
Operating System platform is x86 (32-bit). If you are upgrading from a previous version of Vision 
and/or already have WSS installed the changes made to your WSS installation are outlined 
below.  The steps to configure WSS are outlined in this section. 

  

 If you would prefer not to run the Vision Document Management installation on an 
existing installation of SharePoint, refer to “Appendix C: Manual Installation of Document 
Management” for manual setup instructions. 
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The Document Management installation does the following: 

 Installs Web Service Extensions (WSE) 2.0 SP3. 

 Installs WSS 3.0 when run on the SharePoint web server if it is not already installed. 

 Copies Document Management files to the SharePoint ISAPI folder (c:\program 
files\common files\microsoft shared\web service extensions\12\isapi). 

 Copies Document Management files to the Vision Support folder (\program 
files\deltek\vision\support\DM\30). 

 Modifies the SharePoint Web.config file in the ISAPI directory to work with Vision 
Document Management. 

 Installs Deltek.Vision.WSS30.Server.dll into the Global Assembly Cache (GAC). 

Install Vision 7.1 Document Management on the Vision Web Server 
  

 You must run the Document Management installer on both the Vision web server and the 
SharePoint web server. 

  

To install Vision 7.1 Document Management on the Vision Web server, complete the 
following steps: 

1. Download the DeltekVision71DM.exe file and run the setup on your Vision Web server.  

2. When a dialog box displays to indicate the IIS licensing requirements for the use of 
Windows Integrated Authentication (required to use Vision Document Management), click 
OK. 

3. On the first Document Management Installation Wizard page, click Next. 

4. On the License Agreement page, select I accept the terms of the license agreement 
and click Next. 

5. When the following message displays, click No because this is a multi-tier installation of 
Vision Document Management and your Vision Web server will not host WSS 3.0. 

 
6. When the following message displays to remind you to run the setup on the WSS server, 

click OK. 

 
7. On the Ready to Install the Program page, click Install to start the installation.  
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8. When the InstallShield Wizard Complete page displays, click Finish. 

Configure Authentication for the Vision Website 

IIS Kernel Mode Authentication 

The default configuration of IIS when using Windows Integrated Authentication (required for 
Vision Document Management) is to use Kernel Mode Authentication.  Under this configuration, 
the application pool runs under the Machine account whether or not an identity has been 
established.  Because the Machine account cannot be used for delegation scenarios which are 
required for multi-tier deployments of Vision Document Management, the additional configuration 
steps below are necessary. 

Identify if Kernel Mode Authentication Is Enabled 

Follow the steps below to identify if Kernel Mode Authentication is enabled. (In a default 
configuration of IIS it will be enabled.) 

To identify the authentication status, complete the following steps: 

1. Log on to the domain on the Vision Web/application server using an Administrator 
account. 

2. Open Internet Information Services: Start » All Programs » Administrative Tools » 
Internet Information Services (IIS) Manager. 

3. Expand the server name, expand Sites, and expand Default Web Site or whichever site 
Vision is installed to. 

4. Select the Vision virtual directory and then double click Authentication in the 
Features view. 

5. Select Windows Authentication and verify that the status is Enabled 
(Anonymous Access should be Disabled).  If it is not, select Enable from the 
Actions menu. 

6. With Windows Authentication still selected, click Advanced settings on the 
Action menu. The Advanced Settings dialog box displays: 

 

Kernel Mode Authentication Implementation 

As mentioned above, under this default configuration, Vision Document Management will 
not be able to delegate credentials to a WSS 3.0 server separate from the Vision 
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Web/application server. Two possible configurations allow Document Management to 
function properly: 

 Disable Kernel Mode Authentication. In order to Disable Kernel Mode Authentication, 
simply uncheck the Enable Kernel Mode Authentication option under the Advanced 
Settings of the Windows Authentication feature for the Vision virtual directory. 

 Modify the ApplicationHost.config file to force the use of the Application Pool 
Identity.  In order to continue to use Kernel Mode Authentication but force the Application 
Pool to run under its Identity rather than the Machine account, it is necessary to modify 
the ApplicationHost.config file, the steps of which are outlined below: 

1. Click Start » All Programs » Accessories. 

2. Right-click Notepad, click Run as, and select the Administrator account.  
  

 This is necessary in order to save the changes we need to make to the 
ApplicationHost.config file, which is protected under UAC (User Account Control) on 
Windows Server 2008. 

  

3. Click Open on the File menu and locate the ApplicationHost.config file from 
c:\windows\system32\inetsrv\config.  

4. Click Find on the Edit menu in Notepad and search for the following:  

<location path=”Default Web Site/Vision”> 

5. Locate the windowsAuthentication tag and add useAppPoolCredentials=”true” as 
shown in the following:  

 
6. Once the edits are complete, save your changes and restart IIS to make the changes 

effective.  

Both of these configuration options require that a Service Principal Name be established 
for the Application Pool Identity. The following section provides more information on 
creating the SPN. 

Configure Service Principal Name (SPN) for Vision Application Pool Identity 
Under the default configuration with Kernel Mode Authentication enabled, it is not necessary to 
create a Service Principal Name for the Application Pool Identity for Windows Authentication to 
work properly and creating an SPN for the Application Pool Identity in this configuration will result 
in a “duplicate SPN” issue, preventing Windows Integrated Security from authenticating anyone to 
the Web site.   
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However, For Multi Tier installations of Vision Document Management it is necessary to create a 
Service Principal Name (SPN) for the domain user running the Vision Application Pool Identity 
(DeltekVisionAppPool) as this is the account used for delegation. 
  

 

Domain rights are required to complete this step. 
  

After you establish one of the above Kernel Mode configuration changes, use the steps 
below to create a Service Principal Name for the Application Pool Identity of the 
DeltekVisionAppPool. 

  

 The setspn utility is installed by default on Windows Server 2008. It is not necessary to download 
and install it separately. 

  

To create a service principal name, complete the following steps: 

1. Open a command prompt and enter: 

setspn –A http/<Vision Web/App Server name> <domain app pool identity> 

For example: setspn –A http/camqainetk3nwb5 inettest2k3n\dmservacct3tier 

2. Repeat for the FQDN of the server. 
 
For example: setspn –A http/camqainetk3nwb5.inettest2k3n.com 
inettest2k3n\dmservacct3tier 

  

 
See the following related Microsoft Knowledge Base article for more information: 

http://support.microsoft.com/?id=871179  
  

Install Vision Document Management on the WSS Server 

To install Vision Document Management on the WSS server, complete the following steps: 

1. Download DeltekVision7.1DM.exe and run the setup on your WSS server. 

2. On the first Document Management Installation Wizard page, click Next. 

3. On the License Agreement page, select I accept the terms of the license agreement 
and click Next. 

4. When the following message displays to remind you to run the setup on the Vision 
web/application server if you haven’t already, click OK. 
 

 

http://support.microsoft.com/?id=871179
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5. On the Ready to Install the Program page, click Install to start the installation. The 
installation automatically downloads Windows SharePoint Services 3.0, extracts the WSS 
3.0 setup files, and installs Windows SharePoint Services. 

6. When the “Files extracted successfully” message displays, click the OK button to 
continue the installation. 

7. When the InstallShield Wizard Complete page displays, click Finish. 

Run the SharePoint Products and Technologies Configuration Wizard 

To run the SharePoint Products and Technologies Configuration wizard, complete the 
following steps: 

1. Click Start » Administrative Tools » SharePoint Products and Technologies Wizard. 
The Welcome page displays. 

 
2. Click Next. The following dialog box displays. 

 
3. Click Yes. The Connect to a server farm page displays. 
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4. Select the No, I want to create a new server farm option and click Next to display the 

Specify Configuration Database Settings page. 

 
5. Enter the name of the database server to host the SharePoint configuration database and 

accept the default database name: SharePoint_Config. 
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 Your SharePoint database access account will need to have the dbcreator and 
securityadmin SQL Server Roles.  This is accomplished by adding the domain account as 
a SQL Server login and adding the roles as shown below: 
 

  
 
 

  

6. Enter the domain and name of the Vision Application Pool Identity (configured and added 
to the local administrator group on the WSS server) as the Username for the SharePoint 
database access account and enter that user’s Password. 

7. Click Next. The Configure SharePoint Central Administration Web Application page 
displays. 
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8. Specify the port to be used for the SharePoint Central Administration Web site and select 

Negotiate (Kerberos) for the authentication provider.   

9. Click Next.  The following dialog box displays. 

 
10. Click Yes to continue using Kerberos with Windows Authentication. The Completing the 

SharePoint Products and Technologies Configuration Wizard page displays. 
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11. Click Next to begin the configuration. This process may take some time to complete. The 

Configuration Successful page displays when configuration is complete. 

 
12. Click Finish to finish the configuration process. The SharePoint Central Administration 

page displays. 
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Use SharePoint Central Administration to Complete the SharePoint 
Configuration 

To complete the SharePoint configuration, complete the following steps: 

1. When you click Finish in the preceding procedure, SharePoint Central Administration is 
launched. 

 
2. Click Operations. The Operations page displays. 
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3. Click Services on Server under Topology and Services to configure the SharePoint 

Services search. 

 
4. Locate the Windows SharePoint Services Search option and click Start. 
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5. Configure the search service to include the Service account and Content Access account 

(use the same account information as your Vision Application Pool Identity). 
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6. Configure Search Database as shown and click Start. After a minute or so, the service’s 
status changes to Started. 

 
7. Click Application Management to configure the SharePoint Web Application. 

 
8. Select the Create or extend Web application option. The Create or Extend Web 

Application page displays. 
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9. Click Create a new Web application. The Create a New Web Application page displays. 

 
10. Select the Create a new IIS web site option. Enter a description for the Web site and 

specify a port in Port. 

Because WSS is installed on its own server, it can run on the Default Web Site and Port 
80. To accomplish this, select the existing Web site (Default Web Site). Note the entry in 
Path, which by default is the root of your WSS Web site in a directory named after the 
port chosen under c:\inetpub\wwwroot\wss\virtualdirectories. 
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11. Select Negotiate (Kerberos) under Authentication provider. 

12. For the Allow Anonymous and Use Secure Sockets Layer (SSL) options, accept the 
default of No. If you want to use SSL with SharePoint, you can configure SSL later but 
you must not configure SSL to be required as the web service calls from the Vision 
Web/Application server cannot use SSL.. 

 
13. Select the Create a new application pool option and provide a name (Deltek 

recommends using the same name as the Web site). Note that if you are installing WSS 
to the Default Web Site, you can also choose to use the Default App Pool rather than 
creating a new application pool. 

14. Select Predefined and Network Service for the security account to be used for the 
application pool.  NOTE: Since the SharePoint Application Pool will run as Network 
Service, no SPN is required. 

15. Select the Restart IIS Manually option for Reset Internet Information Services. 
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16. Verify the name of the server in Database Server. (It should be the same as that used 

for the SharePoint configuration database server.) Accept the default in Database Name 
for the content database. 

17. Select Windows authentication (recommended) under Database authentication. 
(This will use the SharePoint service account and Vision Application Pool Identity 
configured previously.) 

18. Select the search server in Select Windows SharePoint Services search server and 
click OK. The following dialog box displays. 

 
19. Click OK to use Kerberos for Windows Authentication. After a few minutes, the 

Application Created page displays. It indicates the status of the process to create a new 
Web application. 
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20. Do not click the Create Site Collection link at this time. It is still necessary to add 

DeltekVision as a managed path with explicit inclusion before you create the site 
collection. 

21. Click Application Management and select the Define Managed Paths option.  

 
22. Enter DeltekVision in Path and select Explicit inclusion in Type. 

23. Click OK. 
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24. Click Application Management and select the Create site collection option under 
SharePoint Site Management. 

 
The Create Site Collection page displays. 

 
25. Enter Deltek Vision in Title and enter a description, if appropriate. 

26. From the URL drop-down list, select /deltekvision. This will be the top level root for 
Vision Document Management. 
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27. Under Select a template, accept the default of Team Site for the template to be used 

and enter a username in each of the User name fields for the primary and secondary site 
collection administrators. One of these needs to be the Vision Application Pool identity. 

28. Select No Quota in Select a quota template and click OK. The Top-Level Site 
Successfully Created page displays. 

 
29. Click Start » Run, enter iisreset /noforce, and click Enter. 
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30. Click the link for the top level site (in our example it is 
http://camqainetk3nss1/deltekvision) to display the site. 

 
31. The SharePoint configuration is complete. Close SharePoint Central Administration. 

Optional: Configure SharePoint for a Custom URL  
If you will be configuring your SharePoint server to use a custom DNS record for the URL (e.g. 
http://sharepoint.company.com instead of http://servername.company.com http://servername), 
then you must create additional SPNs and also create Alternate Access Mappings in SharePoint.  
It is recommended that this step be completed before Vision Document Management is 
configured in order to eliminate re-work.  

See “Appendix B: Configure SharePoint for a Custom URL” for more information. 

Verify IIS Configuration and Configure Deltek Vision Document 
Management .NET Assembly 

To verify IIS configuration, complete the following steps: 

1. Use the directions that follow to open Internet Information Services to view these Web 
sites: 

 Default Web Site — Stopped. 

 SharePoint – 80 — This is your WSS 3.0 Web site. 

 SharePoint Central Administration Web Site 

http://sharepoint.company.com/
http://servername/


Multi Tier New Installation and Configuration for x86 (32-bit) Servers – SharePoint is NOT Installed 

 

Document Management Installation Guide 124 

 

 
2. Copy the Vision Document Management .NET assembly to SharePoint site directory. 

 
Copy Deltek.Vision.WSS30.Server.dll from <Vision Installation Directory>\Support\DM\30 
to one of the following: 

 c:\inetpub\wwwroot\bin (if WSS was installed to the default web site) 

 c:\inetput\wwwroot\wss\Virtual Directories\<site>\bin (if WSS was installed to another 
web site) 

  

 By default, the <site> directory references the port chosen. In our example, the port is 80. 
If you extended WSS to the Default Web Site, the path will be c:\inetput\wwwroot\ bin. 

  

Configure Document Management Service Account in Weblink 
You must configure the Document Management service account (username/password) on the 
System Settings tab of the Deltek Vision Weblink utility.  

To configure the service account in Weblink, complete the following steps: 

1. On the Vision Web server, launch Weblink from Start » Programs » Deltek Vision 

2. Enter the Weblink password when prompted. 

3. Click the System Settings tab.  

4. In the Document Management group box, enter your SharePoint username and 
password.  This account is your SharePoint Service account/Deltek Vision Application 
Pool Identity.  

5. Click the Test button and SharePoint Credentials to validate that the information entered 
is correct. 
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Configure Vision Document Management 
To configure Vision Document Management, complete the following steps: 

1. Log in to Vision using an account that has access to the Configuration menus. 

2. Click Configuration » General » System Settings and select the Document 
Management tab. 

 
3. Select the Enable Document Management check box. 
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4. Enter the name of the server hosting Document Management. This should be the server 
name only, FQDN’s or custom DNS values are not needed here. Enter this value without 
the protocol prefix (for example, remove the http://). In the illustration above, the value is 
camqainetk3nwb4. 

5. Enter the Virtual Server Port. In the illustration above, the port is 81 but on a typical 
dedicated SharePoint installation the port will be 80 for the default web site. 

6. Click the Lookup icon to select the current site. 

 
7. The Select Web Site dialog box displays the available sites. Select a site, and click OK. 

8. Save your changes. 

Configure Constrained Delegation 
Because your WSS server is on a separate physical server and because the Vision Web server 
needs to pass the domain credentials of your Vision Document Management users on to the 
WSS server, you must configure Constrained Delegation. 

  

 This assumes a non-Internet deployment of Vision Document Management using Kerberos 
authentication. If you are deploying Vision Document Management so that it is accessible over the 
Internet, you need to skip ahead to “Optional: Configure Protocol Transition” in the next section. 

  

To configure Constrained Delegation, complete the following steps: 

1. Open the Active Directory Users and Computers MMC on a Domain Controller.  

2. Locate the User account for the Vision Application Pool Identity (WSS Service account). 

3. Right-click and select Properties. 

4. On the Delegation tab, select the Trust this user for delegation to specified services 
only option. 

5. Select the Use Kerberos only option.  
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6. Click the Add button. The Add Services dialog box displays. 

 
7. Click Users or Computers. The Select Users or Computers dialog box displays. 
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8. Locate the http service, select it, and click OK. 

 
The Delegation tab should look like this: 
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Because we are explicitly specifying the http service and not all services on the SharePoint 
server, this is known as Constrained Delegation. 

There are two http service types listed. These service types are known as Service Principal 
Names (SPNs). The SPN referencing CAMQAINETK3NSS1.inettest2k3n.com was created 
automatically when the server was added to the domain and the http service (IIS) was installed. 
The second SPN referencing sharepoint.inettest2k3n.com is a new SPN that was created using 
the setspn utility that allows us to register the custom FQDN of the server, which provides more 
meaning than the actual machine name. 

Optional: Configure Protocol Transition  
If Vision Document Management functionality is required over the Internet and you will be using a 
custom DNS/FQDN for the SharePoint URL (as in our example, vision1.inettest2k3n.com), then 
you need to configure a form of delegation referred to as Protocol Transition. If Document 
Management functionality is not required, you can skip this step. 

The Kerberos authentication protocol must be used to authenticate from the Vision Web server to 
the SharePoint server. However, if Vision is deployed in an Internet scenario and there are users 
outside of the firewall who need to access Document Management features, Kerberos 
authentication cannot be used to authenticate the client to the Web server. This is because the 
client needs to have the ability to negotiate a Kerberos ticket with the Key Distribution Center 
(KDC), which is a service running on a Domain Controller. This requires port 88 to be opened 
inbound on the firewall to the Domain Controller, which is not an advisable configuration. 

To get around this, you must be running a Native Windows Server 2003 functional domain.  

To configure Protocol Transition, select the Use any authentication protocol option instead of 
the Use Kerberos only option, which is used to configure Constrained Delegation. This allows 
the client to authenticate to the Vision Web server using NTLM instead of Kerberos, and that 
authentication is then “transitioned” over to Kerberos for Delegation to the SharePoint server.  
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To configure Protocol Transition, complete the following steps: 

1. Open the Active Directory Users and Computers MMC on a Domain Controller.  

2. Locate the User account for the Vision Application Pool Identity (WSS Service account), 
which is most likely under the Computers Organizational Unit (OU). 

3. Right-click and select Properties. 

4. On the Delegation tab, select the Trust this user for delegation to specified services 
only option. 

5. Select the Use any authentication protocol option.  

 
6. Click the Add button. The Add Services dialog box displays. 
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7. Click Users or Computers, search for the SharePoint server, and click OK. 

 
8. Locate the http service for the SPN (FQDN) you created earlier (in our example, 

sharepoint.inettest2k3n.com), select it, and click OK. 
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This illustration shows two http service types. Unless you have registered a custom 
FQDN using the setspn utility, only the server name displays. These service types are 
known as Service Principal Names (SPNs).  

The SPN referencing CAMQAINETK3NSS1.inettest2k3n.com was created 
automatically when the server was added to the domain and the http service (IIS) was 
installed.  

The second SPN referencing sharepoint.inettest2k3n.com is a new SPN that was 
created using the setspn utility that allows us to register the custom FQDN of the server, 
which provides more meaning than the actual machine name. 
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The Delegation tab should look like this: 

 
Because you explicitly specified the http service and not all services on the SharePoint 
server and because you selected the Use any authentication protocol option and not 
Kerberos, this is known as Protocol Transition. 
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Multi Tier New Installation and Configuration for 
x64 (64-bit) Servers – SharePoint is NOT Installed 
  

 
!!IMPORTANT!! 
Please note the following for this configuration: 

 In this configuration, Vision and SharePoint will be installed to the same physical 
server and SharePoint is NOT yet installed.   

 The Vision Document Management installation will install SharePoint Foundation 
2010.  Windows SharePoint Services is not supported for this configuration. 

 The Operating System for the server is x64 (64-bit).  

Before you proceed: 

 Review the Hardware and Software Requirements for SharePoint Foundation 2010. See 
http://technet.microsoft.com/en-us/library/cc288751.aspx for more information. 

 Make sure your SharePoint servers are current with all available Windows Updates. 
Deltek strongly recommends that you do this, to ensure that the SharePoint prerequisite 
installer completes successfully. 

Specific database server requirements for SharePoint Foundation 2010 are as follows: 

Environment Minimum Requirement 

Database server in 
a farm 

One of the following: 

 The 64-bit edition of Microsoft SQL Server 2008 R2. 

 The 64-bit edition of Microsoft SQL Server 2008 with Service Pack 
1 (SP1) and Cumulative Update 2.  
 
NOTE: Deltek recommends SQL 2008 Sp3 with Vision 7.1 

 The 64-bit edition of Microsoft SQL Server 2005 with Service Pack 
3 (SP3).  
 
NOTE: Even though SQL 2005 is supported for SharePoint 
Foundation 2010, Deltek does not support SQL Server 2005 with 
Vision 7.1 if you will be using the same database server for Vision 
and SPF 2010. 

For more information about choosing a version of SQL Server, see SQL Server 
2008 R2 and SharePoint 2010 Products: Better Together (white paper) (SharePoint 
Server 2010). 

 
  

http://technet.microsoft.com/en-us/library/cc288751.aspx
http://technet.microsoft.com/en-us/library/cc990273.aspx
http://technet.microsoft.com/en-us/library/cc990273.aspx
http://technet.microsoft.com/en-us/library/cc990273.aspx
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The Document Management installation does not check the edition, platform or 
version of your SharePoint database server but the SharePoint 2010 Products 
Configuration Wizard will and will fail to configure SharePoint until the database 
prerequisites have been met.   

For example, you may see an error similar to the following: 

 
  

Prerequisites 
 Install/upgrade your Vision installation to Vision 7.1 (if applicable).  

 Change the Application Pool Identity for the DeltekVisionAppPool to be a domain user 
account (the Vision 7.1 installation sets this to be the local DeltekVision account).  

 The domain service account used above will also be the SharePoint Service account.  

 Add this domain user to the local Administrators and IIS_IUSRS group on the Vision 
server. 

Multi Tier Installation and Configuration Steps 

Step Where to Perform Description 

1.  Vision Web/Application 
Server 

Configure Vision Application Pool Identity to Be a Domain 
Account 

2.  Vision Web/Application 
Server 

Grant Local Security Policy Rights to Vision Application 
Pool Identity 

3.  Vision Web/Application 
Server 

Install Vision 7.1 Document Management on the Vision 
Web Server 

4.  Vision Web/Application 
Server 

Configure Authentication for the Vision Website 

5.  Vision Web/Application 
Server 

Configure Service Principal Name (SPN) for Vision 
Application Pool Identity 

6.  SharePoint Web 
/Application Server 

Install Vision Document Management on the SharePoint 
Foundation 2010 Server 
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7.  SharePoint Web 
/Application Server 

Run the SharePoint 2010 Products Configuration Wizard 

8.  SharePoint Web 
/Application Server 

Use SharePoint Central Administration to Complete the 
SharePoint Configuration 

9.  SharePoint Web 
/Application Server 

Configure Service Principal Name (SPN) for SharePoint 
Application Pool Identity 

10.  SharePoint Web 
/Application Server 

Optional: Configure SharePoint for a Custom URL 

11.  SharePoint Web 
/Application Server 

Verify IIS Configuration and Configure Deltek Vision 
Document Management .NET Assembly 

12.  Vision Web/Application 
Server 

Configure Document Management Service Account in 
Weblink 

13.  Vision Web/Application 
Server 

Configure Vision Document Management 

14.  Domain Configure Constrained Delegation 

15.  Domain Optional: Configure Protocol Transition 

Configure Vision Application Pool Identity to be a Domain Account  
You must change the Vision Application Pool Identity to be a domain account. The default is for 
Vision to use a local DeltekVision user created during the Vision installation. This change is 
necessary because of the local account’s inability to work with Active Directory.  

  

 For this account to be the Application Pool Identity it must be a member of the IIS_IUSRS group in 
addition to being a member of the local administrators group on the local server.. 

  

To change the Vision Application Pool Identity, complete the following steps: 

1. Create a domain user account. This account must also be your SPF Service account. No 
domain Admin rights are needed for this account. 

2. Log on to the domain on the Vision Web/application server using an Administrator 
account. 

3. Open Internet Information Services: Start » All Programs » Administrative Tools » 
Internet Information Services (IIS) Manager. 

4. Expand the Server name and then click Application Pools. 

5. Select the DeltekVisionAppPool and select Advanced Settings from the Action pane 
on the right hand side.  The following displays: 
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6. Place your cursor in the Identity field and then click the ellipses button to set the identity.  

The Application Pool Identify dialog box displays:  

  
7. Select the Custom account option and click Set.  The Set Credentials dialog box 

displays. 
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8. In User name, enter the Application Pool Identity in the form <Domain>\<Username>.  

9. In Password and Confirm password, enter that user’s password.  

10. Click OK three times to set the identity. 

Grant Local Security Policy Rights to Vision Application Pool Identity 
The Vision Application Pool Identity/SharePoint Service Account must be granted Logon as a 
service rights on the Vision 7.1 Web/Application Server for multi-tier Document Management 
installations, as shown in the following example of the Local Security Settings setup screens. 

 

Install and Configure Vision 7.1 Document Management and 
SharePoint Foundation (SPF) 2010 
When you install Vision 7.1 Document Management SPF is automatically installed if your 
Operating System platform is x64 (64-bit). If you are upgrading from a previous version of Vision 
and/or already have SPF installed the changes made to your SPF installation are outlined below.  
The steps to configure SPF are outlined in this section. 

  

 

If you would prefer not to run the Vision Document Management installation on an 
existing installation of SharePoint, refer to “Appendix C: Manual Installation of Vision 
Document Management” for manual setup instructions. 
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The Document Management installation does the following: 

 Installs Web Service Extensions (WSE) 2.0 SP3. 

 Installs SPF 2010 when run on the SharePoint web server, if it is not already installed. 

 Copies Document Management files to the SharePoint ISAPI folder (c:\program 
files\common files\microsoft shared\web service extensions\14\isapi). 

 Copies Document Management files to the Vision Support folder (\program 
files\deltek\vision\support\DM\30). 

 Modifies the SharePoint Web.config file in the ISAPI directory to work with Vision 
Document Management. 

 Installs Deltek.Vision.WSS30.Server.dll into the Global Assembly Cache (GAC). 

Install Vision 7.1 Document Management on the Vision Web Server 
  

 

You must run the Document Management installer on both the Vision web server and the 
SharePoint web server. 

  

To install Vision 7.1 Document Management, complete the following steps: 

1. Download the DeltekVision71DM.exe file and run the setup on your Vision Web server.  

2. The installation will check to ensure that the IIS Role service, Windows Authentication, is 
installed.  If the Role Service is not installed you will be prompted to install it and the 
setup will exit: 

 

 
3. After installing the Windows Authentication IIS Role Service, re-run the Document 

Management installation.  

4. When a dialog box displays to indicate the IIS licensing requirements for the use of 
Windows Integrated Authentication (required to use Vision Document Management), click 
OK. 

5. On the first Document Management Installation Wizard page, click Next. 

6. On the License Agreement page, select I accept the terms of the license agreement 
and click Next. 

7. When this message displays, click No because this is a multi-tier installation of Vision 
Document Management and your Vision Web server will not host SPF 2010. 
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8. When the following dialog box displays to remind you to run the setup on the SPF server, 

click OK. 

 
9. On the Ready to Install the Program page, click Install to start the installation.  

10. When the InstallShield Wizard Complete page displays, click Finish. 

Configure Authentication for the Vision Website 

IIS Kernel Mode Authentication 

The default configuration of IIS when using Windows Integrated Authentication (required for 
Vision Document Management) is to use Kernel Mode Authentication.  Under this configuration, 
the application pool runs under the Machine account whether or not an identity has been 
established.  Because the Machine account cannot be used for delegation scenarios which are 
required for multi-tier deployments of Vision Document Management, the additional configuration 
steps below are necessary. 

Identify if Kernel Mode Authentication Is Enabled 

Follow the steps below to identify if Kernel Mode Authentication is enabled. (In a default 
configuration of IIS it will be enabled.) 

To identify the authentication status, complete the following steps: 

1. Log on to the domain on the Vision Web/application server using an Administrator 
account. 

2. Open Internet Information Services: Start » All Programs » Administrative Tools » 
Internet Information Services (IIS) Manager. 

3. Expand the server name, expand Sites, and expand Default Web Site or whichever site 
Vision is installed to. 

4. Select the Vision virtual directory and then double click Authentication in the 
Features view. 

5. Select Windows Authentication and verify that the status is Enabled 
(Anonymous Access should be Disabled).  If it is not, select Enable from the 
Actions menu. 
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6. With Windows Authentication still selected, click Advanced settings on the 
Action menu. The Advanced Settings dialog box displays: 

 

Kernel Mode Authentication Implementation 

As mentioned above, under this default configuration, Vision Document Management will 
not be able to delegate credentials to a WSS 3.0 server separate from the Vision 
Web/application server. Two possible configurations allow Document Management to 
function properly: 

 Disable Kernel Mode Authentication. In order to Disable Kernel Mode Authentication, 
simply uncheck the Enable Kernel Mode Authentication option under the Advanced 
Settings of the Windows Authentication feature for the Vision virtual directory. 

 Modify the ApplicationHost.config file to force the use of the Application Pool 
Identity.  In order to continue to use Kernel Mode Authentication but force the Application 
Pool to run under its Identity rather than the Machine account, it is necessary to modify 
the ApplicationHost.config file, the steps of which are outlined below: 

1. Click Start » All Programs » Accessories. 

2. Right-click Notepad, click Run as, and select the Administrator account.  
  

 This is necessary in order to save the changes we need to make to the 
ApplicationHost.config file, which is protected under UAC (User Account Control) on 
Windows Server 2008. 

  

3. Click Open on the File menu and locate the ApplicationHost.config file from 
c:\windows\system32\inetsrv\config.  

4. Click Find on the Edit menu in Notepad and search for the following:  

<location path=”Default Web Site/Vision”> 

5. Locate the windowsAuthentication tag and add useAppPoolCredentials=”true” as 
shown in the following:  
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6. Once the edits are complete, save your changes and restart IIS to make the changes 

effective.  

Both of these configuration options require that a Service Principal Name be established 
for the Application Pool Identity. The following section provides more information on 
creating the SPN. 

Configure Service Principal Name (SPN) for Vision Application Pool Identity 
Under the default configuration with Kernel Mode Authentication enabled, it is not necessary to 
create a Service Principal Name for the Application Pool Identity for Windows Authentication to 
work properly and creating an SPN for the Application Pool Identity in this configuration will result 
in a “duplicate SPN” issue, preventing Windows Integrated Security from authenticating anyone to 
the Web site.   

However, For Multi Tier installations of Vision Document Management it is necessary to create a 
Service Principal Name (SPN) for the domain user running the Vision Application Pool Identity 
(DeltekVisionAppPool) as this is the account used for delegation. 
  

 

Domain rights are required to complete this step. 
  

After you establish one of the above Kernel Mode configuration changes, use the steps 
below to create a Service Principal Name for the Application Pool Identity of the 
DeltekVisionAppPool. 

  

 The setspn utility is installed by default on Windows Server 2008. It is not necessary to download 
and install it separately. 

  

To create a service principal name, complete the following steps: 

1. Open a command prompt and enter: 

setspn –A http/<Vision Web/App Server name> <domain app pool identity> 

For example: setspn –A http/camqainetk3nwb5 inettest2k3n\dmservacct3tier 

2. Repeat for the FQDN of the server. 
 
For example: setspn –A http/camqainetk3nwb5.inettest2k3n.com 
inettest2k3n\dmservacct3tier 
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See the following related Microsoft Knowledge Base article for more information: 

http://support.microsoft.com/?id=871179  
  

Install Vision Document Management on the SPF 2010 Server 

To install Vision Document Management on the SPF 2010 server, complete the following 
steps: 

1. As indicated at the beginning of this section, it is highly recommended that you install all 
available Windows Updates prior to proceeding with the installation. 

2. Download the DeltekVision71DM.exe file and run the setup on your Vision Web server.  

3. The installation will check to ensure that the IIS Role service, Windows Authentication, is 
installed. If the Role Service is not installed you will be prompted to install it and the setup 
will exit: 

 
4. After installing the Windows Authentication IIS Role Service, re-run the Document 

Management installation. The installation will then check to ensure that Hotfix KB979917 
is installed (not applicable if you have Windows Server 2008 R2 Sp1 installed), which is a 
SPF 2010 Prerequisite not installed by the Prerequisite Installer. If it is not installed you 
will be prompted to install it, the setup will exit and a browser windows will open 
displaying the download site. Be sure to choose the correct x64 version, Vista is Server 
2008 and Win7 is Server 2008 R2: 

 
 

5. After installing the hotfix for KB979917 (if applicable), re-run the Document Management 
installation.  

6. When a dialog box displays to indicate the IIS licensing requirements for the use of 
Windows Integrated Authentication (required to use Vision Document Management), click 
OK. 

7. On the first Document Management Installation Wizard page, click Next. 

8. On the License Agreement page, select I accept the terms of the license agreement 
and click Next. 

http://support.microsoft.com/?id=871179
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9. When the following message displays to remind you to run the setup on the Vision 
web/application server if you haven’t already, click OK. 
 

 
10. On the Ready to Install the Program page, click Install to start the installation. The 

installation automatically downloads SharePoint Foundation 2010, extracts the setup files 
and installs SharePoint Foundation 2010.   

11. When the “Files extracted successfully” message displays, click the OK button to 
continue the installation. 

12. The installation will launch the SharePoint Foundation Prerequisite Installer to install all 
prerequisite components. If there are errors installing any of these components you will 
see a dialog indicating that the Prerequisite Installer failed and a link to open the log file 
and the installation will end. The following is an example: 
 

 
 
The following is an excerpt from the Prerequisite Installer log file related to this error, 
which indicates a problem installing the Microsoft Chart Controls for Microsoft .Net 
Framework 3.5: 

 
Should you need to locate the Prerequisite Installer log file, it can be found in 
c:\users\<username>\appdata\local\temp\<numbered subdirectory>. 
 
NOTE: If there are errors installing any software prerequisites download and install them 
manually and then re-run the Document Management installation.  Links to all software 
prerequisites can be found at the following URL, http://technet.microsoft.com/en-
us/library/cc288751.aspx.    

Additionally, if a reboot is necessary you will see a dialog indicating a reboot is required 
and the installation will end. The following is an example: 

http://technet.microsoft.com/en-us/library/cc288751.aspx
http://technet.microsoft.com/en-us/library/cc288751.aspx
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13. After resolving all issues with the prerequisite installations and/or rebooting as required, 

start the Document Management installation again to complete the installation. It may 
take running the installation several times to complete. 

14. The installation will then launch the SharePoint Foundation installation routine. If there 
are errors installing SharePoint, a dialog will display with a link to open the log file. 

15. After resolving any issues, start the Document Management installation again to 
complete the installation. 

16. When the InstallShield Wizard Complete page displays, click Finish. 

Run the SharePoint 2010 Products Configuration Wizard 

To run the SharePoint 2010 Products Configuration Wizard, complete the following steps: 

1. Click Start » All Programs » Microsoft SharePoint 2010 Products » SharePoint 2010 
Products Configuration Wizard. The Welcome page displays. 

 
2. Click Next. The following dialog box displays. 
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3. Click Yes. The Connect to a server farm page displays. 

 

 
4. Select the Create a new server farm option and click Next. The Specify Configuration 

Database Settings page displays.  
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5. Enter the name of the database server to host the SharePoint configuration database and 

accept the default database name: SharePoint_Config. 
  

 Your SharePoint database access account will need to have the dbcreator and 
securityadmin SQL Server Roles.  This is accomplished by adding the domain account as 
a SQL Server login and adding the roles as shown below: 
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6. In the Username field, enter the domain and name of the Vision Application Pool Identity 
(as configured earlier) as the username for the SharePoint database access account, and 
enter the user’s password in the Password field. 

7. Click Next. The Specify Farm Security Settings page displays 
 

 
8. Enter a Passphrase for your Farm. 

9. Click Next. The Configure SharePoint Central Administration Web Application page 
displays. 
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10. Select the Specify port number check box and enter the port to be used for the 

SharePoint Central Administration Web site and select the Negotiate (Kerberos) option 
for the Authentication provider to use. 

11. Click Next. The following dialog box displays.  

 
12. Click Yes to continue using Kerberos with Windows Authentication. The Completing the 

SharePoint Products and Technologies Configuration Wizard page displays. 



Multi Tier New Installation and Configuration for x64 (64-bit) Servers – SharePoint is NOT Installed 

 

Document Management Installation Guide 150 

 

 
 

13. Click Next to begin the configuration. This process may take some time to complete. The 
Configuration Successful page displays when configuration is complete. 
 

 
14. Click Finish to finish the configuration process. The SharePoint Central Administration 

page displays. 
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Use SharePoint Central Administration to Complete the SharePoint 
Configuration 

To finish the SharePoint Configuration, complete the following steps: 

1. When you click Finish in the preceding procedure, SharePoint Central Administration is 
launched. 

 
2. Decide whether to sign up for the SharePoint Customer Experience Program and click 

OK. The Configure your SharePoint Farm Wizard page displays.  
 

  

 
!!IMPORTANT!! 

Do not use the SharePoint Farm Wizard. Doing so will cause Vision to stop functioning!   
Instead, choose the Cancel button “No, I will configure everything myself” 

  

 
3. Click Cancel to configure everything yourself. The main Central Administration page 

displays. 
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4. Select Manage Services on Server under System Settings. The Services on Server page 

displays: 

 
5. Locate SharePoint Foundation Search and click Start. 
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6. Configure the search service to include the Service account and Content Access account 

(use the same account information as your Vision Application Pool Identity). 

7. Configure Search Database as shown above and click Start. After a minute or so, the 
service’s status changes to Started.  



Multi Tier New Installation and Configuration for x64 (64-bit) Servers – SharePoint is NOT Installed 

 

Document Management Installation Guide 154 

 

 
8. Click Application Management and then Manage Web Applications. The Web 

Applications page displays. 

 
9. Click the New button. The Create New Web Application page displays. 
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10. Select Classic Mode Authentication as the Authentication type. 

11. Select the Create a new IIS web site option. Enter a description for the Web site and 
specify a port different that that being used for the Vision web site in Port.   
 
SharePoint defaults to ‘SharePoint – 80’ and ‘80’ as the site name and port, if you change 
the port to be 81 (as shown), the web site name changes automatically to ‘SharePoint – 
81’ 

  

 If no other web applications are installed on this server you may choose to install SPF into 
the Default Web Site. 
 
WARNING!  If other web applications are installed to the Default Web Site, SPF will 
render them unusable. 

  

Note the entry in Path, which by default is the root of your WSS Web site in a directory 
named after the port chosen under c:\inetpub\wwwroot\wss\virtualdirectories. 
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12. Select Negotiate (Kerberos) under Authentication provider. 

13. For the Allow Anonymous and Use Secure Sockets Layer (SSL) options, accept the 
default of No. If you want to use SSL with SharePoint, then you can configure SSL later, 
but you must not configure SSL to be required as the web service calls from the Vision 
Web/Application server cannot use SSL.. 

 
14. Select the Create new application pool option and provide a name (Deltek 

recommends using the same name as the Web site for consistence, for example, 
SharePoint - 81).  
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15. Using Network Service is not an option for SPF. Use the same account used for the 
Deltek Vision Application Pool.  NOTE: Since the SharePoint Application Pool will run as 
a domain account, an SPN is required on the SharePoint server. 

16. Verify the name of the server in Database Server (it should be the same as that used for 
the SharePoint configuration database server) Accept the default in Database Name. It is 
recommended that you modify the name of the Content database to something more 
recognizable (WSS_Content_SharePoint81, for example).  

17. Select Windows authentication (recommended) under Database authentication. This 
will use the SharePoint service account and the Vision Application Pool Identity 
configured previously. 

 
18. Select the search server in Select Windows SharePoint Foundation search server 

and click OK. The following dialog box displays. 

 
19. Click OK to use Kerberos for Windows Authentication. After a few minutes, the 

Application Created page displays. This page indicates the status of the process to 
create a new Web application. 
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20. Do not click the link to Create Site Collection link at this time. It is still necessary to add 

DeltekVision as a managed path with explicit inclusion before you create the site 
collection. Click OK. The Web Applications page displays. 

 
21. Select the SharePoint – 80 web application and click Managed Paths. The Define 

Managed Paths page displays.  
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22. Enter DeltekVision in Path and select Explicit inclusion in Type and click Add Path. 

23. Click OK. DeltekVision is now added as a Managed Path. 

 
24. Click Application Management and select the Create Site Collection option under Site 

Collections. 
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The Create Site Collection page displays. 

 
25. Enter Deltek Vision in Title and enter a description, if appropriate. 

26. From the URL drop-down list, select /deltekvision. This will be the top level root for 
Vision Document Management. 
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27. Under Select a template, accept the default of Team Site for the template to be used 

and enter a username in each of the User name fields for the primary and secondary site 
collection administrators.  One of these needs to be the Vision Application Pool identity. 

28. Select No Quota in Select a quota template and click OK. The Top-Level Site 
Successfully Created page displays. 

 
29. Click the link for the top level site (in our example it is 

http://camqainetk38wb9/deltekvision) to display the site. 

http://camqainetk38wb9/deltekvision
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30. The SharePoint configuration is complete. Close SharePoint Central Administration. 

Configure Service Principal Name (SPN) for SharePoint Application Pool 
Identity 
The default configuration of the SharePoint created Application Pool will be to have Kernel Mode 
Authentication disabled therefore, a Service Principal Name for the Application Pool Identity is 
required for Windows Authentication to work properly. 
  

 

Domain rights are required to complete this step. 
  

  

 The setspn utility is installed by default on Windows Server 2008. It is not necessary to download and 
install it separately. 

  

To create a service principal name, complete the following steps: 

1. Open a command prompt and enter: 

setspn –A http/<SharePoint Web Server name> <domain app pool identity> 

For example: setspn –A http/camqainetk3nwb5 inettest2k3n\dmservacct3tier 

2. Repeat for the FQDN of the server. 
 
For example: setspn –A http/camqainetk3nwb5.inettest2k3n.com 
inettest2k3n\dmservacct3tier 

Optional: Configure SharePoint for a Custom URL  
If you will be configuring your SharePoint server to use a custom DNS record for the URL (e.g. 
http://sharepoint.company.com instead of http://servername.company.com http://servername), 
then you must create additional SPNs and also create Alternate Access Mappings in SharePoint.  

http://sharepoint.company.com/
http://servername/
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It is recommended that this step be completed before Vision Document Management is 
configured in order to eliminate re-work.  

See “Appendix B: Configure SharePoint for a Custom URL” for more information. 

Verify IIS Configuration and Configure Deltek Vision Document 
Management .NET Assembly 

To verify IIS configuration, complete the following steps: 

1. Use the directions that follow to open Internet Information Services to view these Web 
sites: 

 Default Web Site — This is your Vision Web Site 

 SharePoint – 80 — This is your SPF 2010 Web Site 

 SharePoint Central Administration Web Site 

 
2. Copy the Vision Document Management .NET assembly to SharePoint site directory. 

 
Copy Deltek.Vision.WSS30.Server.dll from <Vision Installation Directory>\Support\DM\30 
to one of the following: 

 c:\inetpub\wwwroot\bin (if WSS was installed to the default web site) 

 c:\inetput\wwwroot\wss\Virtual Directories\<site>\bin (if SPF 2010 was installed to 
another web site) 

  

 By default, the <site> directory references the port chosen. In our example, the port is 80. 
If you extended WSS to the Default Web Site, the path will be c:\inetput\wwwroot\ bin. 

  

Configure Document Management Service Account in Weblink 
You must configure the Document Management service account (username/password) on the 
System Settings tab of the Deltek Vision Weblink utility.   

To configure the account in Weblink, complete the following steps: 

1. On the Vision Web server, launch Weblink from Start » Programs » Deltek Vision 
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2. Enter the Weblink password when prompted. 

3. Click the System Settings tab. 

In the Document Management group box, enter your SharePoint username and 
password. This account is your SharePoint Service account/Deltek Vision Application 
Pool Identity.  

4. Click Test and SharePoint Credentials to validate that the information entered is 
correct. 

 

Configure Vision Document Management 
To configure Vision Document Management, complete the following steps: 

1. Log in to Vision using an account that has access to the Configuration menus. 

2. Click Configuration » General » System Settings and select the Document 
Management tab. 
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3. Select the Enable Document Management check box. 

4. Enter the name of the server hosting Document Management. This should be the server 
name only, FQDN’s or custom DNS values are not needed here.. Enter this value without 
the protocol prefix (for example, remove the http://). In the illustration above, the value is 
camqainetk3nwb4. 

5. Enter the Virtual Server Port. In the illustration above, the port is 81 but on a typical 
dedicated SharePoint installation the port will be 80 for the default web site. 

6. Click the Lookup icon to select the current site. 
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7. The Select Web Site dialog box displays the available sites. Select a site, and click OK. 

8. Save your changes. 

Configure Constrained Delegation 
Because your SPF server is on a separate physical server and because the Vision Web server 
needs to pass the domain credentials of your Vision Document Management users on to the SPF 
server, you must configure Constrained Delegation. 
  

 This assumes a non-Internet deployment of Vision Document Management using Kerberos 
authentication. If you are deploying Vision Document Management so that it is accessible over 
the Internet, you need to skip ahead to “Optional: Configure Protocol Transition” in the next 
section. 

  

To configure Constrained Delegation, complete the following steps: 

1. Open the Active Directory Users and Computers MMC on a Domain Controller.  

2. Locate the User account for the Vision Application Pool Identity (SPF Service account). 

3. Right-click and select Properties. 

4. On the Delegation tab, select the Trust this user for delegation to specified services 
only option. 

5. Select the Use Kerberos only option.  
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6. Click the Add button. The Add Services dialog box displays. 

 
7. Click Users or Computers. The Select Users or Computers dialog box displays. 
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8. Locate the http service, select it, and click OK. 

 
The Delegation tab should look like this: 
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Because we are explicitly specifying the http service and not all services on the SharePoint 
server, this is known as Constrained Delegation. 

There are two http service types listed. These service types are known as Service Principal 
Names (SPNs). The SPN referencing CAMQAINETK3NSS1.inettest2k3n.com was created 
automatically when the server was added to the domain and the http service (IIS) was installed. 
The second SPN referencing sharepoint.inettest2k3n.com is a new SPN that was created using 
the setspn utility that allows us to register the custom FQDN of the server, which provides more 
meaning than the actual machine name. 

Optional: Configure Protocol Transition  
If Vision Document Management functionality is required over the Internet and you will be using a 
custom DNS/FQDN for the SharePoint URL (as in our example, vision1.inettest2k3n.com), then 
you need to configure a form of delegation referred to as Protocol Transition. If Document 
Management functionality is not required, you can skip this step. 

The Kerberos authentication protocol must be used to authenticate from the Vision Web server to 
the SharePoint server. However, if Vision is deployed in an Internet scenario and there are users 
outside of the firewall who need to access Document Management features, Kerberos 
authentication cannot be used to authenticate the client to the Web server. This is because the 
client needs to have the ability to negotiate a Kerberos ticket with the Key Distribution Center 
(KDC), which is a service running on a Domain Controller. This requires port 88 to be opened 
inbound on the firewall to the Domain Controller, which is not an advisable configuration. 

To get around this, you must be running a Native Windows Server 2003 functional domain.  

Protocol Transition is configured by selecting the Use any authentication protocol option 
instead of the Use Kerberos only option, which is used to configure Constrained Delegation. 
This allows the client to authenticate to the Vision Web server using NTLM instead of Kerberos, 
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and that authentication is then “transitioned” over to Kerberos for Delegation to the SharePoint 
server.  

To configure Protocol Transition, complete the following steps: 

1. Open the Active Directory Users and Computers MMC on a Domain Controller.  

2. Locate the User account for the Vision Application Pool Identity (WSS Service account), 
which is most likely under the Computers Organizational Unit (OU). 

3. Right-click and select Properties. 

4. On the Delegation tab, select the Trust this user for delegation to specified services 
only option. 

5. Select the Use any authentication protocol option.  

 
6. Click Add. The Add Services dialog box displays. 
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7. Click Users or Computers, search for the SharePoint server, and click OK. 

 
8. Locate the http service for the SPN (FQDN) you created earlier (in our example, 

sharepoint.inettest2k3n.com), select it, and click OK. 

This illustration shows two http service types. Unless you have registered a custom 
FQDN using the setspn utility, only the server name displays. These service types are 
known as Service Principal Names (SPNs).  

The SPN referencing CAMQAINETK3NSS1.inettest2k3n.com was created 
automatically when the server was added to the domain and the http service (IIS) was 
installed.  

The second SPN referencing sharepoint.inettest2k3n.com is a new SPN that was 
created using the setspn utility that allows us to register the custom FQDN of the server, 
which provides more meaning than the actual machine name. 
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The Delegation tab should look like this: 

 
Because you explicitly specified the http service and not all services on the SharePoint 
server and because you selected the Use any authentication protocol option and not 
Kerberos, this is known as Protocol Transition. 
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Multi Tier New Installation and Configuration for 
x86 (32-bit) Servers – SharePoint Already Installed  
  

 
!!IMPORTANT!! 

Please note the following for this configuration: 

 In this configuration, Vision and SharePoint are installed on separate 
physical servers. 

 SharePoint is already installed on the SharePoint server so the Vision 
Document Management installation will NOT install SharePoint. 

 The installation of SharePoint is WSS 3.0. 

 The Operating System for the server is x86 (32-bit). 

Prerequisites 
 Install/upgrade your Vision installation to Vision 7.1 (if applicable).  

 Identify the domain user account being used for the SharePoint Farm Administrator 
account. 

 Change the Application Pool Identity for the DeltekVisionAppPool to be the SharePoint 
Farm Administrator account above (the Vision 7.1 installation sets this to be the local 
DeltekVision account).  

 Add this domain user to the local Administrators and IIS_IUSRS group on the Vision 
server if not already done by the SharePoint installation. 

Multi Tier Installation and Configuration Steps 

Step Where to Perform Description 

1.  Vision Web/Application 
Server 

Configure Vision Application Pool Identity to Be a 
Domain Account 

2.  Vision Web/Application 
Server 

Grant Local Security Policy Rights to Vision Application 
Pool Identity 

3.  Vision Web/Application 
Server 

Install Vision 7.1 Document Management on the Vision 
Web Server 

4.  Vision Web/Application 
Server 

Configure Authentication for the Vision Website 

5.  Vision Web/Application 
Server 

Configure Service Principal Name (SPN) for Vision 
Application Pool Identity 

6.  

 

SharePoint Web 
/Application Server 

Install Vision Document Management on the WSS 
Server 
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7.  SharePoint Web 
/Application Server 

Use SharePoint Central Administration to Complete the 
SharePoint Configuration 

8.  SharePoint Web 
/Application Server 

Verify IIS Configuration and Configure Deltek Vision 
Document Management .NET Assembly 

9.  Vision Web/Application 
Server 

Configure Document Management Service Account in 
Weblink 

10.  Vision Web/Application 
Server 

Configure Vision Document Management 

11.  Domain Configure Constrained Delegation 

12.  Domain Optional: Configure Protocol Transition  

Configure Vision Application Pool Identity to Be a Domain Account 
You must change the Vision Application Pool Identity to be a domain account. The default is for 
Vision to use a local DeltekVision user created during the Vision installation. This change is 
necessary because of the local account’s inability to work with Active Directory.  

  

 For this account to be the Application Pool Identity it must be a member of the IIS_IUSRS group in 
addition to being a member of the local administrators group on the local server.. 

  

To change the Vision Application Pool Identity, complete the following steps: 

1. Create a domain user account. This account must also be your SPF Service account. No 
domain Admin rights are needed for this account. 

2. Log on to the domain on the Vision Web/application server using an Administrator 
account. 

3. Open Internet Information Services: Start » All Programs » Administrative Tools » 
Internet Information Services (IIS) Manager. 

4. Expand the Server name and then click Application Pools. 

5. Select the DeltekVisionAppPool and select Advanced Settings from the Action pane 
on the right hand side.  The following displays: 
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6. Place your cursor in the Identity field and then click the ellipses button to set the identity.  

The Application Pool Identify dialog box displays:  

  
7. Select the Custom account option and click Set.  The Set Credentials dialog box 

displays. 
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8. In the User name field, enter the Application Pool Identity in the form 

<Domain>\<Username>.  

9. In the Password and Confirm password fields, enter that user’s password.  

10. Click OK three times to set the identity. 

Grant Local Security Policy Rights to Vision Application Pool Identity 
The Vision Application Pool Identity/SharePoint Service Account must be granted Logon as a 
service rights on the Vision 7.1 Web/Application Server for multi-tier Document Management 
installations, as shown in the following example of the Local Security Settings setup screens. 

 

Install and Configure Vision 7.1 Document Management  
When you install Vision 7.1 Document Management the changes made to your WSS installation 
are outlined below. The steps to configure WSS are outlined in this section. 

  

 If you would prefer not to run the Vision Document Management installation on an 
existing installation of SharePoint, refer to “Appendix C: Manual Installation of Vision 
Document Management” for manual setup instructions. 

  

The Document Management installation does the following: 

 Installs Web Service Extensions (WSE) 2.0 SP3. 
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 Installs WSS 3.0 when run on the SharePoint web server if it is not already installed. 

 Copies Document Management files to the SharePoint ISAPI folder (c:\program 
files\common files\microsoft shared\web service extensions\12\isapi). 

 Copies Document Management files to the Vision Support folder (\program 
files\deltek\vision\support\DM\30). 

 Modifies the SharePoint Web.config file in the ISAPI directory to work with Vision 
Document Management. 

 Installs Deltek.Vision.WSS30.Server.dll into the Global Assembly Cache (GAC). 

Install Vision 7.1 Document Management on the Vision Web Server 
  

 

You must run the Document Management installer on both the Vision web server and the 
SharePoint web server. 

  

To install Vision 7.1 Document Management on the Vision Web server, complete the 
following steps: 

1. Download the DeltekVision71DM.exe file and run the setup on your Vision Web server.  

2. When a dialog box displays to indicate the IIS licensing requirements for the use of 
Windows Integrated Authentication (required to use Vision Document Management), click 
OK. 

3. On the first Document Management Installation Wizard page, click Next. 

4. On the License Agreement page, select I accept the terms of the license agreement 
and click Next. 

5. When this message displays, click No because this is a multi-tier installation of Vision 
Document Management and your Vision Web server will not host WSS 3.0. 

 
6. When the following dialog box displays to remind you to run the setup on the WSS 

server, click OK. 

 
7. On the Ready to Install the Program page, click Install to start the installation. 

8. When the InstallShield Wizard Complete page displays, click Finish. 
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Configure Authentication for the Vision Website 

IIS Kernel Mode Authentication 

The default configuration of IIS when using Windows Integrated Authentication (required for 
Vision Document Management) is to use Kernel Mode Authentication.  Under this configuration, 
the application pool runs under the Machine account whether or not an identity has been 
established.  Because the Machine account cannot be used for delegation scenarios which are 
required for multi-tier deployments of Vision Document Management, the additional configuration 
steps below are necessary. 

Identify if Kernel Mode Authentication Is Enabled 

Follow the steps below to identify if Kernel Mode Authentication is enabled. (In a default 
configuration of IIS it will be enabled.) 

To identify the authentication status, complete the following steps: 

1. Log on to the domain on the Vision Web/application server using an Administrator 
account. 

2. Open Internet Information Services: Start » All Programs » Administrative Tools » 
Internet Information Services (IIS) Manager. 

3. Expand the server name, expand Sites, and expand Default Web Site or whichever site 
Vision is installed to. 

4. Select the Vision virtual directory and then double click Authentication in the 
Features view. 

5. Select Windows Authentication and verify that the status is Enabled 
(Anonymous Access should be Disabled).  If it is not, select Enable from the 
Actions menu. 

6. With Windows Authentication still selected, click Advanced settings on the 
Action menu. The Advanced Settings dialog box displays: 

 

Kernel Mode Authentication Implementation 

As mentioned above, under this default configuration, Vision Document Management will 
not be able to delegate credentials to a WSS 3.0 server separate from the Vision 
Web/application server. Two possible configurations allow Document Management to 
function properly: 
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 Disable Kernel Mode Authentication. In order to Disable Kernel Mode Authentication, 
simply uncheck the Enable Kernel Mode Authentication option under the Advanced 
Settings of the Windows Authentication feature for the Vision virtual directory. 

 Modify the ApplicationHost.config file to force the use of the Application Pool 
Identity.  In order to continue to use Kernel Mode Authentication but force the Application 
Pool to run under its Identity rather than the Machine account, it is necessary to modify 
the ApplicationHost.config file, the steps of which are outlined below: 

1. Click Start » All Programs » Accessories. 

2. Right-click Notepad, click Run as, and select the Administrator account.  
  

 This is necessary in order to save the changes we need to make to the 
ApplicationHost.config file, which is protected under UAC (User Account Control) on 
Windows Server 2008. 

  

3. Click Open on the File menu and locate the ApplicationHost.config file from 
c:\windows\system32\inetsrv\config.  

4. Click Find on the Edit menu in Notepad and search for the following:  

<location path=”Default Web Site/Vision”> 

5. Locate the windowsAuthentication tag and add useAppPoolCredentials=”true” as 
shown in the following:  

 
6. Once the edits are complete, save your changes and restart IIS to make the changes 

effective.  

Both of these configuration options require that a Service Principal Name be established 
for the Application Pool Identity. The following section provides more information on 
creating the SPN. 

Configure Service Principal Name (SPN) for Vision Application Pool Identity 
Under the default configuration with Kernel Mode Authentication enabled, it is not necessary to 
create a Service Principal Name for the Application Pool Identity for Windows Authentication to 
work properly and creating an SPN for the Application Pool Identity in this configuration will result 
in a “duplicate SPN” issue, preventing Windows Integrated Security from authenticating anyone to 
the Web site.   
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However, For Multi Tier installations of Vision Document Management it is necessary to create a 
Service Principal Name (SPN) for the domain user running the Vision Application Pool Identity 
(DeltekVisionAppPool) as this is the account used for delegation. 
  

 

Domain rights are required to complete this step. 
  

After you establish one of the above Kernel Mode configuration changes, use the steps 
below to create a Service Principal Name for the Application Pool Identity of the 
DeltekVisionAppPool. 

  

 The setspn utility is installed by default on Windows Server 2008. It is not necessary to download 
and install it separately. 

  

To create a service principal name, complete the following steps: 

1. Open a command prompt and enter: 

setspn –A http/<Vision Web/App Server name> <domain app pool identity> 

For example: setspn –A http/camqainetk3nwb5 inettest2k3n\dmservacct3tier 

2. Repeat for the FQDN of the server. 
 
For example: setspn –A http/camqainetk3nwb5.inettest2k3n.com 
inettest2k3n\dmservacct3tier 

  

 
See the following related Microsoft Knowledge Base article for more information: 

http://support.microsoft.com/?id=871179  
  

Install Vision Document Management on the WSS Server 

To install Vision Document Management on the WSS server, complete the following steps: 

1. Download DeltekVision71DM.exe and run the setup on your WSS server. 

2. On the first Document Management Installation Wizard page, click Next. 

3. On the License Agreement page, select I accept the terms of the license agreement 
and click Next. 

4. Accept the license agreement and click Next. The following dialog displays reminding 
you to run the setup on the Vision web/application server if you haven’t already. 
 

 
5. On the Ready to Install the Program page, click Install to start the installation. 

http://support.microsoft.com/?id=871179
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6. When the InstallShield Wizard Complete page displays, click Finish. 

Use SharePoint Central Administration to Complete the SharePoint 
Configuration 
  

 
!! IMPORTANT INFORMATION FOR EXISTING SHAREPOINT 
INSTALLATIONS!! 

If you already have SharePoint installed and plan to use that existing installation 
of SharePoint for your Vision Document Management deployment, note that 
Vision Document Management does not support integrating with an existing 
SharePoint site collection and requires a dedicated top-level site on your 
SharePoint server. 

  

 
To create the Document Management SharePoint site collection, complete the following steps: 

1. Launch the SharePoint Central Administration application 

2. Click Application Management and select the Define Managed Paths option.  

 
3. Enter DeltekVision in Path and select Explicit inclusion in Type. 

4. Click OK.  

5. Click Application Management and select the Create site collection option under 
SharePoint Site Management. 
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The Create Site Collection page displays. 

 
6. Enter Deltek Vision in Title and enter a description, if appropriate. 

7. From the URL drop-down list, select /deltekvision. This will be the top level root for 
Vision Document Management. 
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8. Under Select a template, accept the default of Team Site for the template to be used 

and enter a username in each of the User name fields for the primary and secondary site 
collection administrators. One of these needs to be the Vision Application Pool identity. 

9. Select No Quota in Select a quota template and click OK. The Top-Level Site 
Successfully Created page displays. 

 
10. Click Start » Run, enter iisreset /noforce, and click Enter. 
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11. Click the link for the top level site (in our example it is 
http://camqainetk3nss1/deltekvision) to display the site. 

 
12. The SharePoint configuration is complete. Close SharePoint Central Administration. 

Verify IIS Configuration and Configure Deltek Vision Document 
Management .NET Assembly 
Copy the Vision Document Management .NET assembly to SharePoint site directory. 

Identify your IIS configuration to specifically identify which website and port SharePoint is 
using as well as which website and port Vision is using.   

If SharePoint was extended to the Default Web Site then copy 
Deltek.Vision.WSS30.Server.dll from <Vision Installation Directory>\Support\DM\30 to 
c:\inetput\wwwroot\bin 

If SharePoint was extended to its own named web site (e.g. SharePoint – 80) then copy 
Deltek.Vision.WSS30.Server.dll from <Vision Installation Directory>\Support\DM\30 to 
c:\inetput\wwwroot\wss\Virtual Directories\<site>\bin 

  

 By default, the <site> directory references the port chosen. (e.g. 80, 81, etc.).  

Configure Document Management Service Account in Weblink 
You must configure the Document Management service account (username/password) on the 
System Settings tab of the Deltek Vision Weblink utility.  
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To configure the service account in Weblink, complete the following steps: 

1. On the Vision Web server, launch Weblink from Start » Programs » Deltek Vision 

2. Enter the Weblink password when prompted. 

3. Click the System Settings tab.  

4. In the Document Management group box, enter your SharePoint username and 
password.  This account is your SharePoint Service account/Deltek Vision Application 
Pool Identity.  

5. Click the Test button and SharePoint Credentials to validate that the information entered 
is correct. 

 

Configure Vision Document Management 
To configure Vision Document Management, complete the following steps: 

1. Log in to Vision using an account that has access to the Configuration menus. 

2. Click Configuration » General » System Settings and select the Document 
Management tab. 
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3. Select the Enable Document Management check box. 

4. Enter the name of the server hosting Document Management. This should be the server 
name only, FQDN’s or custom DNS values are not needed here. Enter this value without 
the protocol prefix (for example, remove the http://). In the illustration above, the value is 
camqainetk3nwb4. 

5. Enter the Virtual Server Port. In the illustration above, the port is 81 but on a typical 
dedicated SharePoint installation the port will be 80 for the default web site. 

6. Click the Lookup icon to select the current site. 
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7. The Select Web Site dialog box displays the available sites. Select a site, and click OK. 

8. Save your changes. 

Configure Constrained Delegation 
Because your WSS server is on a separate physical server and because the Vision Web server 
needs to pass the domain credentials of your Vision Document Management users on to the 
WSS server, you must configure Constrained Delegation. 

  

 This assumes a non-Internet deployment of Vision Document Management using Kerberos 
authentication. If you are deploying Vision Document Management so that it is accessible over the 
Internet, you need to skip ahead to “Optional: Configure Protocol Transition” in the next section. 

  

To configure Constrained Delegation, complete the following steps: 

1. Open the Active Directory Users and Computers MMC on a Domain Controller.  

2. Locate the User account for the Vision Application Pool Identity (WSS Service account). 

3. Right-click and select Properties. 

4. On the Delegation tab, select the Trust this user for delegation to specified services 
only option. 

5. Select the Use Kerberos only option.  
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6. Click the Add button. The Add Services dialog box displays. 

 
7. Click Users or Computers. The Select Users or Computers dialog box displays. 
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8. Locate the http service, select it, and click OK. 

 
The Delegation tab should look like this: 
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Because we are explicitly specifying the http service and not all services on the SharePoint 
server, this is known as Constrained Delegation. 

There are two http service types listed. These service types are known as Service Principal 
Names (SPNs). The SPN referencing CAMQAINETK3NSS1.inettest2k3n.com was created 
automatically when the server was added to the domain and the http service (IIS) was installed. 
The second SPN referencing sharepoint.inettest2k3n.com is a new SPN that was created using 
the setspn utility that allows us to register the custom FQDN of the server, which provides more 
meaning than the actual machine name. 

Optional: Configure Protocol Transition  
If Vision Document Management functionality is required over the Internet and you will be using a 
custom DNS/FQDN for the SharePoint URL (as in our example, vision1.inettest2k3n.com), then 
you need to configure a form of delegation referred to as Protocol Transition. If Document 
Management functionality is not required, you can skip this step. 

The Kerberos authentication protocol must be used to authenticate from the Vision Web server to 
the SharePoint server. However, if Vision is deployed in an Internet scenario and there are users 
outside of the firewall who need to access Document Management features, Kerberos 
authentication cannot be used to authenticate the client to the Web server. This is because the 
client needs to have the ability to negotiate a Kerberos ticket with the Key Distribution Center 
(KDC), which is a service running on a Domain Controller. This requires port 88 to be opened 
inbound on the firewall to the Domain Controller, which is not an advisable configuration. 

To get around this, you must be running a Native Windows Server 2003 functional domain.  

To configure Protocol Transition, select the Use any authentication protocol option instead of 
the Use Kerberos only option, which is used to configure Constrained Delegation. This allows 
the client to authenticate to the Vision Web server using NTLM instead of Kerberos, and that 
authentication is then “transitioned” over to Kerberos for Delegation to the SharePoint server.  
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To configure Protocol Transition, complete the following steps: 

1. Open the Active Directory Users and Computers MMC on a Domain Controller.  

2. Locate the User account for the Vision Application Pool Identity (WSS Service account), 
which is most likely under the Computers Organizational Unit (OU). 

3. Right-click and select Properties. 

4. On the Delegation tab, select the Trust this user for delegation to specified services 
only option. 

5. Select the Use any authentication protocol option.  

 
6. Click the Add button. The Add Services dialog box displays. 
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7. Click Users or Computers, search for the SharePoint server, and click OK. 

 
8. Locate the http service for the SPN (FQDN) you created earlier (in our example, 

sharepoint.inettest2k3n.com), select it, and click OK. 



Multi Tier New Installation and Configuration for x86 (32-bit) Servers – SharePoint Already Installed 

 

Document Management Installation Guide 193 

 

 
This illustration shows two http service types. Unless you have registered a custom 
FQDN using the setspn utility, only the server name displays. These service types are 
known as Service Principal Names (SPNs).  

The SPN referencing CAMQAINETK3NSS1.inettest2k3n.com was created 
automatically when the server was added to the domain and the http service (IIS) was 
installed.  

The second SPN referencing sharepoint.inettest2k3n.com is a new SPN that was 
created using the setspn utility that allows us to register the custom FQDN of the server, 
which provides more meaning than the actual machine name. 
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The Delegation tab should look like this: 

 
Because you explicitly specified the http service and not all services on the SharePoint 
server and because you selected the Use any authentication protocol option and not 
Kerberos, this is known as Protocol Transition. 
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Multi Tier New Installation and Configuration for 
x64 (64-bit) Servers – SharePoint Already Installed 
  

 
!!IMPORTANT!! 

Please note the following for this configuration: 

 In this configuration, Vision and SharePoint are installed on separate 
physical servers. 

 SharePoint is already installed on the SharePoint server so the Vision 
Document Management installation will NOT install SharePoint. 

 The installation of SharePoint is SPF 2010. 

 The Operating System for the server is x64 (64-bit). 

Prerequisites 
 Install/upgrade your Vision installation to Vision 7.1 (if applicable).  

 Identify the domain user account being used for the SharePoint Farm Administrator 
account. 

 Change the Application Pool Identity for the DeltekVisionAppPool to be the SharePoint 
Farm Administrator account above (the Vision 7.1 installation sets this to be the local 
DeltekVision account).  

 Add this domain user to the local Administrators and IIS_IUSRS group on the Vision 
server if not already done by the SharePoint installation. 

Multi Tier Installation and Configuration Steps 

Step Where to Perform Description 

1.  Vision Web/Application 
Server 

Configure Vision Application Pool Identity to Be a Domain 
Account 

2.  Vision Web/Application 
Server 

Grant Local Security Policy Rights to Vision Application 
Pool Identity 

3.  Vision Web/Application 
Server 

Install Vision 7.1 Document Management on the Vision 
Web Server 

4.  Vision Web/Application 
Server 

Configure Authentication for the Vision Website 

5.  Vision Web/Application 
Server 

Configure Service Principal Name (SPN) for Vision 
Application Pool Identity 

6.  SharePoint Web 
/Application Server 

Install Vision Document Management on the SharePoint 
Foundation 2010 Server 
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7.  SharePoint Web 
/Application Server 

Use SharePoint Central Administration to Complete the 
SharePoint Configuration 

8.  SharePoint Web 
/Application Server 

Configure Service Principal Name (SPN) for SharePoint 
Application Pool Identity 

9.  SharePoint Web 
/Application Server 

Verify IIS Configuration and Configure Deltek Vision 
Document Management .NET Assembly 

10.  Vision Web/Application 
Server 

Configure Document Management Service Account in 
Weblink 

11.  Vision Web/Application 
Server 

Configure Vision Document Management 

12.  Domain Configure Constrained Delegation 

13.  Domain Optional: Configure Protocol Transition 

Configure Vision Application Pool Identity to be a Domain Account  
You must change the Vision Application Pool Identity to be a domain account. The default is for 
Vision to use a local DeltekVision user created during the Vision installation. This change is 
necessary because of the local account’s inability to work with Active Directory.  

  

 For this account to be the Application Pool Identity it must be a member of the IIS_IUSRS group in 
addition to being a member of the local administrators group on the local server. 

  

To change the Vision Application Pool Identity, complete the following steps: 

1. Create a domain user account. This account must also be your SPF Service account. No 
domain Admin rights are needed for this account. 

2. Log on to the domain on the Vision Web/application server using an Administrator 
account. 

3. Open Internet Information Services: Start » All Programs » Administrative Tools » 
Internet Information Services (IIS) Manager. 

4. Expand the Server name and then click Application Pools. 

5. Select the DeltekVisionAppPool and select Advanced Settings from the Action pane 
on the right hand side. The following displays: 
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6. Place your cursor in the Identity field and then click the ellipses button to set the identity.  

The Application Pool Identify dialog box displays:  

  
7. Select the Custom account option and click Set. The Set Credentials dialog box 

displays. 
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8. In User name, enter the Application Pool Identity in the form <Domain>\<Username>.  

9. In Password and Confirm password, enter that user’s password.  

10. Click OK three times to set the identity. 

Grant Local Security Policy Rights to Vision Application Pool Identity 
The Vision Application Pool Identity/SharePoint Service Account must be granted Logon as a 
service rights on the Vision 7.1 Web/Application Server for multi-tier Document Management 
installations, as shown in the following example of the Local Security Settings setup screens. 

 

Install and Configure Vision 7.1 Document Management 
When you install Vision 7.1 Document Management the changes made to your existing SPF 
installation are outlined below. The steps to configure SPF are outlined in this section. 

  

 

If you would prefer not to run the Vision Document Management installation on an 
existing installation of SharePoint, refer to “Appendix C: Manual Installation of Vision 
Document Management” for manual setup instructions. 

  

The Document Management installation does the following: 

 Installs Web Service Extensions (WSE) 2.0 SP3. 
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 Installs SPF 2010 when run on the SharePoint web server, if it is not already installed. 

 Copies Document Management files to the SharePoint ISAPI folder (c:\program 
files\common files\microsoft shared\web service extensions\14\isapi). 

 Copies Document Management files to the Vision Support folder (\program 
files\deltek\vision\support\DM\30). 

 Modifies the SharePoint Web.config file in the ISAPI directory to work with Vision 
Document Management. 

 Installs Deltek.Vision.WSS30.Server.dll into the Global Assembly Cache (GAC). 

Install Vision 7.1 Document Management on the Vision Web Server 
  

 

You must run the Document Management installer on both the Vision web server and the 
SharePoint web server. 

  

To install Vision 7.1 Document Management, complete the following steps: 

1. Download the DeltekVision71DM.exe file and run the setup on your Vision Web server.  

2. The installation will check to ensure that the IIS Role service, Windows Authentication, is 
installed.  If the Role Service is not installed you will be prompted to install it and the 
setup will exit: 

 

 
3. After installing the Windows Authentication IIS Role Service, re-run the Document 

Management installation.  

4. When a dialog box displays to indicate the IIS licensing requirements for the use of 
Windows Integrated Authentication (required to use Vision Document Management), click 
OK. 

5. On the first Document Management Installation Wizard page, click Next. 

6. On the License Agreement page, select I accept the terms of the license agreement 
and click Next. 

7. When this message displays, click No because this is a multi-tier installation of Vision 
Document Management and your Vision Web server will not host SPF 2010. 
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8. When the following dialog box displays to remind you to run the setup on the SPF server, 

click OK. 

 
9. On the Ready to Install the Program page, click Install to start the installation. 

10. When the InstallShield Wizard Complete page displays, click Finish. 

Configure Authentication for the Vision Website 

IIS Kernel Mode Authentication 

The default configuration of IIS when using Windows Integrated Authentication (required for 
Vision Document Management) is to use Kernel Mode Authentication.  Under this configuration, 
the application pool runs under the Machine account whether or not an identity has been 
established.  Because the Machine account cannot be used for delegation scenarios which are 
required for multi-tier deployments of Vision Document Management, the additional configuration 
steps below are necessary. 

Identify if Kernel Mode Authentication Is Enabled 

Follow the steps below to identify if Kernel Mode Authentication is enabled. (In a default 
configuration of IIS it will be enabled.) 

To identify the authentication status, complete the following steps: 

1. Log on to the domain on the Vision Web/application server using an Administrator 
account. 

2. Open Internet Information Services: Start » All Programs » Administrative Tools » 
Internet Information Services (IIS) Manager. 

3. Expand the server name, expand Sites, and expand Default Web Site or whichever site 
Vision is installed to. 

4. Select the Vision virtual directory and then double click Authentication in the 
Features view. 

5. Select Windows Authentication and verify that the status is Enabled 
(Anonymous Access should be Disabled).  If it is not, select Enable from the 
Actions menu. 
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6. With Windows Authentication still selected, click Advanced settings on the 
Action menu. The Advanced Settings dialog box displays: 

 

Kernel Mode Authentication Implementation 

As mentioned above, under this default configuration, Vision Document Management will 
not be able to delegate credentials to a WSS 3.0 server separate from the Vision 
Web/application server. Two possible configurations allow Document Management to 
function properly: 

 Disable Kernel Mode Authentication. In order to Disable Kernel Mode Authentication, 
simply uncheck the Enable Kernel Mode Authentication option under the Advanced 
Settings of the Windows Authentication feature for the Vision virtual directory. 

 Modify the ApplicationHost.config file to force the use of the Application Pool 
Identity.  In order to continue to use Kernel Mode Authentication but force the Application 
Pool to run under its Identity rather than the Machine account, it is necessary to modify 
the ApplicationHost.config file, the steps of which are outlined below: 

1. Click Start » All Programs » Accessories. 

2. Right-click Notepad, click Run as, and select the Administrator account.  
  

 This is necessary in order to save the changes we need to make to the 
ApplicationHost.config file, which is protected under UAC (User Account Control) on 
Windows Server 2008. 

  

3. Click Open on the File menu and locate the ApplicationHost.config file from 
c:\windows\system32\inetsrv\config.  

4. Click Find on the Edit menu in Notepad and search for the following:  

<location path=”Default Web Site/Vision”> 

5. Locate the windowsAuthentication tag and add useAppPoolCredentials=”true” as 
shown in the following:  
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6. Once the edits are complete, save your changes and restart IIS to make the changes 

effective.  

Both of these configuration options require that a Service Principal Name be established 
for the Application Pool Identity. The following section provides more information on 
creating the SPN. 

Configure Service Principal Name (SPN) for Vision Application Pool Identity 
Under the default configuration with Kernel Mode Authentication enabled, it is not necessary to 
create a Service Principal Name for the Application Pool Identity for Windows Authentication to 
work properly and creating an SPN for the Application Pool Identity in this configuration will result 
in a “duplicate SPN” issue, preventing Windows Integrated Security from authenticating anyone to 
the Web site.   

However, For Multi Tier installations of Vision Document Management it is necessary to create a 
Service Principal Name (SPN) for the domain user running the Vision Application Pool Identity 
(DeltekVisionAppPool) as this is the account used for delegation. 
  

 

Domain rights are required to complete this step. 
  

After you establish one of the above Kernel Mode configuration changes, use the steps 
below to create a Service Principal Name for the Application Pool Identity of the 
DeltekVisionAppPool. 

  

 The setspn utility is installed by default on Windows Server 2008. It is not necessary to download 
and install it separately. 

  

To create a service principal name, complete the following steps: 

1. Open a command prompt and enter: 

setspn –A http/<Vision Web/App Server name> <domain app pool identity> 

For example: setspn –A http/camqainetk3nwb5 inettest2k3n\dmservacct3tier 

2. Repeat for the FQDN of the server. 
 
For example: setspn –A http/camqainetk3nwb5.inettest2k3n.com 
inettest2k3n\dmservacct3tier 
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See the following related Microsoft Knowledge Base article for more information: 

http://support.microsoft.com/?id=871179  
  

Install Vision Document Management on the SPF 2010 Server 

To install Vision Document Management on the SPF 2010 server, complete the following 
steps: 

1. Download the DeltekVision71DM.exe file and run the setup on your Vision Web server.  

2. When a dialog box displays to indicate the IIS licensing requirements for the use of 
Windows Integrated Authentication (required to use Vision Document Management), click 
OK. 

3. On the first Document Management Installation Wizard page, click Next. 

4. On the License Agreement page, select I accept the terms of the license agreement 
and click Next. 

5. When the following message displays to remind you to run the setup on the Vision 
web/application server if you haven’t already, click OK. 
 

 
6. On the Ready to Install the Program page, click Install to start the installation. 

7. When the InstallShield Wizard Complete page displays, click Finish. 

Use SharePoint Central Administration to Complete the SharePoint 
Configuration 
  

 
!! IMPORTANT INFORMATION FOR EXISTING SHAREPOINT 
INSTALLATIONS!! 

If you already have SharePoint installed and plan to use that existing installation 
of SharePoint for your Vision Document Management deployment, note that 
Vision Document Management does not support integrating with an existing 
SharePoint site collection and requires a dedicated top-level site on your 
SharePoint server. 

  

 
Create Document Management SharePoint Site Collection 

The following instructions are for SharePoint Foundation 2010.  If  you have Windows SharePoint 
Services 3.0 x64 installed as your version of SharePoint, refer to page 110 for specific 
instructions for that platform. 

http://support.microsoft.com/?id=871179
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1. Launch the SharePoint 2010 Central Administration application 

2. Click Manage Web Applications under Application Management. 

3. Select your SharePoint web application and click Managed Paths. The Define Managed 
Paths page displays.  

 
4. Enter DeltekVision in Path and select Explicit inclusion in Type and click Add Path. 

5. Click OK.  
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6. Click Application Management and select the Create Site Collection option under Site 
Collections. 

 
The Create Site Collection page displays. 

 
7. Enter Deltek Vision in Title and enter a description, if appropriate. 

8. From the URL drop-down list, select /deltekvision. This will be the top level root for 
Vision Document Management. 
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9. Under Select a template, accept the default of Team Site for the template to be used 

and enter a username in each of the User name fields for the primary and secondary site 
collection administrators.  One of these needs to be the Vision Application Pool identity. 

10. Select No Quota in Select a quota template and click OK. The Top-Level Site 
Successfully Created page displays. 

 
11. Click the link for the top level site (in our example it is 

http://camqainetk38wb9/deltekvision) to display the site. 

http://camqainetk38wb9/deltekvision
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12. The SharePoint configuration is complete. Close SharePoint Central Administration. 

Configure Service Principal Name (SPN) for SharePoint Application Pool 
Identity 
The default configuration of the SharePoint created Application Pool will be to have Kernel Mode 
Authentication disabled therefore, a Service Principal Name for the Application Pool Identity is 
required for Windows Authentication to work properly. 
  

 

Domain rights are required to complete this step. 
  

  

 The setspn utility is installed by default on Windows Server 2008. It is not necessary to download and 
install it separately. 

  

To create a service principal name, complete the following steps: 

1. Open a command prompt and enter: 

setspn –A http/<SharePoint Web Server name> <domain app pool identity> 

For example: setspn –A http/camqainetk3nwb5 inettest2k3n\dmservacct3tier 

2. Repeat for the FQDN of the server. 
 
For example: setspn –A http/camqainetk3nwb5.inettest2k3n.com 
inettest2k3n\dmservacct3tier 

  

 
See the following related Microsoft Knowledge Base article for more information: 

http://support.microsoft.com/?id=871179  
  

http://support.microsoft.com/?id=871179
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Verify IIS Configuration and Configure Deltek Vision Document 
Management .NET Assembly 
Copy the Vision Document Management .NET assembly to SharePoint site directory. 

Identify your IIS configuration to specifically identify which website and port SharePoint is 
using as well as which website and port Vision is using.   

If SharePoint was extended to the Default Web Site then copy 
Deltek.Vision.WSS30.Server.dll from <Vision Installation Directory>\Support\DM\30 to 
c:\inetput\wwwroot\bin 

If SharePoint was extended to its own named web site (e.g. SharePoint – 80) then copy 
Deltek.Vision.WSS30.Server.dll from <Vision Installation Directory>\Support\DM\30 to 
c:\inetput\wwwroot\wss\Virtual Directories\<site>\bin 

  

 

By default, the <site> directory references the port chosen. (e.g. 80, 81, etc.).  

Configure Document Management Service Account in Weblink 
You must configure the Document Management service account (username/password) on the 
System Settings tab of the Deltek Vision Weblink utility.   

To configure the account in Weblink, complete the following steps: 

1. On the Vision Web server, launch Weblink from Start » Programs » Deltek Vision 

2. Enter the Weblink password when prompted. 

3. Click the System Settings tab. 

In the Document Management group box, enter your SharePoint username and 
password. This account is your SharePoint Service account/Deltek Vision Application 
Pool Identity.  

4. Click Test and SharePoint Credentials to validate that the information entered is 
correct. 
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Configure Vision Document Management 
To configure Vision Document Management, complete the following steps: 

1. Log in to Vision using an account that has access to the Configuration menus. 

2. Click Configuration » General » System Settings and select the Document 
Management tab. 

 
3. Select the Enable Document Management check box. 



Multi Tier New Installation and Configuration for x64 (64-bit) Servers – SharePoint Already Installed 

 

Document Management Installation Guide 210 

 

4. Enter the name of the server hosting Document Management. This should be the server 
name only, FQDN’s or custom DNS values are not needed here.. Enter this value without 
the protocol prefix (for example, remove the http://). In the illustration above, the value is 
camqainetk3nwb4. 

5. Enter the Virtual Server Port. In the illustration above, the port is 81 but on a typical 
dedicated SharePoint installation the port will be 80 for the default web site. 

6. Click the Lookup icon to select the current site. 

 
7. The Select Web Site dialog box displays the available sites. Select a site, and click OK. 

8. Save your changes. 

Configure Constrained Delegation 
Because your SPF server is on a separate physical server and because the Vision Web server 
needs to pass the domain credentials of your Vision Document Management users on to the SPF 
server, you must configure Constrained Delegation. 
  

 This assumes a non-Internet deployment of Vision Document Management using Kerberos 
authentication. If you are deploying Vision Document Management so that it is accessible over 
the Internet, you need to skip ahead to “Optional: Configure Protocol Transition” in the next 
section.. 

  

To configure Constrained Delegation, complete the following steps: 

1. Open the Active Directory Users and Computers MMC on a Domain Controller.  

2. Locate the User account for the Vision Application Pool Identity (SPF Service account). 

3. Right-click and select Properties. 

4. On the Delegation tab, select the Trust this user for delegation to specified services 
only option. 

5. Select the Use Kerberos only option.  
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6. Click the Add button. The Add Services dialog box displays. 

 
7. Click Users or Computers. The Select Users or Computers dialog box displays. 
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8. Locate the http service, select it, and click OK. 
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The Delegation tab should look like this: 

 
Because we are explicitly specifying the http service and not all services on the SharePoint 
server, this is known as Constrained Delegation. 

There are two http service types listed. These service types are known as Service Principal 
Names (SPNs). The SPN referencing CAMQAINETK3NSS1.inettest2k3n.com was created 
automatically when the server was added to the domain and the http service (IIS) was installed. 
The second SPN referencing sharepoint.inettest2k3n.com is a new SPN that was created using 
the setspn utility that allows us to register the custom FQDN of the server, which provides more 
meaning than the actual machine name. 

Optional: Configure Protocol Transition  
If Vision Document Management functionality is required over the Internet and you will be using a 
custom DNS/FQDN for the SharePoint URL (as in our example, vision1.inettest2k3n.com), then 
you need to configure a form of delegation referred to as Protocol Transition. If Document 
Management functionality is not required, you can skip this step. 

The Kerberos authentication protocol must be used to authenticate from the Vision Web server to 
the SharePoint server. However, if Vision is deployed in an Internet scenario and there are users 
outside of the firewall who need to access Document Management features, Kerberos 
authentication cannot be used to authenticate the client to the Web server. This is because the 
client needs to have the ability to negotiate a Kerberos ticket with the Key Distribution Center 
(KDC), which is a service running on a Domain Controller. This requires port 88 to be opened 
inbound on the firewall to the Domain Controller, which is not an advisable configuration. 

To get around this, you must be running a Native Windows Server 2003 functional domain.  

Protocol Transition is configured by selecting the Use any authentication protocol option 
instead of the Use Kerberos only option, which is used to configure Constrained Delegation. 
This allows the client to authenticate to the Vision Web server using NTLM instead of Kerberos, 



Multi Tier New Installation and Configuration for x64 (64-bit) Servers – SharePoint Already Installed 

 

Document Management Installation Guide 214 

 

and that authentication is then “transitioned” over to Kerberos for Delegation to the SharePoint 
server.  

To configure Protocol Transition, complete the following steps: 

1. Open the Active Directory Users and Computers MMC on a Domain Controller.  

2. Locate the User account for the Vision Application Pool Identity (WSS Service account), 
which is most likely under the Computers Organizational Unit (OU). 

3. Right-click and select Properties. 

4. On the Delegation tab, select the Trust this user for delegation to specified services 
only option. 

5. Select the Use any authentication protocol option.  

 
6. Click Add. The Add Services dialog box displays. 
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7. Click Users or Computers, search for the SharePoint server, and click OK. 

 
8. Locate the http service for the SPN (FQDN) you created earlier (in our example, 

sharepoint.inettest2k3n.com), select it, and click OK. 
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This illustration shows two http service types. Unless you have registered a custom 
FQDN using the setspn utility, only the server name displays. These service types are 
known as Service Principal Names (SPNs).  

The SPN referencing CAMQAINETK3NSS1.inettest2k3n.com was created 
automatically when the server was added to the domain and the http service (IIS) was 
installed.  

The second SPN referencing sharepoint.inettest2k3n.com is a new SPN that was 
created using the setspn utility that allows us to register the custom FQDN of the server, 
which provides more meaning than the actual machine name. 
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The Delegation tab should look like this: 

 
Because you explicitly specified the http service and not all services on the SharePoint 
server and because you selected the Use any authentication protocol option and not 
Kerberos, this is known as Protocol Transition. 
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Multi Tier—New Installation of Document 
Management 7.1 with MOSS 2007 
  

 
!!IMPORTANT!! 

Please note the following for this configuration: 

 Vision and SharePoint will exist on separate physical Web servers (Vision 
and MOSS 2007 are not supported on the same physical server).  

 Vision Document Management is being installed against an existing 
installation of Microsoft Office SharePoint Server (MOSS) 2007. 

 Vision Document Management requires its own top-level site and cannot 
integrate into an existing MOSS 2007 site collection. 

 The Operating System for the SharePoint server is x86 (32-bit) or x64 
(64-bit). 

Prerequisites 
 MOSS 2007 is already installed and configured. 

 Install/upgrade your Vision installation to Vision 7.1.  

 Change the Application Pool Identity for the DeltekVisionAppPool to be a domain user 
account (the Vision 7.1 installation sets this to be the local DeltekVision account).  

 The domain service account used above will also be the SharePoint Service account.  

 Add this domain user to the local Administrators and IIS_IUSRS group on the Vision 
server. 

Multi Tier Installation and Configuration Steps 

Step Where to Perform Description 

1.  Vision Web/Application 
Server 

Configure Vision Application Pool Identity to Be a 
Domain Account 

2.  Vision Web/Application 
Server 

Grant Local Security Policy Rights to Vision Application 
Pool Identity 

3.  Vision Web/Application 
Server 

Install Vision 7.1 Document Management on the Vision 
Web Server 

4.  Vision Web/Application 
Server 

Configure Authentication for the Vision Website 

5.  Vision Web/Application 
Server 

Configure Service Principal Name (SPN) for Vision 
Application Pool Identity 
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6.  

 

SharePoint Web 
/Application Server 

Install Vision Document Management on the MOSS 
2007 Server 

7.  SharePoint Web 
/Application Server 

Use SharePoint Central Administration to Create the 
Vision Document Management Site Collection 

8.  SharePoint Web 
/Application Server 

Verify IIS Configuration and Configure Deltek Vision 
Document Management .NET Assembly 

9.  Vision Web/Application 
Server 

Configure Document Management Service Account in 
Weblink 

10.  Vision Web/Application 
Server 

Configure Vision Document Management 

11.  Domain Configure Constrained Delegation 

12.  Domain Optional: Configure Protocol Transition 

Configure Vision Application Pool Identity to Be a Domain Account 
You must change the Vision Application Pool Identity to be a domain account. The default is for 
Vision to use a local DeltekVision user created during the Vision installation. This change is 
necessary because of the local account’s inability to work with Active Directory.  

  

 For this account to be the Application Pool Identity it must be a member of the IIS_IUSRS group in 
addition to being a member of the local administrators group on the local server.. 

  

To change the Vision Application Pool Identity, complete the following steps: 

1. Create a domain user account. This account must also be your SPF Service account. No 
domain Admin rights are needed for this account. 

2. Log on to the domain on the Vision Web/application server using an Administrator 
account. 

3. Open Internet Information Services: Start » All Programs » Administrative Tools » 
Internet Information Services (IIS) Manager. 

4. Expand the Server name and then click Application Pools. 

5. Select the DeltekVisionAppPool and select Advanced Settings from the Action pane 
on the right hand side.  The following displays: 
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6. Place your cursor in the Identity field and then click the ellipses button to set the identity.  

The Application Pool Identify dialog box displays:  

  
7. Select the Custom account option and click Set.  The Set Credentials dialog box 

displays. 
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8. In the User name field, enter the Application Pool Identity in the form 

<Domain>\<Username>.  

9. In the Password and Confirm password fields, enter that user’s password.  

10. Click OK three times to set the identity. 

Grant Local Security Policy Rights to Vision Application Pool Identity 
The Vision Application Pool Identity/SharePoint Service Account must be granted Logon as a 
service rights on the Vision 7.1 Web/Application Server for multi-tier Document Management 
installations, as shown in the following example of the Local Security Settings setup screens. 

 

Install and Configure Vision 7.1 Document Management and the 
MOSS 2007 Site Collection  
When you install Vision 7.1 Document Management the changes made to your existing MOSS 
2007 installation are outlined below .  The steps to configure MOSS 2007 are outlined in this 
section. 

  

 

If you would prefer not to run the Vision Document Management installation on an existing 
installation of SharePoint, refer to “Appendix C: Manual Installation of Vision Document 
Management” for manual setup instructions. 
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The Document Management installation performs the following: 

 Installs Web Service Extensions (WSE) 2.0 Sp3. 

 Copies Document Management files to SharePoint ISAPI folder (c:\program 
files\common files\microsoft shared\web service extensions\12\isapi). 

 Copies Document Management files to the Vision Support folder (\program 
files\deltek\vision\support\DM\30). 

 Modifies the SharePoint Web.config file in the ISAPI directory to work with Vision 
Document Management. 

 Installs Deltek.Vision.WSS30.Server.dll into the Global Assembly Cache (GAC). 

Install Vision 7.1 Document Management on the Vision Web Server 
  

 

You must run the Document Management installer on both the Vision web server and the 
SharePoint web server. 

  

To install Vision 7.1 Document Management on the Vision Web server, complete the 
following steps: 

1. Download the DeltekVision71DM.exe file and run the setup on your Vision Web server.  

2. When a dialog box displays to indicate the IIS licensing requirements for the use of 
Windows Integrated Authentication (required to use Vision Document Management), click 
OK. 

3. On the first Document Management Installation Wizard page, click Next. 

4. On the License Agreement page, select I accept the terms of the license agreement 
and click Next. 

5. When this message displays, click No because this is a multi-tier installation of Vision 
Document Management and your Vision Web server will not host SharePoint. 

 
6. When the following message displays to remind you to run the setup on the MOSS 2007 

server, click OK. 

 
7. On the Ready to Install the Program page, click Install to start the installation. 

8. When the InstallShield Wizard Complete page displays, click Finish. 
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Configure Authentication for the Vision Website 

IIS Kernel Mode Authentication 

The default configuration of when using Windows Integrated Authentication (required for Vision 
Document Management) is to use Kernel Mode Authentication.  Under this configuration, the 
application pool runs under the Machine account whether or not an identity has been established.  
Because the Machine account cannot be used for delegation scenarios which are required for 
multi-tier deployments of Vision Document Management, the additional configuration steps below 
are necessary. 

Identify if Kernel Mode Authentication Is Enabled 

Follow the steps below to identify if Kernel Mode Authentication is enabled. (In a default 
configuration of IIS  it will be enabled.) 

To identify the authentication status, complete the following steps: 

1. Log on to the domain on the Vision Web/application server using an Administrator 
account. 

2. Open Internet Information Services: Start » All Programs » Administrative Tools » 
Internet Information Services (IIS) Manager. 

3. Expand the server name, expand Sites, and expand Default Web Site or whichever site 
Vision is installed to. 

4. Select the Vision virtual directory and then double click Authentication in the 
Features view. 

5. Select Windows Authentication and verify that the status is Enabled 
(Anonymous Access should be Disabled).  If it is not, select Enable from the 
Actions menu. 

6. With Windows Authentication still selected, click Advanced settings on the 
Action menu. The Advanced Settings dialog box displays: 

 

Kernel Mode Authentication Implementation 

As mentioned above, under this default configuration, Vision Document Management will 
not be able to delegate credentials to a WSS 3.0 server separate from the Vision 
Web/application server. Two possible configurations allow Document Management to 
function properly: 
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 Disable Kernel Mode Authentication. In order to Disable Kernel Mode Authentication, 
simply uncheck the Enable Kernel Mode Authentication option under the Advanced 
Settings of the Windows Authentication feature for the Vision virtual directory. 

 Modify the ApplicationHost.config file to force the use of the Application Pool 
Identity.  In order to continue to use Kernel Mode Authentication but force the Application 
Pool to run under its Identity rather than the Machine account, it is necessary to modify 
the ApplicationHost.config file, the steps of which are outlined below: 

1. Click Start » All Programs » Accessories. 

2. Right-click Notepad, click Run as, and select the Administrator account.  
  

 This is necessary in order to save the changes we need to make to the 
ApplicationHost.config file, which is protected under UAC (User Account Control) on 
Windows Server 2008. 

  

3. Click Open on the File menu and locate the ApplicationHost.config file from 
c:\windows\system32\inetsrv\config.  

4. Click Find on the Edit menu in Notepad and search for the following:  

<location path=”Default Web Site/Vision”> 

5. Locate the windowsAuthentication tag and add useAppPoolCredentials=”true” as 
shown in the following:  

 
6. Once the edits are complete, save your changes and restart IIS to make the changes 

effective.  

Both of these configuration options require that a Service Principal Name be established 
for the Application Pool Identity. The following section provides more information on 
creating the SPN. 

Configure Service Principal Name (SPN) for Vision Application Pool Identity 
Under the default configuration with Kernel Mode Authentication enabled, it is not necessary to 
create a Service Principal Name for the Application Pool Identity for Windows Authentication to 
work properly and creating an SPN for the Application Pool Identity in this configuration will result 
in a “duplicate SPN” issue, preventing Windows Integrated Security from authenticating anyone to 
the Web site.   



Multi Tier—New Installation of Document Management 7.1 with MOSS 2007 

 

Document Management Installation Guide 225 

 

However, For Multi Tier installations of Vision Document Management it is necessary to create a 
Service Principal Name (SPN) for the domain user running the Vision Application Pool Identity 
(DeltekVisionAppPool) as this is the account used for delegation. 
  

 

Domain rights are required to complete this step. 
  

After you establish one of the above Kernel Mode configuration changes, use the steps 
below to create a Service Principal Name for the Application Pool Identity of the 
DeltekVisionAppPool. 

  

 The setspn utility is installed by default on Windows Server 2008. It is not necessary to download 
and install it separately. 

  

To create a service principal name, complete the following steps: 

1. Open a command prompt and enter: 

setspn –A http/<Vision Web/App Server name> <domain app pool identity> 

For example: setspn –A http/camqainetk3nwb5 inettest2k3n\dmservacct3tier 

2. Repeat for the FQDN of the server. 
 
For example: setspn –A http/camqainetk3nwb5.inettest2k3n.com 
inettest2k3n\dmservacct3tier 

  

 
See the following related Microsoft Knowledge Base article for more information: 

http://support.microsoft.com/?id=871179  

Install Vision Document Management on the MOSS 2007 Server 

To install Vision Document Management on the WSS server, complete the following steps: 

1. Download DeltekVision71DM.exe and run the setup on your WSS server. 

2. On the first Document Management Installation Wizard page, click Next. 

3. On the License Agreement page, select I accept the terms of the license agreement 
and click Next. 

4. When the following message displays to remind you to run the setup on the Vision 
web/application server if you haven’t already, click OK. 
 

 
5. On the Ready to Install the Program page, click Install to start the installation. 

http://support.microsoft.com/?id=871179
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6. When the InstallShield Wizard Complete page displays, click Finish. 

Use SharePoint Central Administration to Create the Vision Document 
Management Site Collection 
  

 

!! IMPORTANT INFORMATION FOR EXISTING SHAREPOINT 
INSTALLATIONS!! 

If you already have SharePoint installed and plan to use that existing installation 
of SharePoint for your Vision Document Management deployment, note that 
Vision Document Management does not support integrating with an existing 
SharePoint site collection and requires a dedicated top-level site on your 
SharePoint server. 

  

To complete the SharePoint configuration, complete the following steps: 

1. In SharePoint Central Administration, click Application Management and select the 
Define Managed Paths option. This will create a specific URL for your Vision Document 
Management site collection (for example, http://MOSSServer/DeltekVision). 

 
2. Enter DeltekVision in Path and select Explicit inclusion from the Type drop-down list. 

3. Click OK.  

4. Click Application Management and select the Create site collection option under 
SharePoint Site Management. 
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The Create Site Collection page displays. 

 
5. Enter Deltek Vision in Title and enter a description, if appropriate. 

6. From the URL drop-down list, select /deltekvision. This will be the top level root for 
Vision Document Management. 
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7. Under Select a template, accept the default of Team Site for the template to be used 

and enter a username in each of the User name fields for the primary and secondary site 
collection administrators.  One of these needs to be the Vision Application Pool identity. 

8. Select No Quota in Select a quota template and click OK. The Top-Level Site 
Successfully Created page displays. 

 
9. Click Start » Run, enter iisreset /noforce, and click Enter. 
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10. Click the link for the top level site (in our example it is 
http://camqainetk3nss1/deltekvision) to display the site. 

 
11. The SharePoint configuration is complete. Close SharePoint Central Administration. 

Verify IIS Configuration and Configure Deltek Vision Document 
Management .NET Assembly 
Copy the Vision Document Management .NET assembly to SharePoint site directory: 

 Identify your IIS configuration to specifically identify which website and port SharePoint is 
using as well as which website and port Vision is using.   

 If SharePoint was extended to the Default Web Site then copy 
Deltek.Vision.WSS30.Server.dll from <Vision Installation Directory>\Support\DM\30 
to c:\inetput\wwwroot\bin 

 If SharePoint was extended to its own named web site (e.g. SharePoint – 80) then copy 
Deltek.Vision.WSS30.Server.dll from <Vision Installation Directory>\Support\DM\30 
to c:\inetput\wwwroot\wss\Virtual Directories\<site>\bin 

  

 

By default, the <site> directory references the port chosen. (e.g. 80, 81, etc.).  

Configure Document Management Service Account in Weblink 
You must configure the Document Management service account (username/password) on the 
System Settings tab of the Deltek Vision Weblink utility.  
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To configure the service account in Weblink, complete the following steps: 

1. On the Vision Web server, launch Weblink from Start » Programs » Deltek Vision 

2. Enter the Weblink password when prompted. 

3. Click the System Settings tab.  

4. In the Document Management group box, enter your SharePoint username and 
password.  This account is your SharePoint Service account/Deltek Vision Application 
Pool Identity.  

5. Click the Test button and SharePoint Credentials to validate that the information entered 
is correct. 

 

Configure Vision Document Management 
To configure Vision Document Management, complete the following steps: 

1. Log in to Vision using an account that has access to the Configuration menus. 

2. Click Configuration » General » System Settings and select the Document 
Management tab. 
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3. Select the Enable Document Management option. 

4. Enter the name of the server hosting document management. This should be the server 
name only, FQDN’s or custom DNS values are not needed here.. Enter this value without 
the protocol prefix (for example, remove the http://). In the illustration above, the value is 
camqainetk3nwb4. 

5. Enter the Virtual Server Port. In our example the port is 81 but on a typical dedicated 
SharePoint installation the port will be 80 for the default web site.. 

6. Click the Lookup icon to select the current site. 
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7. The Select Web Site dialog box displays the available sites. Select a site, and click OK. 

8. Save your changes. 

Configure Constrained Delegation 
Because your MOSS server is on a separate physical server and because the Vision Web server 
needs to pass the domain credentials of your Vision Document Management users on to the 
MOSS server, you must configure Constrained Delegation. 

  

 This assumes a non-Internet deployment of Vision Document Management using Kerberos 
authentication. If you are deploying Vision Document Management so that it is accessible over the 
Internet, you need to skip ahead to “Optional: Configure Protocol Transition” in the next section. 

  

To configure Constrained Delegation, complete the following steps: 

1. Open the Active Directory Users and Computers MMC on a Domain Controller.  

2. Locate the User account for the Vision Application Pool Identity (MOSS Service account), 
which is most likely under the Computers Organizational Unit (OU). 

3. Right-click and select Properties. 

4. On the Delegation tab, select the Trust this user for delegation to specified services 
only option. 

5. Select the Use Kerberos only option.  
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6. Click the Add button. The Add Services dialog box displays. 

 
7. Click Users or Computers. The Select Users or Computers dialog box displays. 
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8. Locate the http service, select it, and click OK. 

 
9. The Delegation tab should look like this: 
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Because we are explicitly specifying the http service and not all services on the SharePoint 
server, this is known as Constrained Delegation. 

There are two http service types listed. These service types are known as Service Principal 
Names (SPNs). The SPN referencing CAMQAINETK3NSS1.inettest2k3n.com was created 
automatically when the server was added to the domain and the http service (IIS) was installed. 
The second SPN referencing sharepoint.inettest2k3n.com is a new SPN that was created using 
the setspn utility that allows us to register the custom FQDN of the server, which provides more 
meaning than the actual machine name. 

Optional: Configure Protocol Transition  
If Vision Document Management functionality is required over the Internet and you will be using a 
custom DNS/FQDN for the SharePoint URL (as in our example, vision1.inettest2k3n.com), then 
you need to configure a form of delegation referred to as Protocol Transition. If Document 
Management functionality is not required, you can skip this step. 

The Kerberos authentication protocol must be used to authenticate from the Vision Web server to 
the SharePoint server. However, if Vision is deployed in an Internet scenario and there are users 
outside of the firewall who need to access Document Management features, Kerberos 
authentication cannot be used to authenticate the client to the Web server. This is because the 
client needs to have the ability to negotiate a Kerberos ticket with the Key Distribution Center 
(KDC), which is a service running on a Domain Controller. This requires port 88 to be opened 
inbound on the firewall to the Domain Controller, which is not an advisable configuration. 

To get around this, you must be running a Native Windows Server 2003 functional domain.  

To configure Protocol Transition, select the Use any authentication protocol option instead of 
the Use Kerberos only option, which is used to configure Constrained Delegation. This allows 
the client to authenticate to the Vision Web server using NTLM instead of Kerberos, and that 
authentication is then “transitioned” over to Kerberos for Delegation to the SharePoint server.  



Multi Tier—New Installation of Document Management 7.1 with MOSS 2007 

 

Document Management Installation Guide 236 

 

To configure Protocol Transition, complete the following steps: 

1. Open the Active Directory Users and Computers MMC on a Domain Controller.  

2. Locate the User account for the Vision Application Pool Identity (MOSS Service account), 
which is most likely under the Computers Organizational Unit (OU). 

3. Right-click and select Properties. 

4. On the Delegation tab, select the Trust this user for Delegation to specified services 
only option. 

5. Select the Use any authentication protocol option.  

 
6. Click the Add button. The Add Services dialog box displays. 
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7. Click Users or Computers, search for the SharePoint server, and click OK. 

 
8. Locate the http service for the SPN (FQDN) you created earlier (in our example, 

sharepoint.inettest2k3n.com) select it, and click OK. 
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This illustration shows two http service types. Unless you have registered a custom 
FQDN using the setspn utility, only the server name displays. These service types are 
known as Service Principal Names (SPNs).  

The SPN referencing CAMQAINETK3NSS1.inettest2k3n.com was created 
automatically when the server was added to the domain and the http service (IIS) was 
installed.  

The second SPN referencing sharepoint.inettest2k3n.com is a new SPN that was 
created using the setspn utility that allows us to register the custom FQDN of the server, 
which provides more meaning than the actual machine name. 
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The Delegation tab should look like this: 

 
Because we are explicitly specifying the http service and not all services on the 
SharePoint server and because we are using the Use any authentication protocol 
option and not Kerberos, this is known as Protocol Transition. 
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Multi-Tier New Installation of Document 
Management 7.1 with SharePoint Server 2010 
  

 
!!IMPORTANT!! 

Please note the following for this configuration: 

 Vision and SharePoint will exist on separate physical Web servers (Vision 
and SharePoint Server 2010 are not supported on the same physical 
server).  

 Vision Document Management is being installed against an existing 
installation of SharePoint Server 2010. 

 Vision Document Management requires its own top-level site and cannot 
integrate into an existing SharePoint Server 2010 site collection. 

 The Operating System for the SharePoint server is x64 (64-bit). 

Prerequisites 
 SharePoint Server 2010 is already installed and configured. 

 Install/upgrade your Vision installation to Vision 7.1.  

 Change the Application Pool Identity for the DeltekVisionAppPool to be a domain user 
account (the Vision 7.1 installation sets this to be the local DeltekVision account).  

 The domain service account used above will also be the SharePoint Service account.  

 Add this domain user to the local Administrators and IIS_IUSRS group on the Vision 
server. 

Multi Tier Installation and Configuration Steps 

Step Where to Perform Description 

1.  Vision Web/Application 
Server 

Configure Vision Application Pool Identity to Be a 
Domain Account 

2.  Vision Web/Application 
Server 

Grant Local Security Policy Rights to Vision Application 
Pool Identity 

3.  Vision Web/Application 
Server 

Install Vision 7.1 Document Management on the Vision 
Web Server 

4.  Vision Web/Application 
Server 

Configure Authentication for the Vision Website 

5.  Vision Web/Application 
Server 

Configure Service Principal Name (SPN) for Vision 
Application Pool Identity 



Multi-Tier New Installation of Document Management 7.1 with SharePoint Server 2010 

 

Document Management Installation Guide 241 

 

6.  SharePoint Web 
/Application Server 

Install Vision Document Management on SharePoint 
Server 2010 

7.  SharePoint Web 
/Application Server 

Use SharePoint Central Administration to Create the 
Vision Document Management Site Collection 

8.  SharePoint Web 
/Application Server 

Verify IIS Configuration and Configure Deltek Vision 
Document Management .NET Assembly 

9.  Vision Web/Application 
Server 

Configure Document Management Service Account in 
Weblink 

10.  Vision Web/Application 
Server 

Configure Vision Document Management 

11.  Domain Configure Constrained Delegation 

12.  Domain Optional: Configure Protocol Transition  

Configure Vision Application Pool Identity to Be a Domain Account 
You must change the Vision Application Pool Identity to be a domain account. The default is for 
Vision to use a local DeltekVision user created during the Vision installation. This change is 
necessary because of the local account’s inability to work with Active Directory.  

  

 For this account to be the Application Pool Identity it must be a member of the IIS_IUSRS group in 
addition to being a member of the local administrators group on the local server.. 

  

To change the Vision Application Pool Identity, complete the following steps: 

1. Create a domain user account. This account must also be your SPF Service account. No 
domain Admin rights are needed for this account. 

2. Log on to the domain on the Vision Web/application server using an Administrator 
account. 

3. Open Internet Information Services: Start » All Programs » Administrative Tools » 
Internet Information Services (IIS) Manager. 

4. Expand the Server name and then click Application Pools. 

5. Select the DeltekVisionAppPool and select Advanced Settings from the Action pane 
on the right hand side.  The following displays: 
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6. Place your cursor in the Identity field and then click the ellipses button to set the identity.  

The Application Pool Identify dialog box displays:  

  
7. Select the Custom account option and click Set.  The Set Credentials dialog box 

displays. 
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8. In the User name field, enter the Application Pool Identity in the form 

<Domain>\<Username>.  

9. In the Password and Confirm password fields, enter that user’s password.  

10. Click OK three times to set the identity. 

Grant Local Security Policy Rights to Vision Application Pool Identity 
The Vision Application Pool Identity/SharePoint Service Account must be granted Logon as a 
service rights on the Vision 7.1 Web/Application Server for multi-tier Document Management 
installations, as shown in the following example of the Local Security Settings setup screens. 

 

Install and Configure Vision 7.1 Document Management and the 
SharePoint Server 2010 Site Collection  
When you install Vision 7.1 Document Management the changes made to your existing 
SharePoint Server installation are outlined below.  The steps out configure SharePoint are 
outlined in this section. 

  

 

If you would prefer not to run the Vision Document Management installation on an 
existing installation of SharePoint, refer to “Appendix C: Manual Installation of Vision 
Document Management” for manual setup instructions. 
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The Document Management installation does the following: 

 Installs Web Service Extensions (WSE) 2.0 SP3. 

 Copies Document Management files to the SharePoint ISAPI folder (c:\program 
files\common files\microsoft shared\web service extensions\14\isapi). 

 Copies Document Management files to the Vision Support folder (\program 
files\deltek\vision\support\DM\30). 

 Modifies the SharePoint Web.config file in the ISAPI directory to work with Vision 
Document Management. 

 Installs Deltek.Vision.WSS30.Server.dll into the Global Assembly Cache (GAC). 

Install Vision 7.1 Document Management on the Vision Web Server 

NOTE:  You must run the Document Management installer on both the Vision web server and the 
SharePoint web server. 

To install Vision 7.1 Document Management, complete the following steps: 

1. Download the DeltekVision71DM.exe file and run the setup on your Vision Web server.  

2. The installation will check to ensure that the IIS Role service, Windows Authentication, is 
installed.  If the Role Service is not installed you will be prompted to install it and the 
setup will exit: 

 
3. After installing the Windows Authentication IIS Role Service, re-run the Document 

Management installation.  

4. When a dialog box displays to indicate the IIS licensing requirements for the use of 
Windows Integrated Authentication (required to use Vision Document Management), click 
OK. 

5. On the first Document Management Installation Wizard page, click Next. 

6. On the License Agreement page, select I accept the terms of the license agreement 
and click Next. 

7. When the following message displays, click No because this is a multi-tier installation of 
Vision Document Management and your Vision Web server will not host SharePoint.. 
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8. When the following message displays to remind you to run the setup on the SharePoint 
server, click OK. 

 
9. On the Ready to Install the Program page, click Install to start the installation. 

10. When the InstallShield Wizard Complete page displays, click Finish. 

Configure Authentication for the Vision Website 

IIS Kernel Mode Authentication 

The default configuration of IIS when using Windows Integrated Authentication (required for 
Vision Document Management) is to use Kernel Mode Authentication.  Under this configuration, 
the application pool runs under the Machine account whether or not an identity has been 
established.  Because the Machine account cannot be used for delegation scenarios which are 
required for multi-tier deployments of Vision Document Management, the additional configuration 
steps below are necessary. 

Identify if Kernel Mode Authentication Is Enabled 

Follow the steps below to identify if Kernel Mode Authentication is enabled. (In a default 
configuration of IIS it will be enabled.) 

To identify the authentication status, complete the following steps: 

1. Log on to the domain on the Vision Web/application server using an Administrator 
account. 

2. Open Internet Information Services: Start » All Programs » Administrative Tools » 
Internet Information Services (IIS) Manager. 

3. Expand the server name, expand Sites, and expand Default Web Site or whichever site 
Vision is installed to. 

4. Select the Vision virtual directory and then double click Authentication in the 
Features view. 

5. Select Windows Authentication and verify that the status is Enabled 
(Anonymous Access should be Disabled).  If it is not, select Enable from the 
Actions menu. 

6. With Windows Authentication still selected, click Advanced settings on the 
Action menu. The Advanced Settings dialog box displays: 
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Kernel Mode Authentication Implementation 

As mentioned above, under this default configuration, Vision Document Management will 
not be able to delegate credentials to a WSS 3.0 server separate from the Vision 
Web/application server. Two possible configurations allow Document Management to 
function properly: 

 Disable Kernel Mode Authentication. In order to Disable Kernel Mode Authentication, 
simply uncheck the Enable Kernel Mode Authentication option under the Advanced 
Settings of the Windows Authentication feature for the Vision virtual directory. 

 Modify the ApplicationHost.config file to force the use of the Application Pool 
Identity.  In order to continue to use Kernel Mode Authentication but force the Application 
Pool to run under its Identity rather than the Machine account, it is necessary to modify 
the ApplicationHost.config file, the steps of which are outlined below: 

1. Click Start » All Programs » Accessories. 

2. Right-click Notepad, click Run as, and select the Administrator account.  
  

 This is necessary in order to save the changes we need to make to the 
ApplicationHost.config file, which is protected under UAC (User Account Control) on 
Windows Server 2008. 

  

3. Click Open on the File menu and locate the ApplicationHost.config file from 
c:\windows\system32\inetsrv\config.  

4. Click Find on the Edit menu in Notepad and search for the following:  

<location path=”Default Web Site/Vision”> 

5. Locate the windowsAuthentication tag and add useAppPoolCredentials=”true” as 
shown in the following:  
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6. Once the edits are complete, save your changes and restart IIS to make the changes 

effective.  

Both of these configuration options require that a Service Principal Name be established 
for the Application Pool Identity. The following section provides more information on 
creating the SPN. 

Configure Service Principal Name (SPN) for Vision Application Pool Identity 
Under the default configuration with Kernel Mode Authentication enabled, it is not necessary to 
create a Service Principal Name for the Application Pool Identity for Windows Authentication to 
work properly and creating an SPN for the Application Pool Identity in this configuration will result 
in a “duplicate SPN” issue, preventing Windows Integrated Security from authenticating anyone to 
the Web site.   

However, For Multi Tier installations of Vision Document Management it is necessary to create a 
Service Principal Name (SPN) for the domain user running the Vision Application Pool Identity 
(DeltekVisionAppPool) as this is the account used for delegation. 
  

 

Domain rights are required to complete this step. 
  

After you establish one of the above Kernel Mode configuration changes, use the steps 
below to create a Service Principal Name for the Application Pool Identity of the 
DeltekVisionAppPool. 

  

 The setspn utility is installed by default on Windows Server 2008. It is not necessary to download 
and install it separately. 

  

To create a service principal name, complete the following steps: 

1. Open a command prompt and enter: 

setspn –A http/<Vision Web/App Server name> <domain app pool identity> 

For example: setspn –A http/camqainetk3nwb5 inettest2k3n\dmservacct3tier 

2. Repeat for the FQDN of the server. 
 
For example: setspn –A http/camqainetk3nwb5.inettest2k3n.com 
inettest2k3n\dmservacct3tier 
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See the following related Microsoft Knowledge Base article for more information: 

http://support.microsoft.com/?id=871179  
  

Install Vision Document Management on the SharePoint 2010 Server 

To install Vision Document Management on the SharePoint server, complete the following 
steps: 

1. Download the DeltekVision71DM.exe file and run the setup on your SharePoint Web 
server.  

2. On the first Document Management Installation Wizard page, click Next. 

3. On the License Agreement page, select I accept the terms of the license agreement 
and click Next. 

4. When the following message displays to remind you to run the setup on the Vision 
web/application server if you haven’t already, click OK. 

 
5. On the Ready to Install the Program page, click Install to start the installation. 

6. When the InstallShield Wizard Complete page displays, click Finish. 

Use SharePoint Central Administration to Create the Vision Document 
Management Site Collection 
  

 

!! IMPORTANT INFORMATION FOR EXISTING SHAREPOINT 
INSTALLATIONS!! 

If you already have SharePoint installed and plan to use that existing installation 
of SharePoint for your Vision Document Management deployment, note that 
Vision Document Management does not support integrating with an existing 
SharePoint site collection and requires a dedicated top-level site on your 
SharePoint server. 

  

Create the Vision Document Management site using SharePoint Central Administration.  

To finish the SharePoint configuration, complete the following steps: 

1. In SharePoint Central Administration, select Application Management and Manage 
Web Applications. 

http://support.microsoft.com/?id=871179
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2. Select the web application that you would like to create the Deltek Vision site 

collection in and then select Managed Paths option. This will create a specific URL 
for your Vision Document Management site collection (for example, 
http://SharePoinServer/DeltekVision). 

 
3. Enter DeltekVision in Path and select Explicit inclusion from the Type drop-down 

list and click Add Path. 

4. Click OK.  

5. Click Application Management and select the Create Site Collection option under 
Site Collections. 
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The Create Site Collection page displays. 

 
6. Enter Deltek Vision in Title and enter a description, if appropriate. 

7. From the URL drop-down list, select /deltekvision. This will be the top level root for 
Vision Document Management. 
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8. Under Select a template, accept the default of Team Site for the template to be 

used and enter a username in each of the User name fields for the primary and 
secondary site collection administrators.  One of these needs to be the Vision 
Application Pool identity. 

9. Select No Quota in Select a quota template and click OK. The Top-Level Site 
Successfully Created page displays. 

 
10. Click the link for the top level site (in our example it is 

http://camqainetk38wb9/deltekvision) to display the site. 

http://camqainetk38wb9/deltekvision
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11. The SharePoint configuration is complete. Close SharePoint Central Administration. 

Verify IIS Configuration and Configure Deltek Vision Document 
Management .NET Assembly 
Copy the Vision Document Management .NET assembly to SharePoint site directory. 

Identify your IIS configuration to specifically identify which website and port SharePoint is 
using as well as which website and port Vision is using.   

If SharePoint was extended to the Default Web Site then copy 
Deltek.Vision.WSS30.Server.dll from <Vision Installation Directory>\Support\DM\30 to 
c:\inetput\wwwroot\bin 

If SharePoint was extended to its own named web site (e.g. SharePoint – 80) then copy 
Deltek.Vision.WSS30.Server.dll from <Vision Installation Directory>\Support\DM\30 to 
c:\inetput\wwwroot\wss\Virtual Directories\<site>\bin 

  

 

By default, the <site> directory references the port chosen. (e.g. 80, 81, etc.).  

Configure Document Management Service Account in Weblink 
You must configure the Document Management service account (username/password) on the 
System Settings tab of the Deltek Vision Weblink utility.  

To configure the account in Weblink, complete the following steps: 

1. On the Vision Web server, launch Weblink from Start » Programs » Deltek Vision 

2. Enter the Weblink password when prompted. 

3. Click the System Settings tab. 
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4. In the Document Management group box, enter your SharePoint username and 
password.  This account is your SharePoint Service account/Deltek Vision Application 
Pool Identity.  

5. Click Test and SharePoint Credentials to validate that the information entered is 
correct. 

 

Configure Vision Document Management 
To configure Vision Document Management, complete the following steps: 

1. Log in to Vision using an account that has access to the Configuration menus. 

2. Click Configuration » General » System Settings and select the Document 
Management tab. 
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3. Select the Enable Document Management check box. 

4. Enter the name of the server hosting Document Management. Depending on how/if you 
have configured Alternate Access Mappings, the name used here may be the server 
name only, FQDN’s or custom DNS value.. Enter this value without the protocol prefix 
(for example, remove the http://). In the illustration above, the value is 
camqainetk3nwb4. 

5. Enter the Virtual Server Port. In our example the port is 81 but on a typical dedicated 
SharePoint installation the port will be 80 for the default web site.. 

6. Click the Lookup icon to select the current site. 
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7. The Select Web Site dialog box displays the available sites. Select a site and click OK. 

8. Save your changes. 

Configure Constrained Delegation 
Because your SharePoint server is on a separate physical server and because the Vision Web 
server needs to pass the domain credentials of your Vision Document Management users on to 
the SharePoint server, you must configure Constrained Delegation. 

  

 This assumes a non-Internet deployment of Vision Document Management using Kerberos 
authentication. If you are deploying Vision Document Management so that it is accessible over the 
Internet, then you need to skip ahead to “Optional: Configure Protocol Transition” in the next 
section.  

  

To configure Constrained Delegation, complete the following steps: 

1. Open the Active Directory Users and Computers MMC on a Domain Controller.  

2. Locate the User account for the Vision Application Pool Identity (MOSS Service account), 
which is most likely under the Computers Organizational Unit (OU). 

3. Right-click and select Properties. 

4. On the Delegation tab, select the Trust this user for delegation to specified services 
only option. 

5. Select the Use Kerberos only option.  
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6. Click Add. The Add Services dialog box displays. 

 
7. Click Users or Computers. The Select Users or Computers dialog box displays. 
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8. Locate the http service, select it, and click OK. 

 
9. The Delegation tab should look like this: 
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Because we are explicitly specifying the http service and not all services on the SharePoint 
server, this is known as Constrained Delegation. 

There are two http service types listed. These service types are known as Service Principal 
Names (SPNs). The SPN referencing CAMQAINETK3NSS1.inettest2k3n.com was created 
automatically when the server was added to the domain and the http service (IIS) was installed. 
The second SPN referencing sharepoint.inettest2k3n.com is a new SPN that was created using 
the setspn utility that allows us to register the custom FQDN of the server, which provides more 
meaning than the actual machine name. 

Optional: Configure Protocol Transition  
If Vision Document Management functionality is required over the Internet and you will be using a 
custom DNS/FQDN for the SharePoint URL (as in our example, vision1.inettest2k3n.com), then 
you need to configure a form of delegation referred to as Protocol Transition. If Document 
Management functionality is not required, you can skip this step. 

The Kerberos authentication protocol must be used to authenticate from the Vision Web server to 
the SharePoint server. However, if Vision is deployed in an Internet scenario and there are users 
outside of the firewall who need to access Document Management features, then Kerberos 
authentication cannot be used to authenticate the client to the Web server. This is because the 
client needs to have the ability to negotiate a Kerberos ticket with the Key Distribution Center 
(KDC), which is a service running on a Domain Controller. This requires port 88 to be opened 
inbound on the firewall to the Domain Controller, which is not an advisable configuration. 

To get around this, you must be running a Native Windows Server 2003 functional domain.  

Protocol Transition is configured by selecting the Use any authentication protocol option 
instead of the Use Kerberos only option, which is used to configure Constrained Delegation. 
This allows the client to authenticate to the Vision Web server using NTLM instead of Kerberos, 
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and that authentication is then “transitioned” over to Kerberos for Delegation to the SharePoint 
server.  

To configure Protocol Transition, complete the following steps: 

1. Open the Active Directory Users and Computers MMC on a Domain Controller.  

2. Locate the User account for the Vision Application Pool Identity (MOSS Service account), 
which is most likely under the Computers Organizational Unit (OU). 

3. Right-click and select Properties. 

4. On the Delegation tab, select the Trust this user for Delegation to specified services 
only option. 

5. Select the Use any authentication protocol option.  

 
6. Click Add. The Add Services dialog box displays. 
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7. Click Users or Computers, search for the SharePoint server, and click OK. 

 
8. Locate the http service for the SPN (FQDN) you created earlier (in our example, 

sharepoint.inettest2k3n.com), select it, and click OK. 



Multi-Tier New Installation of Document Management 7.1 with SharePoint Server 2010 

 

Document Management Installation Guide 261 

 

 
This illustration shows two http service types. Unless you have registered a custom 
FQDN using the setspn utility, only the server name displays. These service types are 
known as Service Principal Names (SPNs).  

The SPN referencing CAMQAINETK3NSS1.inettest2k3n.com was created 
automatically when the server was added to the domain and the http service (IIS) was 
installed.  

The second SPN referencing sharepoint.inettest2k3n.com is a new SPN that was 
created using the setspn utility that allows us to register the custom FQDN of the server, 
which provides more meaning than the actual machine name. 
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The Delegation tab should look like this: 

 
Because we are explicitly specifying the http service and not all services on the 
SharePoint server, and because we are using the Use any authentication protocol 
option and not Kerberos, this is known as Protocol Transition. 
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Appendix A: Active Directory Domain Functional 
Level 

Active Directory Domain Functional Levels 
There possible active directory functional levels are listed below: 

 Windows 2000 Native — All domain controllers are Windows 2000 

 Windows 2000 Mixed — Server 2003 domain with support for Windows 2000 domain 
controllers 

 Windows Server 2003 — “Native” where all domain controllers are Server 2003 

 Windows Server 2008 

 Windows Server 2008 R2 

However, only the Windows Server 2003 and above domain functional levels are supported for 
Vision 7.1 Document Management.  

The domain configuration for the first two is effectively the same as far as Document 
Management is concerned and are not supported for Vision 7.1 Document Management because 
your only option is to configure what is called Unconstrained Delegation. The remaining three 
domain functional levels can be configured for Unconstrained Delegation; however, Constrained 
Delegation is much more secure and required for Vision Document Management. Another benefit 
of a native Server 2003 and above domains is that it supports Protocol Transition, which is 
necessary to support Internet deployments of Vision where Document Management functionality 
is required. 

Identify the Domain Functional Level 
To check the functional level of the domain, open the Active Directory Users and Computers tool 
on the Domain Controller: 

 
Right-click the domain, and select Properties. 
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If you need to raise the domain functional level to that supported by Vision 7.1 Document 
Management, see the steps in the next section, “How to Raise the Domain Functional Level.” 

How to Raise the Domain Functional Level 
To raise the domain functional level, all Domain Controllers in the domain must be running 
Windows Server 2003.  

  

 
This action cannot be reversed. Be sure that you want to raise the domain function level before 
you proceed. 

  

To raise the domain functional level, complete the following steps: 

1. Open the Active Directory Users and Computers MMC on your Domain Controller. 

2. Right-click the domain, and select Raise Domain Functional Level on the shortcut 
menu. 

 
Select Windows Server 2003 from the Select an available domain functional level drop-down list, 
and click the Raise button 
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.  
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Appendix B: Configure SharePoint for a Custom 
URL 
Several SPN’s will likely have been created in your configuration for the Vision and/or SharePoint 
Application Pool identity referencing the server name and FQDN of the respective servers.  
These SPN’s are required for Windows Authentication and delegation to work properly. 

By default, your SharePoint server will correctly resolve both the servername url 
(http://serveraname) and also the FQDN URL(http://servername.company.com) .  However, If you 
will configure your SharePoint server to use a custom DNS record for the URL (e.g. 
http://sharepoint.company.com you must create additional SPNs and also create Alternate 
Access Mappings in SharePoint.  

Configure SPN and Alternate Access Mappings for Custom URL 
for SharePoint Web Server 
Consider the following: 

 If the URL you want to use for your users to access SharePoint will be a custom DNS 
entry (for example, sharepoint.company.com), you will need to create a Service Principal 
Name (SPN) for this URL if your Application Pool Identity requires it.   

 An SPN will not be required if the SharePoint Application Pool runs as Network Service 
or if your deployment is a single tier installation and Kernel Mode Authentication is 
enabled.  

 For Multi-tier deployments where Constrained Delegation or Protocol Transition needs to 
be configured, you must also create an SPN for the SharePoint server (in addition to the 
Application Pool Identity mentioned above). 

 If you use a custom DNS entry, you must also configure an Alternate Access Mapping 
(AAM) in SharePoint for the this. (Creation of an AAM is not necessary for an FQDN 
based on the server name). 

  

 
For more information on SPNs, refer to the following Microsoft support article: 
http://support.microsoft.com/?id=871179. 

  

Add SPNs for a Custom DNS Name 
As indicated above, there are potentially two SPNs needed here.  The first will be for the Custom 
DNS name being used when the SharePoint Application Pool Identity requires it and the second 
will be for the SharePoint server name in order to properly configure delegation. 

To add an SPN for a custom DNS name for the SharePoint Application Pool Identity, 
complete the following steps: 

 Open an administrative command prompt (using ‘Run as Administrator’) and run the 
following command:  

Setspn -A HTTP/CustomDNSName Domain\<SharePoint Application Pool ID> 

Where CustomDNSName is the fully qualified custom DNS name of the server (for 
example, Vision.company.com) and Domain\<SharePoint Application Pool ID>  is the 
actual netbios computer name of the server (for example, Server01). 

http://serveraname/
http://sharepoint.company.com/
http://support.microsoft.com/?id=871179
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To add an SPN for a custom DNS name for delegation purposes, complete the following 
steps: 

 Open an administrative command prompt (using ‘Run as Administrator’) and run the 
following command:  

Setspn -A HTTP/CustomDNSName WebServerNetbiosName 

Where CustomDNSName is the fully qualified domain name of the server (for example, 
Vision.company.com) and WebServerNetbiosName is the actual netbios computer name 
of the server (for example, Server01). 

Create or Modify Alternate Access Mappings WSS 3.0 / MOSS 
2007 
To create or modify alternate access mappings, complete the following steps:  

1. On the SharePoint server, open SharePoint 3.0 Central Administration via Start » 
Administrative Tools. 

2. Click Operations » Alternate Access Mappings. 

 
3. Click Show All and select Change Alternate Access Mapping Collection. The Select 

an Alternate Access Mapping Collection page displays. 
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4. Select the link for the new SharePoint web application you created. In the above 

illustration, it is SharePoint – 80. This will filter the list to only show the mappings for this 
application. The Alternate Access Mapping page displays. 

 
5. Click the Edit Public URLs button.  The following page displays. 

 



Appendix B: Configure SharePoint for a Custom URL 

 

Document Management Installation Guide 269 

 

 
6. Modify the Default URL to specify the custom DNS name or enter the custom DNS name 

in another zone field and click Save. If a port is specified, do not remove it. 

Create or Modify Alternate Access Mappings SPF  / SharePoint 
Server 2010 
To create or modify alternate access mappings, complete the following steps: 

To [insert procedure], complete the following steps: 

1. On the SharePoint server, click Start » Microsoft SharePoint 2010 Products » 
SharePoint 2010 Central Administration. 

 

 
2. Click Configure Alternate Access Mappings under System Settings. 
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3. Click Show All and select Change Alternate Access Mapping Collection. The Select 

an Alternate Access Mapping Collection page displays 

 
4. Select the link for the new SharePoint web application you created. In the above 

illustration, it is SharePoint – 80. This will filter the list to only show the mappings for this 
application. The Alternate Access Mapping page displays. 

 
5. Click the Edit Public URLs button.  The following page displays. 
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6. Modify the Default URL to specify the custom DNS name or enter the custom DNS name 

in another zone field and click Save. If a port is specified, do not remove it. 
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Configure Constrained Delegation or Protocol Transition When 
Using a Custom DNS Record  
To configure delegation when using a custom DNS record for SharePoint and a domain 
account as the Vision Application Pool Identity complete the following steps: 

1. Open the Active Directory Users and Computers MMC, 

2. Locate the domain account for the Vision Application Pool Identity. 

3. Right-click and select Properties. 

4. Click the Delegation tab: 

  
5. Select the “Trust this user for delegation to specified services only” and if configuring 

Constrained Delegation select “Use Kerberos only” or “Use any authentication protocol” 
for Protocol Transition.  Click Add 
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6. In the Add Services dialog box, click the Users or Computers button and enter the 

SharePoint netbios server name, (not the custom DNS name as that will not be a valid 
AD object). Click OK. 
 

 
7. Select the http SPN for the custom DNS name of the SharePoint server (e.g. 

sharepoint.company.com): 
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8. Click OK.  The Delegation tab should look like this when you have completed this 

procedure: 
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Appendix C: Manual Installation of Vision 
Document Management 
If you have an existing installation of SharePoint and would prefer not to run the Vision Document 
Management installation on that server, follow the steps below to manually configure the 
necessary components: 

To set up Document Management manually for an  existing SharePoint installation, 
complete the following steps: 

1. Extract the document management setup using the following command: 

<Path to Deltek DM Setup>:\<DM .exe> /extract_all:<Path to folder to extract contents> 

For example: 

C:\Users\administrator.INETTEST2K3N\Downloads\DeltekVision71DM.exe 
/extract_all:C:\Users\administrator.INETTEST2K3N\Downloads\DMExtract 

2. Install WSE 2.0 SP3 from <Path to Extracted DM 
Files>\Disk1\Support\Patches\WSE20\WSE20SP3Runtime.msi 

3. Copy the following files from <Path to Extracted DM Files>\Disk1\Support\DM\30 to the 
SharePoint ISAPI directory (C:\Program Files\Common Files\Microsoft Shared\Web 
Server Extensions\<version>\ISAPI) where <version> is 12 for WSS 3.0/MOSS 2007 and 
14 is for SPF 2010 or SharePoint 2010 Server. 
 
WSSVision.asmx 
WSSVision.disco 
WSSVision.wsdl 
wssvisiondisco.aspx 
wssvisionwsdl.aspx 
 
These are the document management web service files. 

4. Modify the SharePoint web.config file in the ISAPI directory (specified above) as follows: 
 
NOTE: Be sure to make a backup of the web.config file before you proceed as incorrectly 
modifying this file will render your SharePoint installation unusable. 
 
ADD the highlighted sections below: 
 
<?xml version="1.0" encoding="UTF-8" standalone="yes"?> 
<configuration> 
  <configSections> 
    <section name="microsoft.web.services2" 
type="Microsoft.Web.Services2.Configuration.WebServicesConfiguration, 
Microsoft.Web.Services2, Version=2.0.0.0, Culture=neutral, 
PublicKeyToken=31bf3856ad364e35" /> 
  </configSections> 
  <system.web> 
    <webServices> 
      <protocols> 
        <remove name="HttpGet" /> 
        <remove name="HttpPost" /> 
        <remove name="HttpPostLocalhost" /> 
        <add name="Documentation" /> 
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      </protocols> 
      <soapExtensionTypes> 
        <add type="Microsoft.Web.Services2.WebServicesExtension, 
Microsoft.Web.Services2,Version=2.0.0.0, Culture=neutral, 
PublicKeyToken=31bf3856ad364e35" priority="1" group="0" /> 
      </soapExtensionTypes> 
    </webServices> 
    <customErrors mode="On" /> 
    <httpRuntime maxRequestLength="128000" executionTimeout="900" /> 
  </system.web> 
. 
. 
. 
  <microsoft.web.services2> 
    <messaging> 
      <maxRequestLength>128000</maxRequestLength> 
    </messaging> 
  </microsoft.web.services2> 
</configuration> 
 

5. Register the Deltek .NET Assembly into the Global Assembly Cache via an 
Administrative command prompt (via ‘Run as Administrator’): 
 
“<path to extracted folder>\Disk1\Support\Utilities\”gacutil /i "<path to extracted 
folder>\Disk1\Support\DM\30\Deltek.Vision.WSS30.Server.dll" 

For example: 

C:\Users\administrator.INETTEST2K3N\Downloads\DMExtract\Disk1\Support\Utilities\ga
cutil.exe /i 
"C:\Users\administrator.INETTEST2K3N\Downloads\DMExtract\Disk1\Support\DM\30\De
ltek.Vision.WSS30.Server.dll" 

6. Copy the Deltek .NET Assembly to the SharePoint web application \bin folder (e.g. 
c:\inetpub\wwwroot\wss\virtual directories\<port>\bin).  If SharePoint was installed to the 
default website then the path will be c:\inetpub\wwwroot\bin. 
 

7. Complete the remainder of the configuration as described in the installation and 
configuration instructions for your deployment. 

 

  



Appendix D:  Troubleshooting 

 

Document Management Installation Guide 277 

 

Appendix D:  Troubleshooting 
Vision Document Management is a very complicated software component, especially with regard 
to many of the domain specific functions including SPN’s, Kerberos and Delegation.  The 
following information will help in troubleshooting issues that may likely arise during the 
configuration of Vision Document Management. 
  

 

Domain rights are required to perform most of the troubleshooting steps identified in this 
appendix. 

  

SPN Troubleshooting 
Setspn.exe 
 
Setspn.exe is a command line executable that has a variety of switches that can be used to list 
existing SPN’s for a specific domain object (computer or user account) as well as to check for the 
existence of duplicate SPN’s.  Run setspn /? from a command prompt to see syntax and usage 
examples. 
 
SPNQuery.vbs 
 
This visual basic script is available for download from Microsoft via the following url: 
http://support.microsoft.com/kb/321044) 
 
When executing this script, the following will dump all http specific SPN’s to a text file so you can 
search for duplicates: 
 
cscript spnquery.vbs http/* >SPNCheck.txt 

Kerberos Troubleshooting 
 
Kliste.exe 
 
Klist is a command line tool included with Windows 7 and Server 2008/R2 that allows you to see 
Kerberos tickets granted to a specific user account.  This is replacement to the Windows 2000 
support tool Kerbtray. 
 
Fiddler 
http://www.fiddlertool.com  
 
Fiddler is an http debugging proxy that allows you to see details of individual http requests 
including authentication headers. 
 
Deleg Config Tool 
http://blogs.iis.net/brian-murphy-booth/archive/2009/04/22/delegconfig-v2-beta.aspx  
 
This tool is an ASP.net application that may be helpful to validate your SPN, Kerberos and 
Delegation configuration.  The tools has been known to have issues so it may or may not work in 
your specific environment. 
 
Kerberos Event Logging  

http://support.microsoft.com/kb/321044
http://www.fiddlertool.com/
http://blogs.iis.net/brian-murphy-booth/archive/2009/04/22/delegconfig-v2-beta.aspx
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http://support.microsoft.com/kb/262177  
 
Kerberos event logging can be enabled via a registry setting that will write Kerberos specific error 
conditions to the Windows event logs.   

Internet Access, Authentication Prompts and Windows 
Credential Manager 
If Vision Document Management will be accessible via the Internet, there are a variety of 
authentication prompts that the user will have to traverse to access the application.  These 
prompts are shown and discussed below as well as a potential work-around. 
 

1. When the user first accesses the Vision virtual directory via (http://server/vision) they will 
be challenged by IIS and the Internet Explorer browser will present the following 
authentication dialog as they are not yet authenticated to your domain. 

 
2. They will need to enter their domain credentials as shown above.   

 
3. At this point the ClickOnce application will be downloaded and initialized at which point 

they will receive the next prompt from asking for the same domain credentials.  The 
reason for this second prompt is that the browser cannot “pass” the credentials to the 
winform client application. 
 

 
 

4. Once these credentials are entered you will be able to login to Vision. 
 

5. The final prompt will occur the first time the user attempts to edit any text editor field.  
These fields are identified by a pencil icon will present the user with another IIS/browser 
based prompt as this is a call to an ASP.net page on the web server but the request is 
coming from the winform client application, not the browser so the previously entered 
credentials cannot be used. 
 

http://support.microsoft.com/kb/262177
http://server/vision
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6. At either of the browser based prompts if the user checks the box on the login screen to 
“Remember my credentials” they will no longer be prompted to authenticate.  Checking 
that box stores the users entered credentials and associates them with the url used to 
access the application so all future requests are automatically authenticated. 
 
The credentials are stored by the operating system in the Credential Manger in Windows 
7 and the Stored User Names and Passwords in Windows XP. 
 

 
 
 
  

 

It is possible that this functionality has been disabled by the system administrator via 
domain Group Policy.  In that case the users will need to enter their credentials as shown 
above but will only need to enter them once per login session. 
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Appendix E:  Use a Site Collection SharePoint 
Account instead of Farm Administrator Account 
The default configuration steps for Document Management advise you to use the SharePoint 
Farm Administrator account as the Deltek Vision Application Pool Identity and SharePoint Service 
Account.  Due to security limitations this may not always be possible.  The following steps provide 
a work-around that will allow the use of a Site Collection Administrator instead of using the more 
privileged Farm Administrator. 

1. First, configure Deltek Vision Document Management as per the installation/configuration 
instructions using the SharePoint Farm Administrator account throughout the process up 
to and including configuring Document Management in Deltek Vision Configuration-
>System Settings->Document Management tab. 
 

2. Thoroughly test to ensure that all Document Management functionality is working, 
especially uploading a document from within Deltek Vision 
 

3. Once Document Management functionality has been validated, identify a Site Collection 
Administrator account for the Deltek Vision site collection in SharePoint and reconfigure 
the following Deltek Vision configuration using this new account. 

 Deltek Vision Web/Application server local security (Administrator and IIS_IUSRS 
local groups and Logon as a Service, Local Security Policy right) 

 Deltek Vision Application Pool Identity 

 Deltek Vision SharePoint Service Account in Weblink (System Settings tab) 

 Domain Service Principal Name configuration 

 Domain Delegation/Protocol Transition configuration 

4. Once the above re-configuration has been completed and all Document Management 
functionality has been re-validated, remove the SharePoint Farm Administrator account 
from the Deltek Vision web/application server configuration as well as removing the 
account from Domain SPN’s and Delegation configuration. 

 

 



 

 

Deltek is the leading global provider of enterprise software and information solutions for professional 
services firms, government contractors, and government agencies. For decades, we have delivered 
actionable insight that empowers our customers to unlock their business potential. Over 14,000 
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